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Preface
This preface introduces information sources that can help you use the application.

Using Oracle Applications

Using Applications Help
Use help icons  to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access Oracle
Applications Help.

Watch: This video tutorial shows you how to find help and use help features.
 

You can also read Using Applications Help.

Additional Resources

• Community: Use  Oracle Cloud Customer Connect  to get information from experts at Oracle, the partner
community, and other users.

• Guides and Videos: Go to the  Oracle Help Center  to find guides and videos.

• Training: Take courses on Oracle Cloud from  Oracle University.

Conventions
The following table explains the text conventions used in this guide.

Convention Meaning

boldface Boldface type indicates user interface elements, navigation paths, or values you enter or select.

monospace Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.

> Greater than symbol separates elements in a navigation path.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.

https://fusionhelp.oracle.com/
https://fusionhelp.oracle.com/
https://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:10552
https://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:10552
http://www.oracle.com/pls/topic/lookup?ctx=cloud&id=OACPR2531440
https://appsconnect.custhelp.com/
http://docs.oracle.com/
http://education.oracle.com/pls/web_prod-plq-dad/db_pages.getpage?page_id=906
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
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Contacting Oracle

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For
information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to:
oracle_fusion_applications_help_ww_grp@oracle.com.

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Expenses Configuration

How You View Details About Predefined Scheduled
Processes
You can use web services to run predefined scheduled processes.

Scheduled Processes
Before you can schedule a process, you must sign in as a corporate card administrator, expense auditor, or travel
administrator. When you sign in as a specific job role, you can then see processes that relate to your job role.

To schedule processes, perform the following steps:

1. Navigate to the Navigator and click the Scheduled Processes link to open the Scheduled Processes page.
2. Click the Schedule New Process button.
3. In the Schedule New Process dialog box, select the applicable process and click OK to open the Process Details

dialog box.
4. Select the applicable parameters for your process and click Submit.

Security
Privileges provide the necessary access to run specific scheduled processes. Privileges are granted to duty roles, which are
granted to job roles. To see which job roles inherit the needed privileges, use the Security Console or the security reference
manuals for the appropriate product family.

Set Up and Use HTML Email Approval Notifications
You can conveniently receive HTML-based expense report approval notifications in emails. To use HTML-based email
approval notifications, you must opt-in to the Usability Enhancements for Expenses feature.

Opt-In to Usability Enhancements for Expenses
In the Offerings work area, enable the Usability Enhancements for Expenses feature:

• Offering: Financials

• Functional Area: Expenses

• Feature: Usability Enhancements for Expenses

• Choice: Enhanced Expenses HTML Approval Notification

Displaying Fields
The following table contains the rules that determine whether fields are displayed on HTML email approval notifications.
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Value Display Behavior on HTML Approval Notification

Currency
 

Amounts are converted to the approver's currency.
 

• Expense Report Owner's Name
• Expense Report Total
• Purpose
• Expense Report Number and

Submitted Date

The header section contains the Expense Report Owner's Name, Expense Report Total, Purpose,
Expense Report Number, and Submitted Date. These values provide an overview of key expense
report details.
 

• Merchant Name
• Description
• Location

Merchant Name, Description, and Location are dynamic values that display when they exist in the
expense report.
 

• Date
• Expense
• Amount

Date, Expense, and Amount are static values that always display on the notification.
 

Itemizations
 

Itemizations only display if they exist for the parent expense item.
 

• Violation Type
• Justification

Violation Type and Justification only display as a line-level violation when a policy violation occurs.
 

• Project
• Task

Project and Task display for each itemized line if they are different for each itemized line. When they
are the same, they display at the parent expense level.
 

Cost Center
 

Cost Center only displays if the cost center is different from the default cost center.
 

Sort Order
  Expense item lines are sorted by:

• Absolute amount in descending order
• Date in ascending order
• Expense type in ascending alphabetic order

Airfare
 

Airfare displays as a separate table on the notification because it's typically a large expenditure.
 

Related Topics

• Overview of Profile Options

• Create and Edit Profile Options

• Set Profile Option Values

• Hierarchy in Profile Levels

• How can I access predefined profile options

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FACIA1792124
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FACIA1792190
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FACIA1792242
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FACIA180436
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FACIA1907176
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Overview of Financials Configurable Workflow Notifications
The Financial applications, as part of certain business flows, automatically send notifications for review or approval. For
example, when a user submits an expense report, the approvers receive an email containing the approval request. Oracle
Business Intelligence (BI) Publisher reports are used for some flows to generate the content and format. You can enable BI
Publisher-based notifications, which are ready to use as delivered. The notification templates can be easily configured to meet
other specific requirements. If required, you can change the delivered template layouts and content, to add images, change
colors and styling, add or remove attributes or modify text.

The following table shows the financial products that use configurable notifications, along with their associated features, and
workflow task names:

Product Feature Name Report or Notification Name Workflow Task Name

General Ledger
 

Journal Approval Notifications
 

Journal Approval Report
 

FinGlJournalApproval
 

Payables
 

Invoice Approval Notifications
 

Invoice Approval Report
 

FinApInvoiceApproval
 

Payables
 

Hold Resolution Notifications
 

Hold Resolution Notification
 

FinApHoldApproval
 

Payables
 

Payment Approval Notifications
 

Payment Approval Notification
 

PaymentApproval
 

Payables
 

Invoice Account Coding
Notifications
 
 

Invoice Account Coding Email
Notification
 
 

FinApInvoiceAccountCoding
 
 

Expenses
 

Expense Report Approval
Notifications
 

Expense Report Approval
Notification
 

FinExmWorkflowExpenseApproval
 

Expenses
 

Expense Reimbursement
Notifications
 

Reimbursement Paid to Card
Issuer Notification
 
Reimbursement Paid by Check
Notification
 
Reimbursement Paid by Direct
Deposit Notification
 

FinExmReimToCardIssuerFyi
 
FinExmReimToEmpByCheckFyi
 
FinExmReimToEmpByDepositFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Expense Report Adjusted by
Auditor Notification
 
Expense Report Rejected by
Auditor Notification
 
Pending Payment with Warnings
Notification
 
Expense Report Returned by
Auditor Notification
 
Short-Paid Report with Receipt
Issue Notification

FinExmExpenseAuditFyi
 
FinExmExpenseAuditFyi
 
FinExmExpenseAuditFyi
 
FinExmReceiptManagementFyi
 
FinExmReportShortpaidReceiptIssue
 
FinExmReportShortpaidPolicyIssue
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Product Feature Name Report or Notification Name Workflow Task Name

 
Short-Paid Report with
Noncompliance Notification
 

Expenses
 

Cash Advance Notifications
 

Cash Advances Approval
Notification
 

FinExmWorkflowCashAdvanceApproval
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Payment is Held Notification
 

FinExmReceiptManagementFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Payment is Released Notification
 

FinExmReceiptManagementFyi
 

Expenses
 

Expense Reimbursement
Notifications
 

Reimbursement Has Been Paid
to Employer Notification
 

FinExmReimToEmpByCheckFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Mileage Adjustment Notification
 

ExpenseAuditMileageAdjustmentFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Missing Receipt Declaration is
Required Notification
 

FinExmReceiptManagementFyi
 

Expenses
 

Cash Advances Notifications
 

Overdue Cash Advance
Notification
 

FinExmWorkflowOverdueNotification
 

Expenses
 

Cash Advances Notifications
 

Cash Advances Automatically
Applied Notification
 

FinExmWorkflowCashAdvanceAutoAppliedFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Inactive Employee's Outstanding
Transactions Notification
 

FinExmInactiveEmployeeSubmitExpenseFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Inactive Employee-Accept
Responsibility Notification
 

FinExmInactiveEmployeeAcceptResp
 

Intercompany
 

Intercompany Email Notifications
 

Intercompany Transaction
Approval Notification
 
Intercompany Enter Receiver
Distribution Notification
 

FinFunTransactionApproval
for Intercompany Transaction
Approval Notification
 
FinFunEnterDistRequestForAction
for Intercompany Enter Receiver
Distribution Notification
 

Bill Management
 

User Registrations Notifications
 

Registration Confirmation.
 
New Account Registration
Confirmation.
 
Account Access Revocation
Notification.
 
Access Revocation Notification.
 

N/A
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Product Feature Name Report or Notification Name Workflow Task Name

Budgetary Control
 

Budgetary Control Override
Email Notifications
 

Budget Override Request
Notification Budget
 

OverrideNotificationFyi
 

Budgetary Control
 

Budgetary Control Override
Email Notifications
 

Override Taken Notification
 

OverrideNotificationFyi
 

Receivables
 

Manual Credit Memo Request
Notification
 

Manual Credit Memo Request
Notification
 

Note: The in-app
notification is also
configurable.

 

FinArTrxnsCreditMemosCreationPostProcessing
 

Note:  When you receive a workflow email notification, you can alternatively find the same notification by clicking
the Notifications icon in the global header or opening the Worklist: Notifications and Approvals work area.Your
report edits don't affect the other notification methods.

Process Overview
Generating configurable notifications through BI Publisher involves various types of objects in the BI catalog, including data
models, subtemplates, style templates, and reports. Reports pull data from data models and generate notifications in an
HTML format. The report layout templates use common table and paragraph styles and refer to a central subtemplate that
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contains reusable notification components. This figure shows how these BI objects work together to generate the notification
content.

Report

Layout
Template

Data Model

Subtemplate

HTML Email

Style Template
Data 

Sources

• Data Sources: Store the attributes and attribute values for business objects and transactions in the application
(example of data sources being transaction tables)

• Data Model: Determines which attributes from data sources are available to be included in the notification and how
that data is retrieved

• Subtemplate: Provides common components, such as a branding logo and buttons, that can be reused in multiple
reports.

• Style Template: Provides styles such as the type of lines and fonts to use in tables, or the font type, size, and color
to use for headings

• Report: Contains a layout template that determines:

◦ Which attributes appear in the notification, from the data model used for the report

◦ What the notification looks like, leveraging components from the subtemplate and styles from the style
template used for the report

• HTML: Format of the output generated by the report

• Email: What the notification looks like, leveraging components from the subtemplate and styles from the style
template used for the report

• In-App Notification: Has the HTML output embedded in the application UI

Each workflow task with configurable notifications has a corresponding predefined report in the BI catalog.. For example, the
Invoice Approval report contains the Invoice Approval Notifications report layout template and uses the Invoice Approval Data
Model.



Oracle Financials Cloud
Implementing Expenses

Chapter 1
Expenses Configuration

7

Notification Modifications
When you enable configurable email notifications, the predefined reports and related objects in the BI catalog will be used to
generate the email notifications. The report-based notifications provide the same information as the standard notifications. In
addition, the format of report-based notifications is optimized for mobile devices. To modify the email notifications, you can
edit copies of the predefined reports, data models, and subtemplate. However, you can't change the style template. You
proceed as you would to edit any report, data model, or subtemplate in the catalog, for example:

1. Find a predefined report for expense approval in the BI catalog.
2. Use the Customize option to create a copy, or copy the report and paste it within the Custom folder.
3. Edit the copied report layout template.

Before modifying workflow email notifications, it's recommended that you familiarize yourself with BI Publisher in general. This
will improve your ability to change your notifications by formatting emails to meet your business requirements.

With BI Publisher-based email notifications you:

• Use only the Template Builder for Word add-in to edit the .rtf template in Microsoft Word, rather than the layout
editor or other tools available for creating and editing report layout.

• Edit a copy of predefined layout templates, rather than creating reports or layout templates.

Note:  Review the My Oracle Support (MOS) note: Configurable Workflow Notifications: Implementation
Considerations (Doc ID 2215570.1).

Steps to Enable
In the Offerings work area, enable the Configurable Email Notifications feature as follows:

1. Offering: Financials
2. Functional Area: Budgetary Control, Expenses, Intercompany, General Ledger, or Payables
3. Feature: Configurable Email Notifications
4. Choices: The specific notifications you want to enable
5. Click Done.

Related Topics
• Best Practices for Layouts in Workflow Notifications

• Preview Changes to Layout Templates for Workflow Notifications

• Modify Journal Approval Email Notifications Using Oracle Business Intelligence (BI) Publisher

• Modifying Invoice Approval Email Notifications Using Oracle Business Intelligence (BI) Publisher: Worked Example

Enable Expenses Configurable Email Notifications
You can use workflow email approval notifications to submit approvals to approvers. These approval notifications are Oracle
Business Intelligence (BI) Publisher-based approval notifications that are embedded in emails. If you want to change the

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=4B454877EA1408B3E05362C3F00ADFD5
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=57434F9C7C2D518BE05362C3F00A78BA
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=5919CF9BF8594E3FE05362C3F00A445A
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=5A2DC391C68F53DBE05362C3F00A31EA
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content or appearance of your email approval notifications, you can modify the content or format of the Oracle BI Publisher
templates.

Before you can use or modify workflow email approval notifications, you must enable in Setup and Maintenance any or all of
the following sets with their corresponding notifications:

• Expense Report Approval Notifications

◦ Expense report approval notification

• Expense Reimbursement Notifications

◦ Expense report payment notification to employee (check)

◦ Expense report payment notification to employee (direct deposit)

◦ Payment to card issuer notification

• Expense Audit and Receipt Management Notifications

◦ Expense report is rejected by auditor

◦ Expense report is returned to employee

◦ Expense report is short paid due to receipt issue

◦ Expense report is adjusted

◦ Expense report is short paid due to non-compliance issue

◦ Pending payment with warnings

• Cash Advance Notifications

◦ Cash advance approval notification

Enabling Configurable Email Notifications
To enable workflow email approval notifications, follow these steps:

1. Navigator > My Enterprise > Offerings.
2. In the Offerings work area, select Financials.
3. Click Opt In Features.
4. On the Opt In: Financials page, select Expenses.
5. Click the Edit icon.
6. On the Edit Features: Expenses page, select Configurable Expenses Email Notifications.
7. Click the Edit icon.
8. In the Feature Name: Configurable Expense Email Notifications dialog box, select any or all of the notification

sets.
9. Click Save and Close.
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How Rules Determine the Display Behavior of Fields on
Email Approval Notifications
You can configure Expenses email approval notifications that are based on Oracle Business Intelligence (BI) Publisher
templates. When you enable these notifications, the application automatically generates them.

For the Oracle BI Publisher-based email approval notifications, Expenses uses predefined rules. The following table contains
the rules that determine whether the fields are conditionally displayed on the email approval notification.

Display Rule Number Values Display Rules

1
 

Currency
 

If an approver has a different user-
preferred currency from the expense report
reimbursement currency, the expense
report's approximate amount in the user
preferred currency is displayed to the
approver.
 

2
 

• Merchant Name
• Description
• Location

Displayed if applicable.
 

3
 

• Violation Type
• Justification

A line-level violation is displayed when a
policy violation occurs.
 

4
 

• Project
• Task

Displayed if applicable.
 

5
 

Cost Center
 

Displayed if applicable.
 

6
 

Itemized Lines
 

Displayed if applicable.
 

7
 

Number of Days
 

Displayed if applicable.
 

8
 

Personal
 

When an employee specifies an amount
as Personal, this amount is shown on the
notification and marked as Personal.
 

9
 

Card
 

A corporate card transaction is displayed
with Card to indicate a card transaction. A
cash transaction is displayed as an amount
without displaying Cash.
 

10
 

Receipt Required
  When an expense item line is Receipt

Required, it is displayed with a Receipt
Required icon.
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Example of Modifying Expenses Email Notifications Using
Oracle Business Intelligence Publisher
This example shows you how to modify the Expense Report Approval email notification template using Oracle Business
Intelligence (BI) Publisher templates.

The following table summarizes questions to consider for this scenario.

Questions to Consider This Example

Do I want to change in the header of the
email approval notification?
 

Add a word to the header.
 

Do I want to add fields or columns to or
remove fields or columns from the email
approval notification?
 

Add a field to the template.
 

You can modify an Expenses BI Publisher email approval notification by:

1. Exporting the Expense Approval Data Model
2. Downloading the Expense Report Approval template
3. Editing the Expense Report Approval template
4. Adding field and table attributes to the Expense Report Approval template
5. Previewing the modified Expense Report Approval template
6. Uploading the modified Expense Report Approval template

Prerequisites
Before you can modify an Expenses workflow email approval notification, complete these steps:

1. Download and install the Template Builder for Word, which is a BI Publisher add-on for Microsoft Word.

a. Sign into the Oracle Business Intelligence Publisher server with the BI Administrator Role.
b. On the Oracle Business Intelligence home page by the Get Started section, click the Download BI Publisher

Desktop Tools link.
c.

Select and install Template Builder for Word.
2. Download a copy of the subtemplate, which is the FinFunWorkflowNotificationSub.rtf file, to your local drive.

a. Click the Catalog menu.
b. In the BI Catalog, expand Shared Folders > Common Content > Templates.
c. Click the Edit link for Workflow Notification Subtemplate.
d. On the Workflow Notification Subtemplate - Sub Template page in the Templates section, click the language

name link in the Locale column.
e. Save the FinFunWorkflowNotificationSub.rtf file to your local drive.
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3. Create an expense report and note the expense report number. You enter the expense report number when you
export the data model .xml file.

Exporting the Expense Approval Data Model
Before you can modify the Expense Report Approval template, you must export the .xml file that contains the predefined data
model attributes for the notifications. Complete these steps:

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.
2. Navigator > Tools > Reports and Analytics.
3. On the Oracle BI Publisher home page, click the Catalog menu.
4. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Workflow Notifications.
5. Expand the Expenses folder.
6. Click the Expenses subfolder to display the data models and the notification templates.
7. Click the Data Models link.
8. By Expense Approval Data Model, click the Edit link.

The Diagram tab displays data sets for the Expense Approval Data Model.
9. Scroll to see all the data sets.

10. To ensure that all data sets include requested elements with null values in the output XML data, complete these
steps:

a. In the Data Model pane, click the Properties link.
b. In the Properties section, select the Include Empty Tags for Null Elements check box.

11. In the Data Model pane, click the Data Sets link.
12. On the Expense Approval Data Model page, select the Data tab and scroll to locate the Expense Report Number

field.
13. In the Expense Report Number  field, enter the expense report number that you created in the third step of the

Prerequisites section in this document.
14. Click View to see the sample data and all the available attributes.
15. Click Save As Sample Data.
16. Click OK.
17. Click Export.
18. Click Save as to save the Expense Approval Data Model .xml file to your local drive.

Downloading the Expense Report Approval Template
The Expense Report Approval template contains the structure of the email approval notification. To download a copy of the
Expense Report Approval template to your local drive, complete these steps:

1. Click the Catalog menu.
2. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Workflow Notifications >

Expenses.
3. Click the Expenses subfolder to display data models and the notification templates.
4. By Expense Report Approval, click the More link, and select Customize.

An image of the predefined Expense Report Approval Email Notification appears. A copy of the Expense Report
Approval template is automatically created in the Custom folder. You can find the copy by expanding Shared Folders
> Custom > Financials > Workflow Notifications > Expenses.
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5. By the predefined Expense Report Approval Email Notification template, click the Edit link.
6. Click Save as to save the Expense Report Approval Email Notification template to your local drive as an .rtf file.

Tip:  Save the downloaded template with the name
UpdatedExpenseApprovalNotificationReport.rtf to distinguish it from the predefined template.

Editing the Expense Report Approval Template
To edit the header section of the Expense Report Approval Email Notification template, complete these steps:

1. Double click the UpdatedExpenseApprovalNotificationReport.rtf file you saved to your local drive.
2. In the header section, place your cursor between Expense and Approval.
3. Type Report. The text now reads Expense Report Approval.

You can add, delete, or change words in the Expense Report Approval template.
4. Save and close the .rtf file.

Adding Field and Table Attributes to the Expense Report Approval
Template
To add field and table attributes to the Expense Report Approval template, complete these steps:

1. In Microsoft Word, open your local copy of the UpdatedExpenseApprovalNotificationReport.rtf file.

Note:  Depending on your version of Microsoft Word or your installation of Template Builder for Word,
you may see either a BI Publisher tab or you may find BI Publisher by the Add-ins menu.

2. From the Add-ins menu, select BI Publisher > Data > Load Sample XML Data.
3. In the Select XML data dialog box, search for and select the Expense Approval Data Model .xml file you

downloaded.
4. Click Open.

A message displays that indicates your .xml data was successfully loaded.
5. Click OK.
6. To insert a field in the Expense Report Approval template, place your cursor at the end of the line you want to insert

into, and press the Enter key on the keyboard.
7. From the Add-ins menu, select BI Publisher > Insert > Field.
8. In the Field dialog box, scroll to the EXPENSES folder, select IMG_REQ_FLAG, and click Insert.

This step inserts text that indicates a receipt image is required. You can add fields from the data model anywhere in
the Expense Report Approval .rtf template.

9. From the Add-ins menu, select BI Publisher > Insert > Field.
10. In the Field dialog box, scroll to the RECENTSIMILAREXPENSES folder, select any field that you want to insert, and

click Insert.

Note:  You can also insert fields that are associated with the following folders: RecurringViolations,
RecentSimilarExpenses, and UnappliedCashAdvances.

11. Save and close the UpdatedExpenseApprovalNotificationReport.rtf file.
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Previewing the Modified Expense Report Approval Template
Before uploading your modified Expense Report Approval template to the BI Catalog, you can preview the changes you
made. By previewing changes, you can avoid uploading a modified template that displays errors in the emails sent to users.

1. Open your local copy of the UpdatedExpenseApprovalNotificationReport.rtf file in Microsoft Word.
2. At the beginning of your modified .rtf template, save the path information for future reference so you can replace it

after previewing. The path information may look like this: <?import:xdoxsl:///Common Content/Templates/Workflow
Notification Subtemplate.xsb?>

3. Replace the path at the beginning of your modified .rtf template with the location of the subtemplate that you
downloaded as a prerequisite. For example, change <?import:xdoxsl:///Common Content/Templates/Workflow
Notification Subtemplate.xsb?> to <?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>

Note:  In the preceding example, part of the replacement path, C:/Template_Directory, represents the
folder in which the user downloaded the subtemplate to in the second step of the Prerequisites section
in this document. Ensure that you change all backward slashes to forward slashes.

4. From the Add-ins menu, select BI Publisher > Preview > HTML.
5. If the preview reflects your expected changes, then change the path at the beginning of your modified .rtf file back to

the original path.
6. From the Add-ins menu, select Validate Template.
7. Save your changes in Microsoft Word.

Uploading the Modified Expense Report Approval Template
To upload and use the modified Expense Report Approval template for email approval notifications, complete these steps:

1. On the Oracle BI Publisher home page, click the Catalog menu.
2. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Workflow Notifications.
3. Click the Expenses subfolder to display the data models and the notification templates.
4. By the Expense Report Approval, click Edit.
5. On the Expense Approval Report page, click Add New Layout.
6. In the Upload or Generate Layout section, click the Upload icon.
7. In the Upload Template File dialog box, Layout Name field, enter UpdatedExpenseApprovalReportTemplate.

The entry represents the name of the Expense Report Approval Template .rtf file that you downloaded and saved to
your local drive with the prefix Updated.

8. In the Template File field, browse for your modified UpdatedExpenseApprovalReportTemplate.rtf file on your local
drive, select the template, and click Open.

9. In the Upload Template File dialog box from the Type choice list, select RTF Template.
10. From the Locale choice list, select English (United States).
11. Click Upload to open the Processing dialog box and return to the Expense Approval Report page.

The uploaded modified .rtf file appears.
12. On the Expense Approval Report page, click the View a list link.
13. In the Layout section in the row for the Updated Expense Report Approval Template, select the Default Layout

check box. This step enables your modified Expense Report Approval Notification template to act as the default
email approval notification.

14. Click the Save Report icon.
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Related Topics

• How You Modify Copies of Predefined Reports

• Set Up for RTF and Excel Report Layout Templates

Example of Modifying Expenses Spend Authorization
Approval Notification Using Oracle Business Intelligence
Publisher
This example shows you how to modify the Authorization Approval Notification template using Oracle Business Intelligence
(BI) Publisher templates.

The following table summarizes questions to consider for this scenario.

Questions to Consider This Example

Do I want to change the header of the
authorization approval notification?
 

Add a word to the header.
 

Do I want to add fields or columns to
or remove fields or columns from the
authorization approval notification?
 

Add a field to the template.
 

You can modify an Expenses BI Publisher authorization approval notification by:

• Editing the Spend Authorization Approval Notification template

• Adding field and table attributes to the Spend Authorization Approval Notification template

Prerequisites
Before you can modify an Expenses workflow authorization approval notification, complete these steps:

1. Download and install the Template Builder for Word, which is a BI Publisher add-on for Microsoft Word.

a. Sign into the Oracle Business Intelligence Publisher server with the BI Administrator Role.
b. On the Oracle Business Intelligence home page by the Get Started section, click the Download BI Publisher

Desktop Tools link.
c. Select and install Template Builder for Word.

2. Download a copy of the subtemplate, which is the AuthorizationApprovalNotificationReport.rtf file, to your local drive.

a. Click the Catalog menu.
b. In the Catalog pane, expand Shared Folders > Common Content > Templates.
c. Click the Edit link for the Authorization Approval Notification template.
d. On the Authorization Approval Email Notification page, click the Edit link.

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAACC1192364
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAACC1354023
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e. Select the Save File option and click OK.
f. Save the AuthorizationApprovalNotificationReport.rtf file to your local drive.

3. Create an spend authorization and note the spend authorization number. You enter the spend authorization number
when you export the data model .xml file.

Editing the Spend Authorization Approval Notification Template
To edit the header section of the Authorization Approval Notification template, complete these steps:

1. Double click the UpdatedAuthorizationApprovalNotificationReport.rtf file you saved to your local drive.
2. In the header section, place your cursor after Authorization Approval.
3. Type Notification. The text now reads Authorization Approval Notification.

You can add, delete, or change words in the Authorization Approval Notification template.
4. Save and close the .rtf file.

Adding Field and Table Attributes to the Spend Authorization
Approval Notification Template
To add field and table attributes to the Authorization Approval Notification template, complete these steps:

1. In Microsoft Word, open your local copy of the UpdatedAuthorizationApprovalNotificationReport.rtf file.

Note:  Depending on your version of Microsoft Word or your installation of Template Builder for Word,
you may see either a BI Publisher tab or you may find BI Publisher by the Add-ins menu.

2. From the Add-ins menu, select BI Publisher > Data > Load Sample XML Data.
3. In the Select XML data dialog box, search for and select the Authorization Approval Data Model .xml file you

downloaded.
4. Click Open.

A message displays that indicates your .xml data was successfully loaded.
5. Click OK.
6. To insert a field in the Authorization Approval Notification template, place your cursor at the end of the line you want

to insert into, and press the Enter key on the keyboard.
7. From the Add-ins menu, select BI Publisher > Insert > Field.
8. In the Field dialog box, scroll to the SPEND_AUTH_HEADER_DS folder, select

SA_FUNCTIONAL_CURRENCY_CODE, and click Insert.
9. Save and close the UpdatedAuthorizationApprovalNotificationReport.rtf file.

Enable Contingent Workers to Enter Expense Reports
Contingent workers are workers who don't have a direct employment relationship with your company. They are typically
supplied by an employment agency or they are self-employed contractors.

Before you can enable and reimburse contingent workers for incurred business expenses, you must perform the high-level
steps listed in the following table.
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Note:  The first two steps are prerequisites for the last step.

High-Level Step Application Selected Action Steps

1
 

In your human resource application, create a
person as a contingent worker.
 

Ensure that you set up the contingent worker
with a Worker Type of Contingent Worker.
 

2
  In your procurement application, set up a:

• Supplier
• Supplier site
• Supplier bank account at the supplier

or supplier site level

You must set up a default payment method
at the supplier or supplier site level.
 

Tip: When you create an invoice,
a payment method is required. If
you don't specify a default payment
method at the supplier site level,
the payment method automatically
populates from the supplier setup.

 

Note: Bank account information is
used to pay supplier invoices by EFT.

 

3
 

In Oracle Fusion Expenses, associate the
contingent worker with the supplier.
 

In the Auditing Tasks pane, click the Manage
Contingent Workers link and select the
applicable supplier and supplier site.

Related Topics
• Payment Methods

• Payment Method Defaulting

• Set Up a Supplier's Bank Account

• Create a Supplier and Supplier Site

• How can I create a user

FAQs for Expenses Configuration

How can I configure an employee's check mailing address?
Sign in to in Oracle Fusion Global Human Resources as a Human Resources specialist and select the applicable check
mailing address.

For an existing employee, navigate to the Manage Employment page. In the Expenses Information section, select Home or
Office from the Expense Check Send-to Address choice list.

For a new employee, navigate to the Hire an Employee page. In the Expenses Information section, select Home or Office
from the Expense Check Send-to Address choice list.

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAIPP301186
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAIPP299003
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=OAPRC1139100
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=OAPRC894008
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FASER365907
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How can I access Expenses predefined flexfields?
Access predefined flexfields using the Define Flexfields task list as follows:

1. In the Setup and Maintenance work area, search for the Define Flexfields task list.
2. Click the Define Flexfields task list link to display the tasks.
3. Click the task link that corresponds to the flexfields you are searching for.
4. Enter data for any of the search parameters and click Search.
5. If you don't know the flexfield name or the code, open the Module choice list and click the Search link.
6. In the User Module Name field, enter Expenses and click Search.
7. Select Expenses and click OK.
8. Click Search.
9. Select a flexfield and click the Edit icon to view its details.

How can I access Expenses predefined lookups?
Access Oracle Fusion Expenses predefined lookups using the Define Lookups task list as follows:

1. In the Setup and Maintenance work area, search for the Define Lookups task list.
2. Click on the Define Lookups task list link to view the Define Lookups tasks.
3. Click the task link that corresponds to the lookups you are searching for.
4. Enter data for any of the search parameters and click Search.
5. If you don't know the lookup type or the meaning, open the Module choice list and click the Search link.
6. In the User Module Name field, enter Expenses and click Search.
7. Select Expenses and click OK.
8. Click Search.
9. Select a lookup type to view its lookup codes.

Tip:  To filter the lookup codes, click the Query By Example icon. Enter the term you want to filter on
and press Enter on the keyboard.

How can I access Expenses predefined profile options?
Access Oracle Fusion Expenses predefined profile options using the Define Profiles task list as follows:

1. In the Setup and Maintenance work area, search for the Manage Profile Options task.
2. Click on the Manage Profile Options task link to open the Manage Profile Options page.
3. Enter data for any of the search parameters and click Search.
4. Alternatively, from the Application choice list, select Expenses and click Search.
5. If you don't know the profile option code or the display name, open the Module choice list and click the Search link.
6. In the User Module Name field, enter Expenses and click Search.
7. Select Expenses and click OK.
8. Click Search.
9. Select a profile option to view its details.
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Can I implement Expenses in another country if I have already
implemented Expenses in one country?
Yes. You must set up applicable expense policies and rules, expense templates, and corporate card programs for the new
country's business units. New users can start entering expenses as soon as setup is complete.

Why do I have to configure the barcode font mapping?
To display and print the barcode properly on expense reports, you must map the barcode font to the correct font in Oracle
Business Intelligence Publisher Enterprise (Oracle BI Publisher Enterprise).

To do this, perform the following steps:

1. In Oracle BI Publisher Enterprise, sign in as a user with Administrator access.
2. In the toolbar, click the Catalog menu.
3. In the Catalog pane, open Shared Folders and then open the Financials folder.
4. Select the Expenses folder and then select the Printable Expense Report Template icon.
5. Click the Edit link. The Printable Expense Report Template tab appears.
6. In the toolbar, click the Properties icon. The Report Properties dialog box appears.
7. In the Report Properties dialog box, select the Font Mapping tab.
8. In the RTF Templates region, add a new row.
9. In the Font Family field, enter Bookman.

10. From the Target Font choice list, select 128R00.TTF.

Note:  Code 128 is the barcode symbology provided with Oracle Fusion Applications.

11. Click the OK button.
12. To save the barcode font mapping, click the Save icon in the toolbar.

To use another barcode symbology, you must load the barcode font to the Oracle BI Publisher Enterprise Server and then
perform steps 1 to 12.

Note:  At any point in time, you can have only one active barcode font mapping for the Printable Expense Report
Template. That is, only one active mapping can be used for the barcode font in the Printable Expense Report
Template.

Can I implement a country-specific version of Oracle Fusion
Expenses?
No. A country-specific version of Expenses isn't available. Expenses supports both global and local requirements.
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How can I enable employees to enter expense reports?
To enable employees to enter expense reports, you must sign in to Oracle Fusion Global Human Resources as a Human
Resources specialist. Then you can create employee records. Whether you create an employee record for an existing or a
new employee, the mandatory Expense Entry Duty is automatically assigned.

For an existing employee, navigate to the Manage Employment page, select the employee's business unit on the Assignment
Details tab in the Assignment section. Then select the default expense account in the Expenses Information section.

For a new employee, navigate to the Hire an Employee page, select the employee's business unit on the Assignment Details
tab in the Assignment section. Then select the default expense account in the Expenses Information region.

How can I enable only a set of users to charge expenses against
projects?
The Project Expense Allocation Duty allows employees to charge expenses against projects and tasks. Manually grant this
duty role to the user when he or she is identified as a project user. To grant the duty role to the user, you must create a
custom role that contains the Project Expense Allocation Duty. Then assign the new custom role to the user.

Alternately, you can also assign the abstract role, Project Team Member, or the job role, Project Manager, to the user. The
user can then charge expenses to projects and tasks.

To enable project users to charge expenses to a project, they must also have a job assigned to them. Assign the job to the
user in the Setup and Maintenance work area by using the Manage Users page. Alternately, you can assign the job to the
user in the Person Management work area by using the Manage Employment page.

How can I enable some or all users to charge against other accounts
or cost centers?
The expense accounting privilege named Override Expense Account Allocation allows employees to charge expenses
against companies and cost centers that aren't their default company or cost center. If users must charge expenses to
other companies or cost centers, you can assign the privilege to some or all employees. To do so, navigate to: Setup and
Maintenance > Tools > Security Console.

How can I enable all account segments for expense report users?
Set the value for the EXM_ALLOW_FULL_ACCT_OVERRIDE profile option to Yes. When you set the profile value to Yes,
expense report users can change the segment values of expense accounts during expense entry to accurately reflect
the charge allocations of their expenses. You can set the value to Yes in the Account field on the Create Expense Item
page. Navigate to: Setup and Maintenance > Search Tasks: Manage Administrator Profile Values > Search:
EXM_ALLOW_FULL_ACCT_OVERRIDE.
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How can I control automatic population of expense fields?
By creating the profile option, EXM_DFLT_FROM_PREV_EXPENSE, on the Manage Administrator Profile Values page
and setting the Profile Value to N at the site, product or user level. When the value is set to N, values that were previously
populating from an expense will stop populating. Instead, only the following fields are automatically populated on the Create
Expense Item page when you create multiple expense items:

• Date: Populated with the system date.

• Currency: Populated with the ledger currency as set up in Human Capital Management.

• Company and Department: Populated with values that are set up in your default expense account in Human
Capital Management.

When the value is set to N, the following fields are blank since they no longer automatically populate values from the previous
expense item:

• Template

• Expense Location

• Project Number and Task Number

In addition, you can optionally prevent automatic population of the conversion rate by deselecting the Default conversion
rate check box on the Edit Conversion Rates and Policies page for a business unit.

What's an expense location?
The location where the expense was incurred. Oracle Expenses captures expense location to enforce corporate policies. The
expense location can determine specific merchant tax fields that appear in the UI, including the tax classification code. The
application uses the location information, which is centrally stored.

Can I deploy Oracle Expenses Cloud as a stand-alone application?
Yes. You can deploy Oracle Expenses Cloud as a stand-alone application if you perform specific product tasks. In Setup and
Maintenance, search and select the Define Ledger Configuration for Rapid Implementation task list and the Define Taxes for
Rapid Implementation task list. Additional tasks to perform include: Manage Common Options for Payables and Procurement,
Manage Disbursement System Options, Manage Payment Methods, and Manage Payment Process Profiles. You must also
set up employees and their assignments in the application.

How can I enable third-party integration for expense report
payments?
You can specify a third-party reimbursement application on the Manage Expenses System Options page. The default option
processes employee expenses through Oracle Fusion Payables.
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2  Credit Card Data

How Corporate Card Transaction Files Are Processed
Before you can begin processing corporate card transaction files, your company must establish connectivity with the
corporate card issuers. You must also determine the transaction file format and the transaction file delivery frequency. After
establishing a secure connection, your company receives transaction files. The application loads the transaction file and
validates the transactions. The application loads eFolio summary and detail transactions if they are present in the file. All valid
transactions are created as expense items and are available to employees for inclusion in the expense reports. All invalid
transactions are available for corporate card administrators to review and correct. After correction, these transactions are
validated again and become available for expense reporting.

When you implement corporate credit card functionality, you must decide whether your company or its employees are
responsible for paying the credit card issuer. The three payment options that you can implement in Expenses are the
following:

• Individual Pay: The employee pays the corporate card issuer for all corporate card transactions

• Company Pay: Your company pays the corporate card issuer for all transactions

• Both Pay: Your company pays the corporate card issuer for business expenses and the employee pays the
corporate card issuer for personal expenses
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This figure shows an overview of the corporate card transaction files processing.
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A Setting That Affects Corporate Card Transaction Files
The process flow of corporate card transaction files is based on which of the three payment options your company decides to
implement. Your company can implement one, two, or all three of the payment options by geographical region, organizational
hierarchy, or other criteria. For example, a global company might have Both Pay implemented in the US and Individual Pay
implemented in the UK. Another company might have Both Pay for one set of organizations and Individual Pay for another set
of organizations within the UK.

When creating a company account for a card program, select a payment option from the Payment Due From list on the
Create Company Account page.
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How Corporate Card Transaction Files Are Processed
This section provides examples of the corporate card transaction files process flow for each payment option. For each
example, assume that an employee reports cash and categorizes card transactions as both business and personal when
creating and submitting an expense report.

Individual Pay
The Individual Pay payment option is simpler than Both Pay or Company Pay. Whether you identify corporate card
transactions as business or personal expenses, the employee pays the corporate card issuer for both business and personal
expenses. When the employee creates an expense report, both business and personal transactions are reported. The
employee is, however, reimbursed by your employer for the corporate card business expenses.

The following table provides an example of Individual Pay corporate card transaction files processing:

Action Description

Set up company account and download
data file.
 

Obtain the corporate card transactions data file from your corporate card provider.
 

Upload data file into Expenses.
 

Upload and validate your corporate card transactions files.
 

Create and submit expense report.
 

When you create an expense report, you select the corporate card transactions that you want to
submit on the report. You determine if transactions are business or personal expenses. By default,
transactions are identified as Business.
 
You're only reimbursed by your employer for business expenses. Once processed on an expense
report, corporate card transactions are no longer available in the list of transactions to be added to
expense reports. This rule applies to both business and personal expenses.
 

Review and approve expense report.
 

After you submit the expense report, your manager must approve it. After managerial approval, the
report is verified to ensure that required receipts are attached and that the report is in compliance
with your company's policies.
 

Reimbursement.
 

After the expense report has been reviewed and approved, it's ready for invoice creation in Payables
to facilitate payment processing. To create an invoice with the amount due to the employee, run
the Process Expense Reimbursements program. Then the payment to the employee is processed
through Oracle Fusion Payments.
 

Company Pay
For the Company Pay payment option, your employer pays the corporate card issuer for all corporate card transactions
incurred by its employees. The employee is only reimbursed for cash business expenses. Corporate card transactions
reported as business expenses have no effect on the amount that is reimbursed to the employee.

Note:  If the employee reports any transactions as personal expenses, these transactions are offset against
any cash business expenses reported. Therefore, the amount reimbursable to the employee is reduced by the
amount of the corporate card personal expenses.
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The following table provides an example of Company Pay corporate card transaction files processing:

Action Description

Set up company account and download
data file.
 

Obtain the corporate card transactions file from your corporate card provider.
 

Upload data file into Expenses.
 

Upload and validate your corporate card transactions files.
 

Create and submit expense report.
 

When you create an expense report, select the corporate card transactions that you want to submit.
You determine if transactions are business or personal expenses.
 
Cash expenses aren't charged to the company corporate card but are considered business
expenses. Cash expenses aren't reimbursed as corporate card business expenses. Corporate card
transactions designated as personal expenses reduce the amount you're reimbursed.
 
You are only reimbursed by your employer for cash business expenses. Once processed on an
expense report, corporate card transactions are no longer available in the list of transactions to be
added to expense reports. This rule applies to both business and personal expenses.
 

Review and approve expense report.
 

After you submit the expense report, your manager must approve it. After managerial approval, your
report is verified to ensure that required receipts are attached and that the report is in compliance
with your company's policies. Any corporate card transactions designated as personal expenses are
also displayed to the managers for review.
 

Export the expense report from
Expenses to Payables.
 

After the expense report has been reviewed and approved, it's ready for invoice creation in Payables
to facilitate payment processing.
 
To create the invoice with the amount due to the employee, run the Process Expense
Reimbursements program. Then the payment to the employee is processed through Oracle Fusion
Payments.
 
To create an invoice with the amount due to the card issuer, run the Create Corporate Card Issuer
Payment Requests process. Then the payment to the employee is processed through Oracle Fusion
Payments. The card issuer can be paid at any time, regardless of the status of the expense report.
 

Both Pay
For the Both Pay payment option, your company pays the corporate card issuer for transactions that are categorized as
business expenses. The employee pays the corporate card issuer for all corporate card transactions reported as personal
expenses. An invoice can't be created for the corporate card issuer until the expense report is exported to Payables as an
invoice.

The following table provides an example of Both Pay corporate card transaction files processing:

Action Description

Set up company account and download
data file.
 

Obtain the corporate card transactions data file from your corporate card provider.
 

Upload data file into Expenses.
 

Upload and validate your corporate card transactions files.
 

Create and submit expense report.
 

When you create an expense report, select the corporate card transactions that you want to submit.
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Action Description

You are reimbursed only by your employer for cash business expenses. Once processed on an
expense report, corporate card transactions are no longer available in the list of transactions to be
added to expense reports. This rule applies to both business and personal expenses.
 

Review and approve expense report.
 

After you submit the expense report, your manager must approve it. After managerial approval, your
report is verified to ensure that required receipts are attached and that the report is in compliance
with your company's policies. When the Payables review process is complete for an expense report,
a new expense report containing only corporate card transactions is created. The new report is
based on the existing report by copying only the business transactions, which are used to pay the
card issuer. If the expense report contains transactions charged to two corporate cards, two reports
are created to pay the corporate card issuers. These reports are named 1 and 2 respectively.
 

Process expense reimbursements.
 

After the card issuer expense report is created, it's ready for invoice creation in Payables to facilitate
payment processing.
 
To create the invoice with the amount due to the employee and to the card issuer, run the Process
Expense Reimbursements program. Then the payment to the employee and the corporate card
issuer is processed through Oracle Fusion Payments. The invoice due to the employee contains
accounting distributions and project accounting, when applicable, for both the cash and corporate
card expenses.
 
The corporate card issuer invoice contains a single accounting distribution for all corporate card
expenses against the expense clearing account.
 

Options for Deciding Who Pays the Corporate Card Issuer
Deciding who is responsible for paying the corporate card issuer is an important decision. You can choose from the following
options:

• Individual Pay: The employee pays the corporate card issuer for all corporate card transactions.

• Company Pay: Your company pays the corporate card issuer for all transactions.

• Both Pay: The employee pays the corporate card issuer for personal expenses and your company pays the
corporate card issuer for business expenses.

Individual Pay
For the Individual Pay option, the employee pays the corporate card issuer for both business and personal transactions. The
employee reports both expenses in expense reports. To ensure that required receipts are attached and that the report is in
compliance with your company's business policies, the employee's expense report is verified. When the report is approved
by the employee's manager, the employee is reimbursed for corporate card business expenses and cash business expenses.

Note:  Cash business expenses are paid by cash or check instead of a corporate card.
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The following table describes the Individual Pay option where employees pay the corporate card issuer for corporate card
business and personal expenses. Your company reimburses employees for corporate card business and cash business
expenses.

Employees Pay Corporate Card
Issuer

Company Pays Corporate Card
Issuer

Company Doesn't Pay Company Reimburses
Employees

• Corporate card business
expenses

• Corporate card personal
expenses

Not Applicable
 

Corporate card personal
expenses
 

• Corporate card business
expenses

• Cash business expenses

Company Pay
For the Company Pay option, the employee doesn't pay the corporate card issuer. Your company pays the corporate card
issuer for corporate card and cash business transactions incurred by the employee. When the employee creates an expense
report, business and personal expenses must be reported, but your company reimburses the employee for corporate card
and cash business expenses. Any personal expenses are deducted from the cash business expenses and recovered by your
company.

Note:  Your company can pay the corporate card issuer at any time, depending on the payment terms.
Submission or approval of expense reports isn't required for payment to the card issuer.

The following table describes the Company Pay option where your company pays for corporate card and cash business
expenses. Your company also reimburses employees for corporate card and cash business expenses.

Employees Pay Corporate Card
Issuer

Company Pays Corporate Card
Issuer

Employees Reimburse Company Company Reimburses
Employees

Not Applicable
 

• Corporate card business
expenses

• Corporate card personal
expenses

Corporate card personal
expenses
 

Cash business expenses
 

Both Pay
For the Both Pay option, the employee pays the corporate card issuer for corporate card transactions reported as personal
expenses and your company pays the corporate card issuer for business expenses. When the employee creates an expense
report, he selects corporate card business transactions. When the report is approved, the employee pays the corporate card
issuer for corporate card personal expenses. Your company reimburses the employee for cash business expenses. This
payment option is also referred to as joint liability.

The following table describes the Both Pay option where employees pays for personal expenses. Your company pays the
corporate card issuer for business expenses.

Employees Pay Corporate Card
Issuer

Company Pays Corporate Card
Issuer

Company Doesn't Pay Company Reimburses
Employees

Corporate card personal
expenses
 

Corporate card business
expenses
 

Corporate card personal
expenses
 

Cash business expenses
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How Accounting Entries for Corporate Card Transactions
Are Distributed
Accounting entries vary depending on which payment option is used by your company.

The following table illustrates a sample expense report with various payment liabilities and amounts.

Payment Method Amount

Cash
 

500 USD
 

Corporate Card Business Expenses
 

650 USD
 

Corporate Card Personal Expenses
 

299 USD
 

Corporate Card Transactions from
Corporate Card Issuer
 

949 USD
 

Data in the preceding table is used in subsequent sections to illustrate how accounting entries are distributed for each
payment liability.

Settings That Affects Payment Options
The following options available from the Payment Option choice list in the Create Company Account dialog box affect
payment liability: Both, Company, and Individual.

How Accounting Entries for Payment Options Are Calculated
When an employee's expense report is exported to Payables, the amount of the payment request equals the amount due the
employee.

The following table summarizes amounts owed by a company to an employee and the corporate card issuer based on the
payment liability.

Payment Liability Expense Report Total Amount Due Employee Amount Due Corporate Card
Issuer

Individual Pay
 

1,150 USD
 

1,150 US
 

0
 

Both Pay
 

1,150 USD
 

500 USD
 

650 USD
 

Company Pay 1,150 USD 201 USD 949 USD
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Payment Liability Expense Report Total Amount Due Employee Amount Due Corporate Card
Issuer

       

Accounting Entries for Individual Pay
Since the payment option is Individual Pay, a single payment request is created to reimburse the employee. It's the
employee's responsibility to pay the card issuer.

The following table describes the accounting distributions for a corporate card with Individual Pay liability.

Account Debit Credit

Cash and other expenses
 

500 USD
 

Not Applicable
 

Corporate card business expenses
 

650 USD
 

Not Applicable
 

Employee liability
 

Not Applicable
 

1,150 USD
 

Accounting Entries for Both Pay
With Both Pay liability, two payment requests are created, one to pay the employee for any out of pocket expenses and a
second one to pay the card issuer.

The following table describes the accounting distributions for a corporate card with Both Pay liability.

Account Debit Credit

Payment Request for Employee
 
Cash and other expenses
 

500 USD
 

Not Applicable
 

Due to employee
 

Not Applicable
 

500 USD
 

Corporate card business expenses
 

650 USD
 

Not Applicable
 

Expenses clearing account
 

  650 USD
 

Payment Request for Card Issuer
 
Expenses clearing account
 

650 USD
 

Not Applicable
 

Due to card issuer
 

Not Applicable
 

650 USD
 

Accounting Entries for Company Pay
With Company Pay liability, a company can pay the card issuer at any time. The payment request for an employee is created
when an expense report is approved and processed, while the payment request for the card issuer is created separately.
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The following table describes the accounting distributions for a corporate card with Company Pay liability.

Account Debit Credit

Payment Request for Employee
 
Cash and other expenses
 

500 USD
 

Not Applicable
 

Corporate card business expenses
 

650 USD
 

Not Applicable
 

Expenses clearing account
 

Not Applicable
 

949 USD
 

Due to employee
 

Not Applicable
 

201 USD
 

Payment Request for Card Issuer
 
Expenses clearing account
 

949 USD
 

 

Due to card issuer
 

Not Applicable
 

949 USD
 

Steps Your Administrator Takes to Receive Transaction
Files from a Card Issuer
Before your company can receive transaction files from a corporate card issuer, your administrator must perform the following
steps:

• Select the correct transaction file format.

• Establish file transfer connectivity.

• Test sample transaction files.

Selecting the Correct Transaction File Format
Your company must verify that the corporate card issuer's file format is supported by Oracle Expenses. Expenses supports
the following corporate card transaction file formats:

Note:  You can no longer load files that contain full card numbers. Card numbers must be masked or tokenized
according to the format.

• American Express GL1025 Card Number Disguising Format

• American Express GL1080 Card Number Disguising Format

• Diner's Club Standard Data File format with Tokens

• MasterCard Common Data Format, version 3.0 (CDF 3.0) Masked

• Visa VCF4 Format with Tokens
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Corporate card issuers require your company to provide organizational hierarchy information that they set up in their system
to satisfy your reporting and billing needs. The organizational hierarchy associates the corporate cards issued to your
employees with the appropriate organizations within your company.

Corporate card issuers can provide your company with a single file that contains all company transactions or a separate
transaction file for each organizational hierarchy. Expenses processes both types of transactions files. To obtain the
appropriate file for your company, communicate your preference to the corporate card issuer.

Establishing File Transfer Connectivity
Work with your card issuer to determine the secure file transfer method that meets your company's security requirements. A
secure connection between the card issuer and your company is required to receive the transaction file from the card issuer's
server. To process the transaction files, Expenses must have read access to the directory location in which the transaction
files are stored.

Note:  For American Express files, Expenses supports automatic download of corporate card transaction files
from the American Express server.

Testing Sample Transaction Files
The corporate card issuer provides your company with transactions file format specifications and sample test files applicable
to your company. Work with your card issuer to identify transactions that you want to include in the test files and the number
of test files required.

Note:  Before you can test the sample transaction files, you must complete the corporate card program setup.

If you automatically assign newly created corporate cards to company accounts based on your setup within the card issuer's
system, then you must set up the company account with the following:

• Company account number

• Card issuer number

• Processor-assigned number

• Market code

• Billing control account number based on your card brand

If you don't plan to automatically assign newly created cards, then you must create one company account per business
unit that pays the card issuer. The application then assigns the corporate card to a company account that is defined for the
business unit of the employee.

If you do plan to automatically assign corporate cards to company accounts based on your setup within the card issuer's
system, you must set up data on the Create Corporate Card Program page.

To test the card issuer's sample transaction files, copy the data from the sample transaction files into the applicable fields on
the Create Corporate Card Program page. To do this, use the data from the sample transaction files to identify what to enter
on the Create Corporate Card Program page.

The following table shows the location of the setup data in the card issuer's sample transaction files.

Tip:  Use this table with the file specification from the card issuer to locate the data in the sample transaction
files.
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Transaction File
Format

Field Name on the
Create Corporate
Card Program Page

Type of Record Data Element Name Data Location in
the Card Issuer's
Transaction File

Tag

American Express
GL1025 Card
Number Disguising
Format
 

Company Account
Number
 

Type 1
 

Global Client Origin
Identifier
 

5-19
 

N/A
 

Market Code
 

Type 1
 
Type 8
 

Market Code
 
Market Code
 

2-4
 
37-39
 

N/A
 

Diner's Club
Standard Data File
Format with Tokens
 

Company Account
Number
 

N/A
 

Link_acct
 

71-89
 

N/A
 

MasterCard
Common Data
Format, version 3.0
(CDF 3.0) Masked
 

Company Account
Number
 

N/A
 

N/A
 

N/A
 

<CorporateEntity>
 
<CorporationNumber>
 

Card Issuer Number
 

N/A
 

N/A
 

N/A
 

<IssuerEntity>
 
<IssuerNumber>
 

Processor-Assigned
Number
 

N/A
 

N/A
 

N/A
 

<IssuerEntity>
 
<ICANumber>
 

Visa VCF4 Format
with Tokens
 

Company Account
Number
 

Block Header
 

Company
Identification
 

Field #2
 

N/A
 

Card Issuer Number
 

Block Header
 

Issuer Identification
Number
 

Field #9
 

N/A
 

Processor-Assigned
Number
 

Block Header
 

Processor
Identification
Number
 

Field #10
 

N/A
 

You can use the following table with the file specification from the card issuer to locate employee numbers in the charge files.

Transaction File Format Type of Record Data Element Name Data Location in Card
Issuer's File

Tag

American Express
GL1025 Card Number
Disguising Format
 

Type 1
 

Employee ID
 

328 to 342
 

N/A
 

MasterCard Common
Data Format, version 3.0
(CDF 3.0) Masked
 

N/A
 

N/A
 

N/A
 

<EmployeeId> in
<AccountInformation_
4300>
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Transaction File Format Type of Record Data Element Name Data Location in Card
Issuer's File

Tag

Visa VCF4 Format with
Tokens
 

Card Account (Type 3)
 

Cardholder Identification
 

Field #2
 

N/A
 

Visa VCF4 Format with
Tokens
 

Cardholder (Type 4)
 

Cardholder Identification
 

Field #3
 

N/A
 

Visa VCF4 Format with
Tokens
 

Cardholder (Type 4)
 

Employee ID
 

Field #23
 

N/A
 

Options for Creating Corporate Cards
You can create corporate cards in two ways. You can choose either of the following actions at different points in time or you
can do both at the same time:

• Automatic corporate card creation

• Manual corporate card creation

Automatic Corporate Card Creation
Automatic corporate card creation applies only to corporate cards that are issued to employees and used primarily for travel
expenses. New employees are typically given new corporate cards, but the information on the cards isn't manually entered
into the application at that time.

You can create corporate cards automatically by selecting an employee matching rule for new cards on the Upload Rules tab
of the Create Corporate Card Program page. Then, when the corporate card transaction file containing transactions for the
new card is uploaded to Expenses for the first time, the corporate card transaction upload and validation process uses the
matching rule to match the new corporate card to the new employee.

Using the specified employee matching rule, the application automatically enters the transaction data for the new corporate
card and associates it with the applicable employee. If the employee matching rule fails to identify a match, the application
leaves the corporate card unassigned.

Tip:  To reduce or eliminate manual effort, automatic corporate card creation is recommended.

Employee Matching Scenarios
Any of these employee matching scenarios can occur for any corporate card brand when the first transaction for a new card
comes in:

• Company account information on the transaction matches the company account information in the application.

The application searches and identifies an employee in the business unit of your company account.

• Company account information on the transaction matches the company account information in the application.

The application searches and doesn't identify an employee in the business unit of your company account.
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If the Perform employee matching across all business units check box is selected, the application searches all
other business units and identifies an employee match.

• The company account in the application has no information, such as company account number, billing control
account, or card issuer number.

If no setup data exists, the application matches across business units, identifies the employee and the employee's
business unit, and associates the corporate card to a company account in the same business unit.

Manual Corporate Card Creation
You can manually create corporate cards for employees in the Create Corporate Card dialog box where you enter the
following data:

• Corporate card program

• Company account name

• Token or masked card number

• Employee name and number

• Expiration date

• Maximum amount per transaction: Applicable for procurement cards only

• Maximum amount per billing period: Applicable for procurement cards only

Note:  Manual creation of corporate cards is the exception, rather than the rule. Corporate cards are company
account-specific. For example, if an employee transfers to another organization within your company and the
organization belongs to another company account, you must create the corporate card again with the applicable
company account name.

Mapping Rules
The corporate card expense type mapping rule is a correspondence between the transaction code in the card feed file
and the predefined card expense type. This linkage enables the application to automatically populate expense types for
transactions in the expense report.

To automatically produce expense types in expense reports, you must perform the following steps:

1. Define corporate card feed file transaction codes as lookup types.
2. Map predefined corporate card expense types to feed file transaction codes.
3. Assign the mapping rule to the corporate card program.
4. Map predefined corporate card expense types to user-defined expense types in the default expense template for

each business unit.
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This figure shows the setup to automatically produce expense types in expense reports, in conjunction with uploading and
validating corporate card transaction files. Ultimately, expense items are displayed in the Expenses work area.

Corporate Card 
Expense Types

Transaction Codes 

-- MIS Industry Codes
--SIC Codes
--Merchant Category Codes

Map Corporate Card 
Expense Types to 
Transaction Codes  

Map Corporate Card 
Expense Types to Expense 

Types  

User-Defined Lookups

User-Defined Mapping

Predefined Lookup

User-Defined
Mapping Rule

Converted to Corporate 
Card Expense Types

Validate

Feed File 
Transaction Codes  

Upload

Converted to 
Expense 

Types

Expense 
Items Display 
in Expenses 
Work Area

Create Expense Items

Upload and Validate Corporate Card Transaction File

Assign Mapping Rule 
to Corporate Card 

Program

Define Feed File Transaction Codes
Corporate card issuers provide the transaction codes for each transaction in a corporate card feed file. These transaction
codes, whether MIS Industry Codes, SIC Codes, or merchant category codes, must be set up in the application as lookups.
Oracle Fusion Expenses provides predefined lookup types so you can define these transaction codes.

Map Corporate Card Expense Types to Transaction Codes
Expenses provides predefined corporate card expense types in a single lookup type. This lookup type can be configured to
include your company's specific expense types. Then you must associate the predefined corporate card expense types with
the corporate card transaction codes. This association is known as a mapping rule.



Oracle Financials Cloud
Implementing Expenses

Chapter 2
Credit Card Data

35

Assign Mapping Rule to Corporate Card Program
To enable the upload process to use the correct mapping rule, you must assign a mapping rule to the corporate card
program. You can set up multiple mapping rules to automatically produce expense types into expense reports for either of the
following:

• Summary transactions, known as eFolio or Level 2

• Detail transactions, known as Level 3

Map Corporate Card Expense Types to Expense Types
To automatically produce expense types into expense reports, you must perform a final setup. In the expense template, you
associate the predefined corporate card expense types with your user-defined expense types. The upload process uses the
default expense template mapping for the transaction's business unit to derive the expense type that's displayed for the card
expense.

Wait Days
Using Oracle Fusion Expenses, you can hold the main corporate card transactions from use until the detail corporate card
transactions arrive. This ensures that employees can include the itemization detail provided by the card issuer in their expense
reports.

Two types of wait days control the maximum duration that the application waits for the detail transactions to arrive:

• Transaction detail wait days

• Merchant wait days

Note:  Wait days are applicable only when the merchant provides Level 3 detail transaction data. No wait period
is applicable for transactions from merchants who don't provide transaction detail.

Transaction Detail Wait Days
Transaction detail wait days are the number of days the application is set up to hold the main transaction data while waiting
for detail transaction data from a merchant. Detail transaction data may or may not arrive.

You can set a wait period at the corporate card program level by selecting a value from the Transaction Detail Wait Days
choice list on the Upload Rules tab of the Create Corporate Card Program page. If defined, the application uses the smaller
value between the transaction detail wait days and the merchant wait days as the wait period for the main transactions.

Merchant Wait Days
Merchant wait days are calculated by the application. It's the difference, in days, between receiving the main transactions and
receiving detail transactions when they arrive for the first time. Thereafter, merchant wait days are computed as follows:

• Detail Transactions Arrival Date minus Main Transactions Arrival Date plus Most Recent Merchant Wait Days for the
Main Transactions Upload divided by two.

A merchant can provide detail transactions either with the main transactions or as a separate delivery. If they're provided as a
separate delivery, the Upload Corporate Card Transaction File process holds the main transactions for a specified time period
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while waiting for the detail transactions. During this wait period, the main transactions aren't available for expense reports.
After each delivery of detail transactions, the merchant's wait days are updated by the application according to the preceding
formula.

Note:  The actual time that data arrives isn't a factor in the merchant wait days or in the application's wait days'
calculation.

The following table shows the calculations associated with detail transactions and merchant wait days based on transaction
data arrival dates using sample data. The table data is based on a transaction detail wait days setting of five days.

Data Upload Main
Transactions
Arrival Date

Detail
Transactions
Arrival Date

Merchant Wait
Days

Application
Transaction Wait
Days

Latest Date
Transactions
are Available in
Expense Report

Actual Date
Transactions
are Available in
Expense Report

First Time: Detail
transactions
arrival date
minus main
transactions
arrival date
 
Thereafter, detail
transactions
arrival date
minus main
transactions
arrival date
plus most
recent merchant
wait days
for the main
transactions
upload divided
by 2.
 

Application uses
the minimum
of transaction
detail wait days
or merchant
wait days
for the main
transactions
upload plus 1
day.
 

Date the
transaction detail
wait days end.
 

Actual date the
main and detail
transactions are
available in the
expense report.
 

Main
Transactions 1
 

May 1
 

N/A
 

N/A
 
The merchant
has never
provided detail
transactions.
Therefore no
merchant wait
days exist in the
application.
 

0 Days
 
The merchant
didn't provide
details
transactions.
Therefore the
application
doesn't wait.
 

May 1
 
Available
immediately.
 

May 1
 
Available
immediately.
 

Detail
Transactions 1
 

N/A
 

May 5
 

4 Days
 

N/A
 

N/A
 

May 5
 

Main
Transactions 2
 

May 7
 

N/A
 

4 Days
 
Previously
calculated
merchant wait
days.
 

5 Days
 
The application
waits for the
minimum of 5
transaction detail
wait days or 4
merchant wait
days plus 1 day.

May 11
 
May 7 + 5
application wait
days = May 12.
 

N/A
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Data Upload Main
Transactions
Arrival Date

Detail
Transactions
Arrival Date

Merchant Wait
Days

Application
Transaction Wait
Days

Latest Date
Transactions
are Available in
Expense Report

Actual Date
Transactions
are Available in
Expense Report

 

Detail
Transactions 2
 

N/A
 

May 9
 

3 Days
 
(May 9 minus
May 7) +4 /2.
 

N/A
 

N/A
 

May 9
 

Main
Transactions 3
 

May 12
 

N/A
 

3 Days
 
Previously
calculated
merchant wait
days.
 

4 Days
 
The application
waits for the
minimum of 5
transaction detail
wait days or 3
merchant wait
days plus 1 day.
 

May 15
 
May 12 + 4
application wait
days = May 16.
 

N/A
 

Travel Card Processing
Travel cards, also known as centrally-billed travel cards, business travel accounts, or ghost cards, are used by companies to
centrally charge high value travel expenses, such as airfare, accommodations, and car rental. The travel card account allows
corporate employees to purchase travel expenses using a single card account, rather than each employee using individual
corporate cards. A centrally-billed card is a single card number that is assigned to an entire company or to a specific business
unit.

Your company can realize the following benefits from using a travel card account:

• Greater visibility into total trip cost

• Accurate travel expense allocation

• On time payment to card issuers

• Integration with American Express

• Cost savings

Processing travel cards includes the following actions:

• Schedule the Upload Corporate Card Transactions process.

• View upload results.

• Schedule the Create Corporate Card Issuer Payment Requests process.

• View payment requests results.

Schedule the Upload Corporate Card Transactions Process
The Upload Corporate Card Transactions process uploads and validates corporate card or travel card transactions from a
card issuer.
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To schedule the Upload Corporate Card Transactions process, navigate to: Navigator > Expenses > Corporate Cards
link > Tasks link > Upload Corporate Card Transactions link > Upload Corporate Card Transactions page.

The following table contains the parameters that you must select on the Upload Corporate Card Transactions page to
schedule the Upload Corporate Card Transactions process.

Parameters Option

Process Type
 

Upload and validate
 

Corporate Card Program
 

Applicable travel card
 

Account Type choice list
 

Centrally-billed card
 

View Upload Results
View upload results in the Corporate Cards work area on the Transactions Upload Results tab. The upload results display
the status of the process, output, and any invalid transaction errors. You can click the View Output icon and the link for the
number of invalid transactions to review details and take corrective action.

Schedule the Create Corporate Card Issuer Payment Requests Process
The Create Corporate Card Issuer Payment Requests process creates invoices for subsequent payment to corporate card or
travel card issuers.

To schedule the Create Corporate Card Issuer Payment Requests process, navigate to: Navigator > Expenses >
Corporate Cards link > Tasks link > Create Corporate Card Issuer Payment Requests link > Create Corporate
Card Issuer Payment Requests page.

The following table contains the parameters that you must select on the Create Corporate Card Issuer Payment Requests
page to schedule the Create Corporate Card Issuer Payment Requests process.

Parameters Option

Corporate Card Program
 

Travel card
 

Account Type choice list
 

Centrally-billed card
 

View Payment Requests Results
View payment requests results in the Corporate Cards work area on the Card Issuer Payment Requests tab. The payment
requests results display the status of the process, as well as output. You can click the View Output icon to review details
and take corrective action.
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How Corporate Card Issuer Payment Requests for
Company Pay Transactions Are Processed
You can run the Create Corporate Card Issuer Payment Requests process to generate payment requests for corporate
card issuers when there are corporate cards that use the Company Pay payment option. The Create Corporate Card Issuer
Payment Requests process is run only when the Company Pay payment option is used.

Note:  You can run the process any time. Since your company's objective is to pay the card issuer on time,
running the Create Corporate Card Issuer Payment Requests process isn't dependent on when an employee
submits an expense report.

This following figure shows how the:

• Create Corporate Card Issuer Payment Requests process generates payment requests to pay corporate card
issuers when corporate cards use the Company Pay payment option.

• Process Expense Reimbursement process generates payment requests to pay employees when corporate cards
use the Company Pay Plus Cash payment option.

Process 
Corporate Card 
Transactions for 

Payment

Create Payables 
Document

Process 
Expense 

Reports for 
Payments

Create Payables 
Document

Pay Corporate 
Card Issuers

Pay Employees

Corporate Card 
Transactions

Employee 
Submits 
Expense 
Reports

Create Corporate Card Issuer
 Payment Requests

Process Expense Reimbursement

Company Pay
 + Cash 

Expenses

Company Pay

Settings That Affect Corporate Card Issuer Payment Requests for
Company Pay Transactions
Settings that affect payment requests for Company Pay transactions are the following:

• Employee Liability Account: Set up as a system option on the Edit Expenses System Options page.
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Note:  To use the Payables default liability account, select the Use setup from Oracle Fusion Payables
option. To define a specific liability account that is specific to a business unit, select the Define value
specific to business unit option and then enter an account. This account is used only if there are cash
expenses in the expense report and reimbursement is due to the employee.

• Corporate Card Issuer Payment Liability Account: Set up in Oracle Fusion Payables.

This account records the amount the company reimburses corporate card issuers for expenses incurred by
employees who use their corporate cards.

• Expense Clearing Account and Payment Option: Set up in the Create Company Account dialog box.

This account temporarily holds accounting for corporate card transactions. It's cleared when the expense reports
containing the corporate card transactions are processed by Payables.

How Corporate Card Issuer Payment Requests for Company Pay
Transactions Are Processed
The Create Corporate Card Issuer Payment Requests process has the following components:

• Populate Payables Open Invoice Interface tables

• Create corporate card issuer payment requests

• Handle processed and rejected expense reports

Populating Payables Open Invoice Interface Tables
For each corporate card, the Create Corporate Card Issuer Payment Requests process creates one invoice header record
in the Payables Open Invoice Interface table. All corporate card transactions for the corporate card are created as child lines.
The accounting distributions for the transactions are created using the Expense Clearing Account for the corporate card.

Creating Corporate Card Issuer Payment Requests
After populating the Payables Open Invoice Interface table, the Create Corporate Card Issuer Payment Requests process
invokes the Import Payables Invoices process in Payables. Payables creates payment requests using the information in the
Payables Open Invoice Interface table. Tax processing isn't applicable for corporate card issuer payment requests.

Handling Processed and Rejected Expense Reports
During payment request creation, Payables rejects records in the Payables Open Invoice Interface table if errors exist, such
as dates in closed accounting periods or invalid payment methods. After payment requests creation is complete, the Create
Corporate Card Issuer Payment Requests process removes any rejected records from the interface table. You must then
reprocess the corporate card transactions for reimbursement.

Finally, all expense items corresponding to the corporate card transactions, for which payment requests are created, are
updated with a corresponding payment request identifier.
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The following table describes the types of payment options for corporate card transactions in expense reports and the
processes that are run to generate their associated payment requests.

Expense Report Payment Options for
Corporate Card Transactions

Process Run Payment Requests Created

• Cash
• Company Pay

• Process Expense Reimbursements
• Create Corporate Card Issuer

Payment Requests

• Employee Payment Requests
• Corporate Card Issuer Payment

Requests

• Individual Pay
• Company Pay

• Process Expense Reimbursements
• Create Corporate Card Issuer

Payment Requests

• Employee Payment Requests
• Corporate Card Issuer Payment

Requests

• Cash
• Individual Pay
• Company Pay

• Process Expense Reimbursements
• Create Corporate Card Issuer

Payment Requests

• Employee Payment Requests
• Corporate Card Issuer Payment

Requests

• Both Pay
• Company Pay

• Process Expense Reimbursements
• Create Corporate Card Issuer

Payment Requests

Corporate Card Issuer Payment Requests
 

• Cash
• Both Pay
• Company Pay

• Process Expense Reimbursements
• Create Corporate Card Issuer

Payment Requests

• Employee Payment Requests
• Corporate Card Issuer Payment

Requests

• Individual Pay
• Both Pay
• Company Pay

• Process Expense Reimbursements
• Create Corporate Card Issuer

Payment Requests

• Employee Payment Requests
• Corporate Card Issuer Payment

Requests

Company Pay only
 

• Process Expense Reimbursements
• Create Corporate Card Issuer

Payment Requests

Corporate Card Issuer Payment Requests
 

Related Topics
• How Expense Report Payment Requests Are Processed

How Corporate Card Transactions for Inactive Employees
Are Processed
Your company can settle inactive employees' accounts with a card issuer in a timely manner. You can grant managers
permission to submit their inactive employees' unpaid corporate card transactions in expense reports. You can process
corporate card transactions for inactive employees by running either of the following processes from the Corporate Cards
work area:

• Upload Corporate Card Transactions

• Process Corporate Cards Transactions for Inactive Employees

Navigate to Corporate Cards work area: Navigator > Corporate Cards link > Overview page or Navigator >Tools >
Scheduled Processes.

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAWDE202958
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An inactive employee is a person who was terminated or who is on unpaid leave. Examples include:

• Military leave

• Extended medical leave

• Educational leave

Settings That Affect Corporate Card Transactions for Inactive
Employees
No prerequisites or setup is required to process corporate card transactions for inactive employees.

The corporate card transaction processes for inactive employees are relevant for Both Pay and Company Pay transactions
only. For Both Pay transactions, your company pays the corporate card issuer for business expenses and the employee
pays the corporate card issuer for personal expenses. Company Pay transactions are those where your company pays the
corporate card issuer for all corporate card transactions incurred by its employees. The employee is reimbursed only for cash
business expenses.

The following table describes selected parameters for the Process Corporate Cards Transactions for Inactive Employees
process.

Parameters Description

Number of Days
 

Value used by the application that represents an interval of time, which the application uses to
determine whether corporate card transactions for inactive employees exist.
 
The default value for Number of Days is one. However, you can adjust this value depending on how
frequently your company updates information about terminated and inactive employees.
 
If your company updates employee information infrequently, the value for Number of Days should be
greater than one.
 

Tip: A large value for Number of Days may impact performance. It's advisable to update
your employee data frequently and enter a small value for Number of Days.

 

Business Unit
 

Unit of an enterprise in a management hierarchy that performs one or multiple business functions.
The process named Process Corporate Cards Transactions for Inactive Employees runs for the
business unit identified by this parameter.
 

How Corporate Card Transactions for Inactive Employees are
Processed
The figure shows the different starting points of the following processes:

• Upload Corporate Card Transactions
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• Process Inactive Employees' Corporate Card Transactions

Upload and Validate 
Corporate Card 

Transactions

Upload Corporate Card 
Transactions process  

Inactive Employee Processing Flow

Start
Identify Inactive Employee 

Corporate Card 
Transactions

Process Corporate Card Transactions for Inactive Employees

Start

Inactive Employee 
Has Unpaid Card 

Transactions?  

Manager Has 
Delegation 
Access?

Manager Accepts 
Delegation 
Access?

Send 
Notice to 
Manager

End

Remove Delegation 
Access from Manager 
if Assigned Previously

Manager 
Reassigns 

Delegation Access 
to Another Person

Send to Manager of 
Manager

Send Notification to 
Manager

End

Notification 
Expired?

End

End

Manager Submits Report

Manager of Manager Submits Report

Delegate Submits 
Report

Yes  

No
No

End

Yes No

Yes

Yes

To run the Upload Corporate Card Transactions process from the Corporate Cards work area, click the Upload Corporate
Card Transactions link in the Tasks list. First, this process validates and uploads corporate card transactions to Expenses.
Second, if the process identifies unpaid corporate card transactions for an inactive employee, the process called Process
Corporate Card Transactions for Inactive Employees initiates.

After Process Corporate Card Transactions for Inactive Employees is initiated and unpaid card transactions are found, a
notification is sent to the inactive employee's manager.



Oracle Financials Cloud
Implementing Expenses

Chapter 2
Credit Card Data

44

If the direct manager doesn't have delegation, he receives a notification. The notification informs him that corporate card
transactions exist for an inactive employee. He can either accept delegation or reassign it to another person.

If no unpaid corporate card transactions exist for an inactive employee, then delegation is removed from the manager if it was
assigned previously.

If the direct manager already has delegation, he receives a notification, informing him that corporate card transactions exist for
an inactive employee. The manager can then submit the unpaid corporate card transactions in an expense report on behalf of
the inactive employee.

Note:  If a person other than the inactive employee's manager accepts delegation, every subsequent notification
is sent to both the inactive employee's manager and the delegate.

When unpaid card transactions for inactive employees are submitted in a report and are paid, delegation is removed from the
manager or other designated person.

Alternatively, you can skip the Upload Corporate Card Transactions process if it's irrelevant, and run the Process Corporate
Card Transactions for Inactive Employees. To run the process, click the Process Corporate Card Transactions for
Inactive Employees link in the Tasks list. This process is run using two parameters: the Business Unit with which the
inactive employee was associated and a value for the Number of Days.

How Downloading Corporate Card Transaction Files From
American Express Are Processed
To download corporate card transaction files from American Express, you must set up Oracle Fusion Expenses to download
data files in conjunction with the Upload Corporate Card Transaction File program.

Note:  You can only download American Express transaction files.

Settings That Affect Downloading Corporate Card Transaction Files
From American Express
Before you can download transaction files from American Express servers, you must set up a Secure File Transfer account
with American Express and obtain the user name and password that identifies your customer account on the Secure File
Transfer server.

To set up the transaction file transfer parameters for the American Express corporate card program, enter the values in the
following table on the Transfer Parameters tab on the Create Corporate Card Program page.

Parameter Description

Download Profile Name
 

Name you enter to identify the download parameters.
 

Account Name
 

Name provided by American Express that identifies your customer account.
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Parameter Description

Account Password
 

Password for the American Express customer account.
 

File Name Prefix
 

File name prefix provided by American Express.
 

Server
 

Name of the American Express server to connect to for the transaction file download.
 

Tip: American Express also provides a server at fsgatewaytest. aexp.com for transaction file
transfer testing.

 

How Downloading Corporate Card Transaction Files From American
Express are Processed
After you complete the tasks for corporate card transaction download, you can use the Upload Corporate Card Transaction
File program with the profile name as a download parameter to download corporate card transaction files from American
Express.

Note:  American Express places one or multiple transaction files at a time in a folder called Outbox in your
customer account. The Upload Corporate Card Transaction File program, however, processes only one file at
a time. The process picks up the oldest file each time. To pick up multiple files, you must schedule the Upload
Corporate Card Transaction File process to run multiple times.

Upload VISA, MasterCard, and Diner's Club Corporate
Card Transactions Files
Before you can process VISA, MasterCard, and Diner's Club corporate card transaction files, you must set up an HTTPS
server, configure the corporate card programs setup, and verify the HTTPS server setup.

Setting Up the HTTPS Server
When you set up the HTTPS server, ensure the following:

1. Install a web server and enable HTTPS.

◦ The server must be externally accessible.

◦ The server must have a valid certificate, such as Verisign.

2. Create the outbox directory on the server.

◦ Create a directory called on the HTTPS server to receive corporate card transaction files.

◦ Secure the directory with a user name and password.
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◦ Enable the directory so it's visible to external users who have read access.

Note:  You must either receive corporate card transaction files directly to the directory from the card issuers
or move the transaction files to this directory from an alternate location where the transaction files are initially
received.

Configuring the Corporate Card Programs Setup
To configure the corporate card programs setup, perform the following steps:

1. In the Upload Parameters section on the Create or Edit Corporate Card Programs page, do the following:

◦ Create a profile with your server address, user name, and password:

For example, a server address of Vision.com/outbox represents the path to the directory, Vision.com/
outbox, that you created.

◦ Enter the full file name of the corporate card transaction file in the File Name Prefix field.

2. Schedule the Upload Corporate Card Transaction Files process to automatically pull and process the transaction
files.

Note:  The Upload Corporate Card Transactions process supports only user name and password-based
authentication.

Verifying the HTTPS Server Setup
To verify the HTTPS server setup, perform the following steps:

1. Verify that the HTTPS server has a valid certificate.

◦ In your browser, enter the server address, such as https://Vision.com/outbox.

If you don't see an error message that indicates an invalid server certificate or an mistrusted server certificate,
then the certificate is correctly installed.

2. Verify that the directory is accessible and secured.

◦ After navigating to the server address, such as https://Vision.com/outbox, if you see a login screen, then
the directory is accessible and secured.

◦ Sign in with user name and password to ensure that the user has access to the outbox directory.

Enable Pretty Good Privacy (PGP) for Corporate Card
Transaction Files
This topic describes how to enable PGP for Visa, MasterCard, or Diner's Club corporate card transaction files. First you
create a PGP encryption certificate and provide it to the card issuer. Using the PGP certificate that you provide, the card
issuer encrypts your corporate card transaction files and sends them to the server that hosts the files for you. Finally, you run
the Upload Corporate Card Transaction File process, which decrypts the files in memory and processes the transactions.
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Note:  PGP encryption isn't applicable to American Express.

Prerequisites
To receive files directly from Visa, MasterCard, or Diner's Club, you must set up an HTTPS or SFTP server at your site or with
a third party. Alternatively, you can set up an HTTPS or SFTP server at the card issuer's site so it can host your corporate
card transaction files.

Note:  Oracle Expenses Cloud doesn't allow card issuers to directly push corporate card transaction files to your
Cloud environment.

Creating a PGP Encryption Certificate
To create a PGP encryption certificate for uploading corporate card transactions files, perform the following steps:

1. Sign in to Oracle Applications Cloud as a user with the IT Security Manager role.
2. From the Springboard, navigate to: Tools > Security Console.
3. Select the Certificates tab.
4. Click the Generate button to open the Generate page.
5. From Certificate Type, select the PGP option.
6. In the Alias field, enter EXM_PGP_KEY.

Note:  The alias you enter must exactly match EXM_PGP_KEY.

7. In the Passphrase field, enter a password.

Caution:  Store the password in a safe location. If you need to delete this certificate in the future, the
password is required.

8. From the Key Algorithm choice list, select the algorithm that you want to use.

Note:  A 256 bit algorithm isn't supported.

9. From the Key Length choice list, select the length that you want to use.
10. Click the Save and Close button.

Exporting a PGP Encryption Certificate
To export the PGP encryption certificate to your card issuer, perform the following steps:

1. On the Certificates page, select the EXM_PGP_KEY row, and click the down arrow to open actions available for this
certificate.

2. Select Export > Public Key.
3. Save the public key file.
4. Provide the public key file to your card issuer.

Note:  Using the public key, your card issuer must encrypt your corporate card transactions files.
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Verifying Encrypted Files
Contact the card issuer to verify that the files are encrypted.

Processing Encrypted Transaction Files
Run or schedule the Upload Corporate Card Transaction File process. The process uses the alias, EXM_PGP_KEY, decrypts
the corporate card transaction files, and processes the transactions.

Set Up to Receive American Express GL1025 Tokenized
Files
Your company can receive and process American Express GL1025 files with card disguising numbers, also known as
tokenized GL1025 files. Card disguising numbers, or token numbers, are random numbers generated by American Express
that are used in place of valid card numbers. The token numbers remain the same throughout the life of the cards. Using
tokenized GL1025 files eliminates storage of full card numbers and lets you use the American Express remittance process,
Global Remittance Utility.

Note:  Only American Express GL1025 files support tokenization. You can no longer load files that contain full
card numbers.

To receive tokenized GL1025 files from American Express, you must:

• Set up your company in American Express

• Set up your company in Expenses

• Upload tokenized files

Setting Up Your Company in American Express
To receive tokenized GL1025 files instead of standard GL1025 files, contact American Express through your AMEX
representative. You must decide and inform American Express of the following:

• Regions, territories, or countries for which you want to receive tokenized files

• Mailbox or user account where you want to receive tokenized GL1025 files on the American Express production
server

• File prefix: A unique file prefix that identifies your GL1025 files in the American Express folder. The file prefix is
mutually agreed to by you and American Express.

• Mailbox or user account where you want to receive test files

American Express lets you use production files for testing. It can place production files on the AMEX production server or the
test server. Notify American Express of your server preference for testing.

After American Express sets up your company for tokenized GL1025 files, you can start testing in Expenses.
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Setting Up Your Company in Expenses
To receive tokenized GL1025 files, you must create a card program with tokenization enabled by performing the following
steps:

1. Sign in to Expenses as a corporate card administrator.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Corporate Card Programs

3. Click the Create icon.
4. On the Create Corporate Card Program page, perform the following steps:

a. In the Name field, enter a name for your corporate card program.
b. From the Card Type choice list, select Travel.
c. From the Card Brand choice list, select American Express.
d. Select the Upload Rules tab.
e. In the File Format field, American Express GL1025 is read-only.
f. From the Card Number Format choice list, select Token.
g. Select the Transfer Parameters tab.
h. Transfer parameters define the connection details between Expenses and American Express.
i. Click the Create icon to open the Create Transfer Parameter dialog box.

i. In the Download Profile Name field, enter meaningful values to identify the connection details. For
example, if you are creating the connection details for connecting to the American Express test server,
you might enter AMEX Test.

ii. In the Account Name field, enter the user name of the mailbox where GL1025 files are placed.
iii. In the Account Password field, enter a password for your mailbox.
iv. In the File Name Prefix field, enter your prefix for the GL1025 files. The Upload Corporate Card

Transactions process processes files with this prefix.
v. In the Server field, enter the name of the American Express server where your mailbox exists. GL1025

files are always placed in the outbox folder as follows:

a. fsgatewaytest.aexp.com for test server
b. fsgateway.aexp.com for production server

vi. Click Save and Close.
5. In the Company Accounts section, click on the Create icon to open the Create Company Account dialog box.

a. In the Company Account Name field, enter the name of your company account with American Express.
b. Optionally, enter values that American Express provides to your company in the following fields:

• Company Account Number
• Market Code
• Requesting Control Account Number

c. From the Card Issuer choice list, select the name of the company that is issuing the American Express card to
its employees.
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d. From the Card Issuer Site choice list, select the site of the company that is issuing the American Express card
to its employees.

e. From the Payables Business Unit choice list, select the Oracle Payables business unit that reimburses
employees for corporate card charges.

f. From the Payment Currency choice list, select the three-letter code that represents the currency in which
reimbursements are made.

g. From the Payment Option choice list, select the option that determines whether your company, its employees,
or a combination of the two are responsible for paying the credit card issuer.

h. Remittance Details section: Captures additional parameters for the generation of remittance advice.
Remittance advice is a file that provides the amount paid by your company to American Express by credit
card number. The Global Remittance Utility uses the tokenized card number instead of the real card number.

i. In the Book Number field, enter the financial accounting identifier used in the US and Canada for American
Express

j. In the Load Number field, enter the sender identifier in a remittance file that is transmitted to American
Express. This identifier is provided by American Express.

k. From the Card Issuer Country Code choice list, select the applicable two-letter country code.
l. In the Card Disguising Control Account Number field, enter the control account for the token numbers.

Caution:  If you currently receive standard GL1025 files, you can convert your existing card program to a
tokenized program. However, you should not create a new card program because all cards will be recreated by
the new card program.

Uploading Tokenized Files
Uploading and processing tokenized GL1025 files is exactly the same as the standard GL1025 files. The process creates
tokenized cards and matches them to employees if employee numbers are provided in the GL1025 files. Employee numbers
in the GL1025 files must match person numbers in Oracle Fusion Human Capital Management.

To upload tokenized files, perform the following steps:

1. Manually run or schedule the Upload Corporate Card Transactions process from the Corporate Cards work area.
2. Review the upload results in the Corporate Cards work area and correct any errors.
3. On the Review Corporate Card Transactions page, review unassigned cards and assign them to the correct

employees. On this page, you can see the tokenized card numbers, not the real card numbers.

All corporate card processes support tokenized cards. This includes the following processes:

• Manage Historical Corporate Card Transactions process

• Create Corporate Card Issuer Payment Requests process

Enable Tokenization for Visa VCF4 Files
Oracle Expenses accepts Visa VCF4 files that are tokenized. Visa tokens can include numbers and characters.

To enable tokenization for Visa VCF4 files, complete these steps:

1. In the Setup and Maintenance work area, select:

◦ Offering: Financials

◦ Functional Area: Expenses
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◦ Task: Manage Corporate Card Programs

2. On the Manage Corporate Card Programs page, click the + (Create) icon.
3. On the Create Corporate Card Program page in the Name field, enter a name for your Visa corporate card program.
4. From the Card Type choice list, select Procurement or Travel.
5. From the Card Brand choice list, select Visa.

On the Upload Rules tab, the File Format label shows Visa VCF4 as read-only.
6. From the Card Number Format choice list, select Token.
7. Click Save and Close.

Simplified Configuration for MasterCard CDF3 and Visa
VCF4 Files
You can set up your company account with MasterCard under a single company account number globally. This simplified
configuration supports corporate card transaction files that are generated for multiple entities in your company under a single
company account number. The same setup is also available for Visa card programs.

To simplify your company account setup on the Create Company Account dialog box, you're not required to enter values for
these fields:

• Company Account Number

• Card Issuer Number

• Processor-Assigned Number

For added convenience, if your company accounts aren't set up so they correspond to business units, the application can
perform employee matching across all business units. This matching occurs when a transaction in a charge file matches
a company account based on the information that came in the transaction, but the employee number isn't in the same
business unit. To match employee transactions across business units, select the Perform employee matching across all
business units check box on the Create Corporate Card Program page, File Details section, Upload Rules tab.

When you run the Upload Corporate Card Transaction Files process, it uploads and validates your corporate card
transactions files.

Related Topics

• How You Upload Corporate Card Transactions with Encrypted Card Numbers

Upload American Express Non-Financial Transactions
To upload American Express non-financial transactions, you must create the lookup type EXM_CC_AMEX_NF_FEES. Non-
financial transactions are transactions where the MIS transaction code is NF in the corporate card transactions file. Examples
of non-financial transactions include a membership rewards annual fee and a membership reinstatement fee.

Create the lookup type EXM_CC_AMEX_NF_FEES with its associated lookup codes.

1. In the Setup and Maintenance work area, use:

◦ Offering: Financials

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=19C2CC04E46136B7E05362C3F00A5E0F
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◦ Functional Area: Expenses

◦ Task: Manage Standard Lookups

2. On the Manage Standard Lookups page in the Search Results section, click the New icon.
3. In the Lookup Type field, enter EXM_CC_AMEX_NF_FEES.
4. In the Meaning field, enter an applicable meaning.
5. In the Description field, enter an applicable description.
6. From the Module choice list, search and select Expenses.
7. Click Save.
8. In the EXM_CC_AMEX_NF_FEES: Lookup Codes section, add lookup codes for each of the non-financial

transactions that you would like to load.
9. In the Lookup Code field, enter a code that represents the name of the lookup code, such as NF_MEMRWDS.

10. In the Meaning field, you must enter the same description you receive in the feed, such as MEM RWDS ANNUAL
PROG.

11. In the Description field, enter a description for the lookup code meaning, such as Membership Rewards Annual
Fee.

12. Click Save and Close.
13. Schedule the Upload Corporate Card Transactions process to load the American Express non-financial transactions.

Set Up Remittance Advice for American Express Tokenized
GL1025 Files
If your company uses American Express tokenized GL1025 files, you can use the American Express remittance format,
Global Remittance Utility, to generate remittance advice. The typical company scenario unfolds when employees use
American Express corporate cards for business expenses and then submit expense reports. After expense report approval,
Oracle Payables pays the American Express invoice by making a single payment. You can optionally send a remittance file to
American Express that lists employee card holders and the amounts of their respective payments.

Before you start, you must add the predefined privilege, Submit Corporate Card Remittance File, to your user account. This
privilege isn't assigned to any roles out of the box.

Enable the transmission of remittance advice for American Express tokenized GL1025 files by doing these tasks:

1. Configure the predefined American Express Global Remittance Utility format.
2. Create a remittance file format.
3. Create a transmission file configuration.
4. Modify the payment process profile.
5. Submit the payment process request.
6. Run the Submit Corporate Card Remittance File process.
7. Transmit the remittance advice to American Express.

Configure the Predefined American Express Global Remittance Utility Format
You must configure the predefined remittance advice format to reflect your company details. To configure the Global
Remittance Utility format, sign in as a user with access to Reports and Analytics.

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.
2. On the Oracle BI Publisher home page, click the Catalog menu.
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3. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Payments.
4. Locate Disbursement Corporate Credit Card Remittance Formats.
5. From the More menu, select Customize to create a copy of the report so you can upload a custom template.
6. In the Disbursement Corporate Credit Card Remittance Formats page, click the Edit link to download and save the

CorporateCreditCardRemittanceFile.rtf to your local drive.
7. On your local drive, navigate to the saved RTF file and open it.
8. Locate Record Type 00 in the OutboundPaymentInstruction table.
9. At position 3, change the text in the <DATA> column to reflect your company's Global Corporate Identifier. American

Express provides this value.
10. Locate Record Type 01 in the OutboundPayableLine table.
11. At position 3, change the text in the <DATA> column so it reads as follows after IF SUM:

(DocumentPayableLine/LineGrossAmount/Value) < 0 THEN '+' ELSE '-' END IF

12. At position 4, change the text in the <DATA> column so it reads as follows after ABS:

(ROUND (SUM (DocumentPayableLine/LineGrossAmount/Value)*100))

13. Starting at position 223, add the Card Disguising Number Control Account in the <DATA> column. The range of the
position is from 223 to 241.

Note:  The Card Disguising Number may or may not be the control account that the cards belong to.
Regardless, the card number disguising is set up at the control account number. All accounts below
this hierarchy level are disguised.

14. Locate Record Type 02 in the OutboundPaymentInstruction table.
15. At position 85, add the payment date in the <FORMAT> column.
16. At position 85 in the <DATA> column, add InstructionGrouping/PaymentDate.

Tip:  The payment date must be on or after the payment file date.

17. Upload a copy of the modified template to Oracle BI Publisher.

Create a Remittance File Format
To create a remittance file format, complete these steps:

1. In the Setup and Maintenance work area, use:

◦ Offering: Financials

◦ Functional area: Payments

◦ Task: Manage Formats

2. On the Manage Formats page from the Select Type choice list, select Disbursement Corporate Credit Card
Remittance File.

3. Click Create.
4. On the Create Format page in the Name field, enter a name for the remittance file format.
5. In the Code field, enter a code for the remittance file format.
6. From the BI Publisher Template choice list, select the template that you uploaded to BI Publisher.
7. Click Save and Close.
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Create a Transmission Configuration
To create a transmission configuration, complete these steps:

1. In the Setup and Maintenance work area, use:

◦ Offering: Financials

◦ Functional area: Payments

◦ Task: Manage Transmission Configurations

2. On the Manage Transmission Configurations page from the Select Protocol choice list, select Secure File Transfer
Protocol for Static File Names.

3. Click Create.
4. On the Create Transmission Configuration page in the Configuration field, enter a name for the configuration.
5. In the Value field for Sent File Name, enter GRU.<your company ID>.&REQUESTID.&PAYMENTFILEID.&DATE.
6. Obtain the necessary parameter values to enter from American Express.
7. Click Save and Close.

Modify the Payment Process Profile
To modify the applicable payment process profile, complete these steps:

1. In the Setup and Maintenance work area, use:
a. Offering: Financials
b. Functional area: Payments
c. Task: Manage Payment Process Profiles

2. On the Payment File tab, select the Payment date check box.
3. Click Save and Close.

Submit the Payment Process Request
To submit the payment process request to pay American Express, complete these steps:

Tip:  Make a note of the payment file reference number because you will select it later when you run the Submit
Corporate Card Remittance File process to generate the remittance advice.

1. In the Oracle Payments work area, click the Tasks icon and click the Submit Payment Process Request link.
2. On the Submit Payment Process Request page, select the Selection Criteria tab, and complete the applicable fields.
3. For Pay Groups, select Specific.
4. In the Search and Select: Pay Group dialog box, search and select the pay group that you chose for the American

Express company account when you set up the American Express card program in Oracle Expenses.
This ensures that only invoices related to American Express will be picked up in the payment batch.

5. Select the Payment and Processing Options tab and complete the applicable fields.
6. Click Submit.

Run the Submit Corporate Card Remittance File Process
Schedule or run the Submit Corporate Card Remittance File process.

1. Navigator > Tools > Scheduled Processes.
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2. Click Schedule New Process.
3. In the Schedule New Process dialog box, search and select Submit Corporate Card Remittance File.
4. Click OK.
5. In the Process Details dialog box of the Submit Corporate Card Remittance File process, enter these parameter

values.

Field Name Parameter Value

Payment File choice list
 

Reference number of payment file that was generated when the payment was made to American
Express.
 

Format choice list
 

Name of customized remittance advice format that you configured in BI Publisher.
 

File Sequence Number field
 

User-defined value. This value must be unique and entered within a day of transmission for each
Global Corporate Identifier.
 

File Version Number field
 

The default value is 00.
 
If American Express rejects any remittance file and if you resubmit the same file, you must increment
the value to 01, 02, 03 and so on to represent the new version. The latest version replaces the
previous version.
 

Transmission Configuration choice list
 

Transmission configuration that you set up to transmit Global Remittance Utility files to American
Express.
 

Transmit the Remittance Advice to American Express
In the Process Details dialog box of the Submit Corporate Card Remittance File process, click Submit. The remittance advice
file is then automatically transmitted to American Express.

Related Topics
• How You Use Oracle BI Publisher Enterprise to Modify Templates for Use with Formats

• How You Set Up Transmission Configurations

• Payment Process Profiles

• How You Set Up Formats

FAQs for Credit Card Data

What's a corporate card program?
A corporate card program is an agreement between the corporate card issuer and your company. The agreement governs
the issuance of corporate cards to your employees and the payment to the card issuer. Your company can have a single
card provider that provides corporate cards for your employees globally, which is referred to as a global card program.
Alternatively, you can have multiple card providers that provide corporate cards for your employees based on the region and
the services needed.

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAIEX3347162
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAIEX3347162
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAIPP156104
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAIEX3347162
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A corporate card program consists of one or more company accounts that represent a specific organizational hierarchy in
your company. Each company account is associated with:

• A card issuing bank, known as a card issuer

• Payment terms

• Other agreements

Your company can elect to receive electronic files containing the corporate card transactions of their employees on a regular
basis. The file format and method of delivery are agreed to and set up before your company processes corporate card
transaction files through Oracle Fusion Expenses.

How can I configure corporate card issuers?
You can set up a corporate card issuer through the Manage Corporate Card Issuers page. You can enter the card issuer's
site information and payment information. To pay a card issuer, enter a default payment method in the Address Payment
Information section on the Edit Corporate Card Issuer page. Then you associate the newly created card issuer with your
company account on the Create Company Account page. By selecting a payment currency and payment terms on the
Create Company Account page, you can complete the information necessary to pay the card issuer.

How can I enforce corporate card usage policies?
Your company can set up corporate card usage rules to enforce its policies regarding the use of corporate cards. On the
Manage Corporate Card Usage Policies page, you can define the allowable amount for each expense category that can
be charged as a cash expense. Over this cash limit, employees are required to use their corporate cards. Employees who
exceed the cash limit receive either a warning message or an error message while completing expense entry. A warning
reminds employees to use the corporate card. An error prevents submission of the expense report. Expenses notifies the
expense auditor and the employee's manager of the policy violations. Alternatively, if no cash limits are defined, you can
submit cash expenses of any amount.

Can corporate card administrators view full credit card numbers
associated with tokenized card numbers in Expenses?
No. Corporate card administrators can't view real card number in Expenses. They can only view tokenized card numbers. To
view full card numbers, you can request a GL1210 report from American Express.

Can corporate card administrators view full credit card numbers
associated with tokenized card numbers in American Express?
Yes. Tokenized card numbers are provided only for payment processing. American Express continues to display full card
numbers, even if you receive tokenized card files. To view full card numbers with their associated tokens, you can request
transmission of a GL1210 report to your AMEX mailbox.
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How can I prevent workers from overriding the merchant name on
credit card transactions?
By creating the profile option, EXM_DISABLE_CC_MERCHANT_NAME, and setting the value to Y. When this occurs, the
value in the Merchant Name field becomes read-only on the Create Expense Item page for both the web-based and the
mobile application. A read-only value in the Merchant Name field prevents employees from changing it, which maintains
data integrity.
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3  Expense Policies and Rules

Set Up Delegations
A delegate is a person who is authorized to perform expense entry and management of another person's expense reports. A
delegation is the relationship between a delegate and the person for whom the delegate enters expense reports. By setting
up delegations, you can:

• Specify a delegate who enters expense reports for one or more people.

• Specify a person, or assignment, for whom the delegate enters expense reports.

• Specify whether the delegate can change any or all accounting segments, such as company and cost center.

• Specify whether the delegate can change project or task information for project-related expenses.

Setting Up a Delegation
To set up a delegation, follow these steps:

1. In the Setup and Maintenance work area, use the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Delegations

2. On the Manage Delegations page, click the Create (+) icon.
3. On the Create Delegation page in the Delegate choice list, enter or select the name of the person who will enter

expense reports for one or more people.
4. From the Assignment choice list, enter or select the name of the person who is assigned to the delegate and for

whom the delegate enters expense reports.
5. If the assignment already has the accounting privilege named Override expense account allocation, select the

Accounting access check box.
6. If the assignment already has the project privilege named Allocate project expense, select the Project access

check box.

Caution:  Ensure that you check whether the assignment has the accounting or the project privilege
access. If you select the Accounting access or the Project access check box and the assignment
doesn't already have the applicable privilege set up in the Security module, then the person is given
unintended access.

Related Topics

• How You Manage Delegates

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAWDE792429
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How You Configure Approval Rules
Oracle Fusion Expenses supports flexible and configurable approval rules for expense report approval using the Approvals
Management Extensions of the Oracle Service-Oriented Architecture (SOA) suite and Oracle Business Process Management
Suite (BPM). BPM provides the interface to administer the approval rules. A BPM Worklist administrator who is assigned the
role of Financial Application Administrator (FUN_FINANCIAL_APPLICATION_ADMINISTRATOR) can access the approval rules
in the BPM Worklist.

When you submit an expense report, Expenses invokes the approval process, which prompts a set of approval rules created
in AMX to build the list of approvers. Approvals Management Extensions sends approval notifications to approvers every time
it receives a response to an approval notification. AMX continues sending approval notifications to the next set of approvers in
the approval list until all approvals are complete.

The approval rules are managed through the Oracle BPM Worklist. Navigate to: Setup and Maintenance > Select:
Financials > Setup button > Functional Areas: Expenses > Show: All Tasks > Manage Expense Approval Rules >
Oracle BPM Worklist.

To configure or modify rules, perform the following steps:

1. In the BPM Worklist, select the Task Configuration tab.
2. From the Tasks to be configured pane, select FinExmWorkflowExpenseApproval.
3. Select the Assignees tab.
4. Click the Switch to Vertical Layout link. An approval hierarchy displays.
5. By the SoaOLabelExp rectangle, click the diamond icon and select Go to Rule.

The expense approval flow contains predefined rule sets with their associated approvers as described in the following table:

Rule Set Approval by

ExpenseReportRuleSet

• CustomSerialParticipantRuleSet
• CustomParallelParticipantRuleSet

Supervisor

• Additional serial approval rules for configuration
• Additional parallel approval rules for configuration

CostCenterRuleSet
 

Cost center owners in parallel mode
 

ProjectManagerRuleSet
 

Project managers in parallel mode
 

ExpenseRuleSet
 

A specialist based on expense types in parallel mode
 

SerialCostCenterRuleSet
 

Cost center owners in serial mode
 

SerialProjectManagerRuleSet
 

Project managers in serial mode
 

SerialExpenseRuleSet
 

A specialist based on expense types in serial mode
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ExpenseReportRuleSet: Approval by Supervisor
The predefined rule set for approval of expense reports using the supervisory hierarchy is called ExpenseReportRuleSet. The
predefined rules include the following:

• Approval by the immediate supervisor of expense reports with a report total over 1000

• Automatic response for all expense reports with a report total equal to or less than 1000

You can change the predefined rules, delete, or add rules as needed. The following table lists the parameters for the
ExpenseReportRuleSet rule set.

Rule Field Predefined Value Description

ExpenseReportManagerApprovalRule
 

Condition
 

Task. payload.
getExpenseReportVOResponse.
result. expenseReportTotal
 

Attribute that stores the expense
report total in the reimbursement
currency.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

Starting Participant
 

HierarchyBuilder.
getManager("supervisory"Task.
creator -1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.
getPrincipal("FINUSER30"-1"","")
 

Last approver in the approval
chain. Approval doesn't go
beyond this participant in a
hierarchy. To use this rule
as is, you must change the
predefined last approver user
name to the last approver in your
organization.
 

Auto Action Enabled
 

False
 

Automatic approval action is
disabled.
 

Auto Action
 

Null
 

No automatic approval action.
 

ExpenseReportAutoApprovalRule
 

Condition
 

Task. payload.
getExpenseReportVOResponse.
result. expenseReportTotal
 

Attribute that stores the expense
report total in the reimbursement
currency.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
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Rule Field Predefined Value Description

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

Starting Participant
 

HierarchyBuilder.
getPrincipal("workflowsystem"-1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.
getPrincipal(Task. creator-1"","")
 

Person for whom the expense
report is submitted.
 

Auto Action Enabled
 

True
 

Automatic approval is enabled.
 

Auto Action
 

Approve
 

The response is set to Approve.
 

ExpenseReportInactiveEmployeeManagerApproverRule
 

Condition
 

Task. payload. employeeInActive
 

Attribute that stores the
condition.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

Starting Participant
 

HierarchyBuilder.
getPrincipal(Task. payload.
startingParticipant-1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.
getPrincipal("FINUSER30"-1,"","")
 

Last approver in the approval
chain. Approval doesn't go
beyond this participant in a
hierarchy. To use this rule
as is, you must change the
predefined last approver user
name to the last approver in your
organization.
 

Auto Action Enabled
 

False
 

Automatic approval action is
disabled.
 

Auto Action
 

null
 

No automatic approval action.
OR The response is set to
Approve.
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Additional Serial Approval Rules for Configuration: This is an additional predefined rule set for serial approval called
CustomSerialParticipantRule. This rule set doesn't contain any predefined rules. You can use this rule set for any additional
combination of approval rules that needs to be executed sequentially with respect to the rules in ExpenseReportRuleSet.

Additional Parallel Approval Rules for Configuration: This is an additional predefined rule set for parallel approval called
CustomParallelParticipantRule. This rule set doesn't contain any predefined rules. You can use this rule set for any additional
combination of approval rules that needs to be executed in parallel to the rules in ExpenseReportRuleSet.

ProjectManagerRuleSet: Approval by Project Managers in Parallel Mode
The predefined rule set for approval of expense reports by project managers is called ProjectManagerRuleSet. This rule set
has a single predefined rule. The rule says that if the total amount charged to projects is greater than zero, the expense report
is sent to the project manager for approval. Additionally, if expenses are charged to more than one project, the applicable
project managers receive the approval notification in parallel. The approval is complete when all project managers identified as
approvers have approved the expense report.

You can change the predefined rules, delete, or add rules as needed. The following table lists the parameters for the
ProjectManagerRuleSet rule set.

Rule Field Predefined Value Description

ProjectManagerApprovalRule
 

Condition
 

ExpenseReport/
projectTotalVOtotal
 

Attribute that stores the total
expense charged against each
project in an expense report. The
view object only stores details
for expense reports that contain
projects.
 

List Builder
 

Resource
 

Static list of approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Participants
 

ExpenseReport/
projectTotalVOmanagerUsername
 

The approver of the expense
report is the project manager.
 

CostCenterRuleSet: Approval by Cost Center Owners in Parallel Mode
The predefined rule set for approval of expense reports by cost center owners is called CostCenterRuleSet. This rule set has
the following predefined rules:

• If the total amount charged to cost centers other than the employee's default cost center is greater than zero, the
expense report is sent to the cost center owner for approval.

◦ If expenses are charged to a cost center other than the employee's default cost center, the applicable cost
center owners receive the approval notification in parallel. The approval is complete when all cost center
owners identified as approvers have approved the expense report.

• If the cost center of the expenses is the same as the default cost center of the employee, an automatic response is
generated that indicates there is no cost center approval.
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You can change the predefined rules, delete, or add rules as needed. The following table lists the parameters for the
CostCenterRuleSet rule set.

Rule Field Predefined Value Description

CostcenterIsNotEmpDefaultCostcenterRule
 

Condition
 

ExpenseReport/
costCenterTotalVOcostCenter
 

Attribute that stores the cost
centers in the expense report.
 

Condition
 

Task. payload.
getExpenseReportVOResponse.
result. defaultCostCenter
 

Default cost center of the
employee.
 

List Builder
 

Resource
 

Static list of approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Participants
 

ExpenseReport/
costCenterTotalVOmanagerUsername
 

The approver of the expense
report is the cost center owner.
 

CostcenterIsEmpDefaultCostcenterRule
 

Condition
 

ExpenseReport/
costCenterTotalVOcostCenter
 

Attribute that stores the cost
centers in the expense report.
 

Condition
 

Task. payload.
getExpenseReportVOResponse.
result. defaultCostCenter
 

Default cost center of the
employee.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

Starting Participant
 

HierarchyBuilder.
getPrincipal("workflowsystem"-1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.
getPrincipal(Task. creator-1"","")
 

Person for whom the expense
report is submitted.
 

Auto Action Enabled
 

True
 

Automatic approval is enabled.
 

Auto Action
 

Approve
 

The response is set to Approve.
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ExpenseRuleSet: Approval by a Specialist Based on Expense Types in Parallel
Mode
The predefined rule set for approval of expense reports based on the template name or any attributes of the expense type is
called ExpenseRuleSet. This rule set has the following predefined rules:

• If the template name for any of the expenses is Relocation Expenses, the expense report is routed to approval by a
predefined user.

• If the expense reports don't contain any expenses with the expense template Relocation Expenses, an automatic
approval response is generated that indicates there is no special approval.

You can change the predefined rules, delete, or add rules as needed. The following table lists selected parameters for the
ExpenseRuleSet rule set.

Rule Field Predefined Value Description

ExpenseTypeIsRelocationExpensesRule
 

Condition
 

ExpenseReport/
expenseVOexpenseTemplateName
 

Attribute that stores the cost
centers in the expense report.
 

List Builder
 

Resource
 

Static list of approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Participants
 

User ID of the approver
 

The approver of the expense
report is a specialist.
 

ExpenseTypeIsNotRelocationExpensesRule
 

Condition
 

ExpenseReport/
expenseVOexpenseTemplateName
 

Auto approval enabled with
the same list builder criteria as
ExpenseReportAutoApprovalRule
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

Starting Participant
 

HierarchyBuilder.
getPrincipal("workflowsystem"-1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.
getPrincipal(Task. creator-1,"","")
 

Person for whom the expense
report is submitted.
 

Auto Action Enabled
 

True
 

Automatic approval is enabled.
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SerialProjectManagerRuleSet: Approval by Project Managers in Serial Mode
The predefined rule set for approval of expense reports in serial mode by project managers is called
SerialProjectManagerRuleSet. This rule set contains the same rule as the parallel approval, but the rule set is configured to
send the approval notifications sequentially to the approvers in the list. Each notification to a subsequent approver is sent
only after the current approver approves the expense report. If the current approver rejects the expense report, the approval
process is complete and the report returns to the user.

SerialCostCenterRuleSet: Approval by Cost Center Owners in Serial Mode
The predefined rule set for approval of expense reports in serial mode by cost center owners is called
SerialCostCenterRuleSet. This rule set contains the same rule as the parallel approval, but the rule set is configured to send
the approval notifications sequentially to the approvers in the list. Each notification to a subsequent approver is sent only after
the current approver approves the expense report. If the current approver rejects the expense report, the approval process is
complete and the report returns to the user.

SerialExpenseRuleSet: Approval by a Specialist Based on Expense Types in
Serial Mode
The predefined rule set for approval of expense reports based on a template name or any attributes of the expense type is
called SerialExpenseRuleSet. The rule set contains the same rule as the parallel approval, but the rule set is configured to
send the approval notifications sequentially to the approvers in the list. Each notification to a subsequent approver is sent
only after the current approver approves the expense report. If the current approver rejects the expense report, the approval
process is complete and the expense report returns to the user.

How You Define Approval Rules
Approval rules are configurable rules for expense report approval created in Approval Management Extensions. Oracle
Fusion Expenses provides nine predefined rule sets. By using the BPM Worklist, you can define new approval rules or modify
existing ones in AMX. To manage approval rules, you must be a BPM Worklist administrator, such as a financial application
administrator.

If you are authorized to manage the approval rules, you can:

• Modify existing approval rules

• Define new approval rules

• Understand and apply properties of rules and rule sets

If you are authorized to manage the approval rules, an Administration link displays in the corner of the BPM Worklist. To
define new approval rules or modify existing ones, click the Administration link, click the Task Configuration tab, click the Data
Driven tab to display the Data driven configuration page, and then select the FinExmWorkflowExpenseApproval task from the
Tasks to be configured pane.

Each rule set contains one or more approval rules. Each approval rule has an approval condition and a list of approvers. The
list of approvers derived for each rule set is called a participant. To generate the list of approvers, each rule requires a list
builder to be associated with it.
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Each expense report can only satisfy one rule within a rule set. If an expense report does not satisfy any rule in a rule set, the
approval process errors and an incident is reported in Oracle Enterprise Manager Grid Control.

Modify Existing Approval Rules
In the Data driven configuration page, select a rule set to modify and click the Edit icon in the Tasks to be configured pane.
You can now add, modify, or delete rules within the specified rule set. The changes take effect when you click the Commit
Task icon in the Tasks to be configured pane. Saving changes by clicking the Save icon saves the changes, but it does not
activate them. If needed, you can undo changes by clicking the Reset icon.

Define New Approval Rules
To create new rules, you must provide values for the following rule components:

• Condition: Criteria that an expense report must satisfy

• Response type: Required or FYI. A response from the approver is required or the notification is informational.

• List builder: Creates a list of approvers for a specific notification

To define a condition, select a value from the list of values in the IF region. The Condition Browser displays. In the Condition
Browser, open a view object (folder) and select the attribute that you want to use as the criteria. You can add multiple
conditions to a rule. An example of a condition is: ExpenseReport.expenseReportTotal more than 1000.

The following table lists view objects (folders) that are visible in the Condition Browser with their associated attributes and
descriptions.

Note:  The following table contains view objects with their associated attributes and descriptions that you can
select as conditions for expense report approval rules.

View Object in Condition Browser Attribute Description

ExpenseReport
 

ExpenseReportId
 

Expense report identifier
 

ExpenseReport
 

PersonId
 

Person identifier of the employee on the
expense report
 

ExpenseReport
 

AssignmentId
 

Primary assignment identifier of the
employee's assignment
 

ExpenseReport
 

ExpenseReportDate
 

Date of the latest expense in the expense
report
 

ExpenseReport
 

ExpenseReportTotal
 

Total amount of the expense report in the
reimbursement currency
 

ExpenseReport
 

ReimbursementCurrencyCode
 

Expense report reimbursement currency
 

ExpenseReport
 

ReportSubmitDate
 

Date on which the expense report was
submitted for approval
 

ExpenseReport ExpenseStatusCode Most recent status of the expense report
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View Object in Condition Browser Attribute Description

     

ExpenseReport
 

ExpenseStatusDate
 

Date of the most recent status of the
expense report
 

ExpenseReport
 

OrgId
 

Business unit identifier of the expense report
 

ExpenseItem
 

ReceiptAmount
 

Expense amount in receipt currency
 

ExpenseItem
 

ReceiptCurrencyCode
 

Currency code of the expense amount
 

ExpenseItem
 

ExpenseSource
 

Source of the expense item, cash, or
corporate card
 

ExpenseItem
 

ExpenseTypeCategoryCode
 

Category of the expense item, such as Airfare
or Accommodations
 

ExpenseItem
 

ExpenseCategoryCode
 

Classification of expense item, such as
Business or Personal
 

ExpenseItem
 

ExpenseTemplateId
 

Expense template identifier for the expense
item
 

ExpenseItem
 

ExpenseTypeId
 

Expense type identifier of the expense item
 

ExpenseItem
 

PolicyViolatedFlag
 

Check box that indicates whether the
expense item has policy violations
 

ExpenseItem
 

ReceiptMissingFlag
 

Check box that indicates whether the user
has the original receipt
 

ExpenseItem
 

EmpDefaultCostCenter
 

Default cost center of the employee
 

CostCenterTotal
 

ExpenseReportId
 

Expense report identifier
 

CostCenterTotal
 

CostCenter
 

Cost center against which the expense is
incurred
 

CostCenterTotal
 

Total
 

Total expense charged to the cost center
 

CostCenterTotal
 

ManagerId
 

Person identifier of the cost center owner
 

CostCenterTotal
 

ManagerUsername
 

User name of the cost center owner
 

ProjectTotal
 

ExpenseReportId
 

Expense report identifier
 

ProjectTotal
 

PjcProjectId
 

Project identifier
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View Object in Condition Browser Attribute Description

ProjectTotal
 

Total
 

Total expense charged to the project
 

ProjectTotal
 

ProjectPartyId
 

Person identifier of the project manager
 

ProjectTotal
 

ManagerUsername
 

User name of the project manager
 

Each approval notification generated from an approval rule must have a response type of Required or FYI. You specify the
applicable response type in the THEN region on the Data driven configuration page of the BPM Worklist. If the approver
should take an action in response to the notification, click the Required radio button. If the approval notification is designed as
information only, click the FYI radio button.

Each rule requires a list builder to build the list of approvers. The following table contains the list builder types with their
associated descriptions that are available in the BPM Worklist.

List Builder Type Description

Supervisory
 

Ascends the primary supervisory hierarchy, starting at the expense report submitter or at a given
approver, and generates the approval chain.
 

Job Level
 

Ascends the supervisory hierarchy, starting at a given approver and continuing until an approver
with the appropriate job level is found.
 

Position
 

Ascends the position hierarchy, starting at a given approver's position and continuing until an
approver with the appropriate position is found.
 

Resource
 

A list of approvers. You can choose a user name or a function that returns a set of approvers.
 

Approval Group
 

Group of approvers. You can create approver groups consisting of a list of users for use in the rule
sets.
 

Each list builder type requires values for specific fields to build its approval list. In the THEN region on the Data driven
configuration page of the BPM Worklist, select a type of list builder from the List Builder choice list and click the Create
Action button. The Add Variable dialog box displays where you add specific variables for specific list builders.

The following table contains the fields associated with each list builder type for which you must select specific values.

List Builder Type Field Description Values to Select and Sample
Data

Supervisor
 

Number of Levels
 

A positive number specifying the
number of levels to traverse the
supervisory hierarchy.
 

A positive number based on your
needs. For example, use 1 for
one level of approval.
 

Supervisor
 

Starting Participant
 

The first participant in the list.
  From the Add Variable dialog

box, select:

• The Get Manager radio
button
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List Builder Type Field Description Values to Select and Sample
Data

• Supervisory as the List
Builder

• Reference User as
task.creator to start
from the person on the
expense report

• An Effective Date if
applicable

This creates the following
string for the start participant:
HierarchyBuilder.getManager
("supervisory",Task.creator,-1,"","").

Supervisor
 

Top Participant
 

The last participant in the list.
The approval list does not
go beyond this person in a
hierarchy.
 

From the Add Variable dialog
box:

• Select the Get User radio
button.

• Enter the user name of
the last person in the
approval chain as the
Reference User.

• Select an Effective Date
if applicable.

This creates the following string
as the highest participant:
HierarchyBuilder.getPrincipal
("<>",-1,"","")

Supervisor
 

Auto Action Enabled
 

If automatic response should
be enabled for the approval
notification, set to True.
 

Not applicable
 

Supervisor
 

Auto Action
 

If automatic response is enabled,
set the response.
 

For expense approval, use
Approve.
 

Position
 

Number of Levels
  A positive number specifying the

number of levels to traverse the
position hierarchy. This number
can be an absolute value or a
value relative to the Starting
Point or Creator.

Not applicable
 

Position
 

Relative to
  The number of levels to traverse

is relative to one of the following
values: Starting Point, Creator,
or Absolute.

• At most 2 relative to
Starting Point

• At least 2 relative to
Starting Point.

Position
 

Starting Participant
 

The first participant in the list.
  To select a starting participant,

click the list of values and select:

• The Get Manager radio
button
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List Builder Type Field Description Values to Select and Sample
Data

• Position as the List
Builder

• Reference User as the
position identifier of the
starting position

• A Hierarchy Type. This
is a mandatory selection
for the position list builder.
To select a hierarchy
type, you must first define
a position hierarchy in
Oracle Fusion Global
Human Resources.

• An Effective Date if
applicable

This creates a string for
the starting participant.
For example, to start from
position ID 1234, use
HierarchyBuilder.getManager
("position","1234",-1,"","
ENTERPRISE_POSITION
_HIERARCHY") as the start
participant.

Position
 

Top Participant
 

The last participant in the list.
The approval list does not
go beyond this person in a
hierarchy.
 

From the Add Variable dialog
box:

• Select the Get User radio
button.

• Enter the position
identifier for the last
position in the approval
chain as the Reference
User.

• Select an Effective Date
if applicable.

This creates a string for the
highest participant. For example,
HierarchyBuilder.getPrincipal
"<>","","
ENTERPRISE_POSITION_
HIERARCHY").

Position
 

Utilized Participants
  Uses only the participants

specified in this option from the
calculated list of participants.
Available options are: Everyone,
First and Last Manager, Last
Manager.

Not applicable
 

Position
 

Auto Action Enabled
 

If automatic response should be
enabled for the notification, set
to True.
 

Not applicable
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List Builder Type Field Description Values to Select and Sample
Data

Position
 

Auto Action
 

If automatic response is enabled,
set the response.
 

For expense approval, use
Approve.
 

Job Level
 

Number of Levels
  A positive number specifying the

number of levels to traverse the
job level hierarchy. This number
can be an absolute value, or a
value relative to Starting Point
or Creator.

Not applicable
 

Job Level
 

Relative to
  The number of levels to traverse

is relative to one of the following
values: Starting Point, Creator,
or Absolute.

• At most 2 relative to
Absolute

• At least 1 relative to
Absolute

Job Level
 

Starting Participant
 

The first participant in the list.
  From the Add Variable dialog

box, select:

• The Get User radio
button

• Job Level as the List
Builder

• Reference User as
task.creator to start
from the person on the
expense report

• An Effective Date if
applicable

This creates a string for the
start participant. For example,
HierarchyBuilder.getManager
("joblevel",task.creator,-1,"","").

Top Participant
 

The last participant in the list.
The approval list does not
go beyond this person in a
hierarchy.
 

From the Add Variable dialog
box:

• Select the Get User radio
button.

• Enter the user name for
the last approver in the
approval chain as the
Reference User.

• Select an Effective Date
if applicable.

This creates the following string
as the highest participant:
HierarchyBuilder.getPrincipal
("<>",-1,"","")

Job Level
 

Include all managers at last level
 

If the job level equals that of
the previously calculated last
participant in the list, then it
includes the next manager in the
list.

Not applicable
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List Builder Type Field Description Values to Select and Sample
Data

 

Job level
 

Utilized Participants
  Uses only the participants

specified in this option from the
calculated list of participants.
Available options are: Everyone,
First and Last Manager, Last
Manager.

Not applicable
 

Job Level
 

Auto Action Enabled
 

If automatic response should
be enabled for the approval
notification, set to True.
 

Not applicable
 

Job level
 

Auto Action
 

If automatic response is enabled,
set the response.
 

For expense approval, use
Approve.
 

Resource
 

Participants
 

Participants can be users,
groups, or application roles. For
users, use a static user name
or a function to retrieve a user
name.
 

For example, use
ExpenseReport/
costCenterTotalVOmanagerUsername
for cost center owner.
 

Approval Group
 

Approval Group
 

Enter the approval group name.
To select an approval group as
a list builder, you must create
the static approval groups in the
BPM Worklist.
 

Not applicable
 

For more information on configuring approval rules, see the Using Task Configuration section of the Using Approval
Management chapter in the Oracle Fusion Middleware Modeling and Implementation Guide.

Understand and Apply Properties of Rules and Rule Sets
The following are properties of rules and rule sets that you need to understand and apply.

• For each expense report, one rule must be true within each rule set. If the expense report does not satisfy any rule in
the rule set, the approval process will error.

• Since there can be only one rule that applies in a rule set for each expense report, you must configure the rules at
the most granular level applicable and use priority within the rule to differentiate overlapping conditions. AMX does
not support nested conditions.

• All rule sets are executed in parallel or in serial with respect to the Expense Report Approval Stage.

• Serial rule sets are designed to execute the approval process in a sequential order. The approvers in the approval list
for any rule included in these rule sets are notified in a sequential order.

• To deactivate a rule set, check the Ignore this participant check box for that rule set.

• If the participants cannot be determined, then AMX sends out a failure notification to the user with an incident
identifier. Administrators can access the incident details through the Support Workbench of the Oracle Enterprise
Manager Grid Control application and restart the approval process in Oracle Enterprise Manager Grid Control after
resolving the issues in the incident report.
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How You Set Up Approval Rules for Delegated Expense
Reports
Oracle Fusion Expenses enables you to delegate expense entry to another person. To understand the approval process for
delegated expense reports, it is necessary to understand the distinction between preparer, or creator, and owner. The person
who submits an expense report for another person is called the preparer. The person who incurs the expenses is called the
owner of the expense report.

Expenses provides predefined approval rules to support delegated expense report approval. When a preparer submits an
expense report, the following approval process ensues.

• Approval by expense report owner
In the first part of the approval process, the expense report is routed to the expense report owner for approval. The
expense report has a status of Pending Individual Approval. The rule set for this part of the approval process is called
the ExpenseReportApprovalStageExpenseReportD : ExpenseReportOwnerRuleSet in the BPM Worklist application.

• Approval by preparer's manager
In the second part of the approval process, the expense report is routed to the preparer's manager hierarchy for
approval. The Expense report has a status of Pending Manager Approval. The rule set for this part of the approval
process is called ExpenseReportApprovalStage : ExpenseReportRuleSet in the BPM Worklist application.

This topic discusses the following two scenarios that require you to modify the rule sets if your company enables delegated
expense entry.

• Bypass approval by owner

• Start approval with owner's manager

Based on your company policies, any one of the following scenarios can apply:

• Only bypass approval by owner

• Only start approval with owner's manager

• Both bypass approval by owner and start approval with owner's manager

• Neither bypass approval by owner nor start approval with owner's manager

Bypass Approval By Owner
If your company policy does not require expense report approval by the expense report owner, you can modify the rule set to
bypass this approval. When bypassed, the expense report status is set to Pending Manager Approval. The expense report is
routed to approvers based on the existing approval rules.

To bypass approval by the owner, perform the following steps:

1. Navigate to the Oracle BPM Worklist application.
2. Click the Administration link displayed in the corner of the page. The Administration tab appears.
3. Click the Task Configuration tab.
4. Click the Rules tab.
5. In the Tasks to be configured pane, select the FinExmWorkflowExpenseApproval task.
6. From the Select Ruleset choice list, select the following predefined rule set:

SoaOLabel.ExpenseReportApprovalStageExpenseReportD : ExpenseReportOwnerRuleSet .
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7. Select the Ignore this participant check box. This action tells the approval rule to ignore the owner as the first
approver in the approval rule.

8. To save the modified rule set, click the Save icon in the Tasks to be configured pane.
9. To commit the modified rule set, click the Commit task icon in the Tasks to be configured pane.

Start Approval with Owner's Manager
The approval process routes the expense reports to the preparer's manager hierarchy.

If your company policy requires expense reports to be routed to the owner's manager hierarchy for approval, perform the
following steps.

1. To navigate to the expense report approval taskflow, perform steps 1-5 in the preceding section.
2. From the Select Ruleset choice list, select the following predefined rule set:

SoaOLabel.ExpenseReportApprovalStage : ExpenseReportRuleSet.
3. Click the Edit task icon (pencil) on the Tasks to be configured pane.
4. Expand the ExpenseReportManagerApproval rule.
5. In the List builder action 1 region, click in the Starting Participant field and scroll until you see

("supervisory",Task.creator,.
6. In the Starting Participant field, replace Task.creator with Task.payload.Expense Report Owner as shown in the

following table.

Predefined Value Changed Value

HierarchyBuilder.
getManager("supervisory"Task. creator
-1,"","")
 

HierarchyBuilder. getManager("supervisory" Task. payload. Expense Report Owner, -1,"","")
 

7. To save the modified rule set, click the Save icon in the Tasks to be configured pane.
8. To commit the modified rule set, click the Commit task icon in the Tasks to be configured pane.

Caution:  Expenses recommends that you evaluate any existing approval rules that use Task.creator as the first
approver in an approval hierarchy to determine whether the first approver should be changed from task.creator
to Task.payload.Expense Report Owner.

Modify the Printable Expense Report Template
The Printable Expense Report template is a RTF file. You can change the information that displays on the Printable Expense
Report template. First you download the RTF file, FinExmExpenseTemplate, to your local drive from Oracle Business
Intelligence (BI) Publisher. Then you can modify attribute names or attribute display text with their corresponding predefined
attributes. Finally, you upload the modified template to Oracle BI Publisher.

On the FinExmExpenseTemplate RTF file, you can modify the following:

• Attribute names: Displayed as UI text on the RTF file.

• Attribute display text: Displayed as bold text on the RTF file.

• Attributes: Code that corresponds to the attribute display text on the RTF file.

The following table contains regions on the Printable Expense Report template that correspond to predefined view objects.
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Regions on the RTF Template Predefined View Objects

Expense Report Header
 

PrintableReportVO
 

Expense Items
 

PrintableExpenseVO
 

Distributions
 

PrintableExpenseDistVO
 

Employee Attendees
 

EmployeeExpenseAttendeeVO
 

Nonemployee Attendees
 

NonemployeeExpenseAttendeeVO
 

Expense Summary
 

ExpenseSummaryVO
 

Attachment
 

AttachmentVO
 

Given the region on the Printable Expense Report template in which your intended change is located, you can then identify
which view object table to consult. The view object tables list the attribute names and their corresponding predefined
attributes. The predefined attributes are available for you to add to the Printable Expense Report template. To access the
view object tables, click the Printable Expense Report Template Attributes related link in this topic.
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The following diagram illustrates the layout of the regions on the Printable Expense Report template.

Distributions

Employee Attendees

Nonemployee Attendees

Expense Summary

Attachment

Expense Report

Expense Items

Prerequisites
Before you can modify the FinExmExpenseTemplate RTF file, you must download and install the Template Builder for Word,
which is a BI Publisher add-on for Microsoft Word. To download and install the Template Builder for Word, follow these steps:

1. Sign into the Oracle Business Intelligence Publisher server with the BI Administrator Role.
2. On the Oracle Business Intelligence home page by the Get Started section, click the Download BI Publisher

Desktop Tools link.
3. Select and install Template Builder for Word.

Downloading the Printable Expense Report Template
To download a copy of the FinExmExpenseTemplate RTF file from Oracle BI Publisher, complete these steps:

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.
2. Navigate: Navigator > Tools > Reports and Analytics.
3. On the Oracle BI Publisher home page, click the Catalog menu.
4. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Expenses.



Oracle Financials Cloud
Implementing Expenses

Chapter 3
Expense Policies and Rules

78

5. Click the Expenses folder to display the Printable Expense Report template.
6. By the Printable Expense Report template, click the Edit link.

The Printable Expense Report Template page appears.
7. By the FinExmExpenseTemplate icon, click the Edit link.
8. Click Save as to save the Printable Expense Report template RTF file to your local drive.

Tip:  Save the downloaded template with the name UpdatedPrintableExpenseReport to distinguish it
from the predefined template.

Adding a Predefined Attribute
To add a predefined attribute to a location on the Printable Expense Report template, complete these steps:

1. Select existing attribute display text, such as ExpenseReportDate.
2. Copy the attribute display text by pressing Ctrl + C on your keyboard.
3. Move your cursor to the location where you want to add the predefined attribute and press Ctrl + V on your

keyboard.
4. Select the new field you pasted, right-click, and navigate: BI Publisher > Properties.

The BI Publisher Properties dialog box appears.
5. In the Text to display field, change the attribute display text.
6. Select the Advanced tab.
7. Click the Printable Expense Report Template Attributes related link in this topic.
8. In the Printable Expense Report Template Attributes topic, determine which view object table to consult based on

the location on which you want to add the predefined attribute.
For example, if you want to add a predefined attribute to the header region of the Printable Expense Report
template, you would consult the PrintableReportVO - Expense Report Header Region table. Then, in the In the
PrintableReportVO - Expense Report Header Region table, locate the UI label and associated predefined attribute
that you want to add.

9. In the Advanced tab, enter the predefined attribute between the question marks.
10. Click OK.

Uploading the Printable Expense Report Template
To upload the FinExmExpenseTemplate RTF file to Oracle BI Publisher, complete these steps:

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.
2. Navigate: Navigator > Tools > Reports and Analytics.
3. On the Oracle BI Publisher home page, click the Catalog menu.
4. Click the New icon.
5. From the New menu, select Report.
6. On the Create Report page, select the Use Data Model icon.
7. In the Select Data Model dialog box, click Cancel to bypass the data model. which is not applicable.
8. Click OK to confirm cancellation.
9. On the Data Model page, click the Upload icon.

10. In Upload Template File dialog box, enter the following:
a. In the Layout Name field, enter FinExmExpenseTemplate.
b. In the Template File field, browse for your modified Printable Expense Report template RTF file on your local

drive, select the template, and click Open.
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c. From the Type choice list, select RTF Template.
d. From the Locale choice list, select English (United States).
e. Click Upload.

The modified RTF file appears with the layout name FinExmExpenseTemplate.
11. Click the Save Report icon.

The Save As dialog box appears.
12. In the Save In field, navigate to the folder where you want to save the modified Printable Expense Report template.

Tip:  A copy of your modified Printable Expense Report template is automatically saved in the
Expenses folder at: Shared Folders > Custom > Financials > Expenses.

13. In the Name field, enter a name for the modified Printable Expense Report Template, such as
UpddatedFinExmReport.

Caution:  When you name the report in the Name field, don't include spaces.

14. Click OK.

Now you can navigate to the Expenses System Option page through Setup and Maintenance. After you click a specific
business unit link in the Specific Business Units section, select the Corporate Options for Expense Report tab. Then you can
select your modified expense report template from the Printable Expense Report Format choice list.

Adding an Attachment Region to the Printable Expense Report Template
If your Printable Expense Report Template is missing the Attachment region, you can add the missing components as
follows:

• <?for-each:Attachment?>

• Placeholder image with alt-text = url:{DOCUMENT}

• <?TITLE?>

• <?end for each?>

To add the missing components, follow these steps:

1. In the RTF Printable Expense Report template, scroll to end of the file.
2. Select and copy any For field and paste on a separate line outside the last table at the end of the template.
3. Select For and navigate: Add-ins > BI Publisher > Field Browser.
4. In the Field Browser dialog box, click Show All.
5. Scroll to the end of the list.
6. Select the last For in the Text and Code fields in the Field Browser dialog box. The last For is the For you just copied

in Step 2 and it's what you must update.
7. In the Edit field, change the code to <?for-each:Attachment?>
8. Click Update.
9. Click Close.

10. After For in your work area of the RTF Printable Expense Report template, press the Enter key on the keyboard
twice.

11. Navigate: Insert > Pictures.
12. Browse to the image.
13. Select the image and click Insert.
14. Click the image.
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15. On the image, right-click the mouse and select Picture.
16. In the Format Picture dialog box, select the Alt Text tab.
17. In the Alternative text field, enter url:{DOCUMENT}.
18. Click OK.
19. After the image in your work area, press the Enter key on the keyboard twice.
20. Copy and paste any field in your work area.
21. Select the field you pasted and navigate: Add-ins > BI Publisher > Field Browser.
22. In the Field Browser dialog box, click Show All.
23. Scroll to the end of the list.
24. Select the final entry.
25. In the Edit field, change the code to <?TITLE?>.
26. Click Update.
27. Click Close.
28. Double-click the field you pasted. The Text Form Field Options dialog box appears.
29. In the Default text field, enter Title.
30. Click OK.
31. After Title in your work area, press the Enter key on the keyboard twice.
32. Select and copy any End For field and paste on a separate line after Title.
33. Select End For and navigate: Add-ins > BI Publisher > Field Browser.
34. In the Field Browser dialog box, the Text and Code fields show exactly what you need, so you don't have to change

the code.
35. Click Close.
36. Click the Save icon in the RTF Printable Expense Report template.

Related Topics
• Example of Modifying Expenses Email Notifications Using Oracle Business Intelligence Publisher

Printable Expense Report Template Attributes
The following tables contain attribute names and their corresponding predefined attributes that you can use to modify the
Printable Expense Report template. Use these view object tables with the figure in the topic titled Modifying the Printable
Expense Report Template: Procedures that is a related link in this topic.

PrintableReportVO - Expense Report Header Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the Expense
Report header region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Assignment ID
 

AssignmentId
 

Assignment identifier of the individual on the
corporate card.
 

Audit Code
 

AuditCode
 

Audit type for the expense report based
on receipt requirements, such as original
receipt-based audit and imaged receipt-
based audit.
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Attribute Name Predefined Attribute Description

 

Both Pay Identifier
 

BothPayFlag
 

Indicates whether the expense report
contains corporate card transactions with
Both Pay payment liability.
 

Business Group ID
 

BusinessGroupId
 

Identifier of an enterprise. Used for multi-
tenancy partitioning.
 

Cash Expense Payment Date
 

CashExpensePaidDate
 

Date when cash expense was reimbursed to
the individual.
 

Created By
 

CreatedBy
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of
the creation of the row.
 

Current Approver ID
 

CurrentApproverId
 

Identifier of the current approver of the
expense report.
 

Display Name
 

DisplayName
 

Derived denormalized name formatted
for UI display. Formatting depends on the
legislation code. Expect first name as first
component in this format.
 

Displayed Field
 

DisplayedField
 

Expense report status.
 

Employee Number
 

EmployeeNumber
 

Number that identifies an employee within a
company.
 

Entertainment Expense Identifier
 

EntertainmentExpenseFlag
 

Indicates whether this report contains any
entertainment expenses.
 

Exchange Rate Type
 

ExchangeRateType
 

Conversion rate type used for calculating the
reimbursable amount.
 

Expense Dates
 

ExpenseDates
 

Expense report date range.
 

Expense Report Date
 

ExpenseReportDate
 

Month, day, and year in which an expense
report is saved or submitted.
 

Expense Report ID
 

ExpenseReportId
 

Identifier of the expense report.
 

Expense Report Number
 

ExpenseReportNum
 

Number that references an expense report
and follows the numbering policies of the
company.
 

Expense Report Processing ID
 

ExpRepProcessingId
 

Identifier of the expense report details, such
as report status change history.
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Attribute Name Predefined Attribute Description

Expense Report Request ID
 

ExportRequestId
 

Identifier of a specific instance of the expense
reimbursement process that processed this
report.
 

Expense Report Total
 

ExpenseReportTotal
 

Total amount of the expense report in
reimbursement currency. Amount in approver
preferred currency is also shown if approver
has a different preferred currency.
 

Expense Status Code
 

ExpenseStatusCode
 

Expense report approval status, such as
Approved, Pending Manager Approval, or
Paid.
 

Expense Status Date
 

ExpenseStatusDate
 

Date when expense report acquired the
current status.
 

First Name
 

FirstName
 

Person's first name.
 

Formatted Report Submit Date
 

FormattedReportSubmitDate
 

Formatted date representing the date the
expense report was submitted.
 

Formatted Total
 

FormattedTotal
 

Formatted report total amount based on
reimbursement currency code.
 

Full Name
 

FullName
 

System constructed version of name. Used in
more formal display purposes
 

Home Address
 

HomeAddress
 

Person's home address.
 

Imaged Receipt Status Code
 

ImagedReceiptStatusCode
 

Represents the imaged receipt status for the
expense report.
 

Last Name
 

LastName
 

Person's last name.
 

Last Update Date
 

LastUpdateDate
 

Date the expense report was last updated.
 

Last Update Login
 

LastUpdateLogin
 

Login ID of the last person who accessed the
expense report.
 

Last Updated By
 

LastUpdatedBy
 

Login ID of the last person who updated the
expense report.
 

List Name
 

ListName
 

Constructed version of a person's name,
intended for use in an alphabetically-ordered
list. The value may naturally differ depending
on the Legislation Code. Expect the last
name as the first component in this format in
most cases.
 

Middle Name MiddleNames Person's middle name.
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Attribute Name Predefined Attribute Description

     

Mileage Expense Identifier
 

MileageExpenseFlag
 

Indicates whether this report contains any
mileage expense items.
 

Missing Images Reason
 

MissingImagesReason
 

Reason imaged receipts are not submitted
with the expense report.
 

Object Version Number
 

ObjectVersionNumber
 

Used to implement optimistic locking. This
number is incremented every time that the
row is updated. The number is compared at
the start and end of a transaction to detect
whether another session has updated the
row since it was queried.
 

Order Name ID
 

OrderName ID
 

System-constructed version of name used
for sorting. A value is always stored in this
location.
 

Organization ID
 

OrgId
 

Identifier of the business unit associated with
the row.
 

Override Approver ID
 

OverrideApproverId
 

Identifier of the person chosen as the initial
approver by the individual.
 

Parent Expense Report ID
 

ParentExpenseReportId
 

Identifier of the parent expense report.
 

Payment Method Code
 

PaymentMethodCode
 

Method of payment for this expense report,
such as check, cash, or credit.
 

Person ID
 

PersonId
 

Identifier of the person whose expenses are
included in this expense report.
 

Preparer ID
 

PreparerId
 

Identifier of the person who created the
expense report.
 

Purpose
 

Purpose
 

Purpose of the expense report as entered by
the user.
 

Receipt Filing Number
 

ReceiptFilingNumber
 

Receipt filing number that is manually entered
by the expense auditor.
 

Receipt Status Code
 

ReceiptsStatusCode
 

Receipt status of an expense report, such as
Missing, Required, or Received.
 

Receipts Receive Date
 

ReceiptsReceiveDate
 

Date when receipts for the expense report
are received
 

Regular Expense Identifier
 

RegularExpenseFlag
 

Indicates whether this report contains any
regular expenses, such as those that are not
mileage, not entertainment, or not per diem.
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Attribute Name Predefined Attribute Description

 

Reimbursement Currency Code
 

ReimbursementCurrencyCode
 

Currency of the amount to be reimbursed to
the individual for the expenses incurred.
 

Report Submit Date
 

ReportSubmitDate
 

Month, day, and year in which an expense
report is submitted.
 

Single Reimbursement Code
 

SingleReimbCurrencyCode
 

The expense report reimbursement currency
shown in the expense item table when all
expense items have the same currency.
 

ExpenseSummaryVO - Expense Summary Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the Expense
Summary region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Amount
 

Amount
 

Amount that is due from employer or
employee.
 

Card ID
 

CardId
 

Identifier of the corporate card transaction.
 

Card Number
 

CardNumber
 

Token or encrypted card number.
 

Currency Code
 

CurrencyCode
 

Currency of the amount to be reimbursed to
the individual for the expenses incurred.
 

Estimated Total
 

EstimatedTotal
 

Estimated expense report total.
 

Expense Report ID
 

ExpenseReportId
 

Identifier of the expense report.
 

Formatted Amount
 

FormattedAmount
 

Formatted amount based on the currency
code.
 

Payment Due From
 

Payment DueFrom
 

Party responsible for payment.
 

Summary Type
 

SummaryType
 

Indicator of payment responsibility.
 

Total
 

Total
 

Total amount of the expense report in
reimbursement currency.
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PrintableExpenseVO - Expense Items Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the Expense
Items region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Assignment ID
 

AssignmentId
 

Identifier of the assignment for the person on
the expense report.
 

Billed Amount
 

BilledAmount
 

Amount billed to the corporate card account.
 

Billed Currency Code
 

BilledCurrencyCode
 

Corporate card transaction billed currency
code.
 

Billed Date
 

BilledDate
 

Date of the statement on which the
transaction appears.
 

Billed Decimal Placement
 

BilledDecimal
 

Number of decimal places used to display
the billed amount.
 

Business Amount
 

BusinessAmount
 

Expense business amount.
 

Card ID
 

CardId
 

Identifier of a specific corporate card.
 

Card Member Name
 

CardmemberName
 

Card member name.
 

Card Number
 

CardNumber
 

Token or encrypted card number.
 

Card Program ID
 

CardProgramId
 

Identifier of the corporate card program.
 

Card Program Name
 

CardProgramName
 

Corporate card program name.
 

Card Reference ID
 

CardReferenceId
 

Identifier of the corporate card in Oracle
Fusion Payments.
 

Card Status Code
 

CardStatusCode
 

Status of a corporate card, such as Active,
Inactive, or Unassigned.
 

Category Code
 

CategoryCode
 

Expense type category code.
 

Code Combination ID
 

CodeCombinationId
 

Identifier of the accounting code combination
to which that expense is charged.
 

Company Account ID
 

CompanyAccountId
 

Identifier assigned by the card issuer to the
deploying company or its business unit.
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Attribute Name Predefined Attribute Description

Company Number
 

CompanyNumber
 

Corporate account number assigned by the
card issuer to the deploying company or its
business unit.
 

Cost Center
 

CostCenter
 

Cost center to which an expense item is
assigned.
 

Created By
 

CreatedBy DisplaySequence
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of
the creation of the row.
 

Credit Card Transaction ID
 

CreditCardTrxnId
 

Identifier of a specific corporate card
transaction.
 

Currency Conversion Rate
 

CurrencyConversionRate
 

A rate that represents the amount one
currency can be exchanged for another at a
specific point in time. Oracle Applications can
access daily, periodic, and historical rates.
These rates are used for foreign currency
conversion, revaluation, and translation.
 

Default Project Expenditure Type
 

DefaultProjExpendType
 

Project expenditure that is assigned to an
expense type that has not been set up at the
project level.
 

Description
 

Description
 

Description of an expense item.
 

Default Corporate Card Expense Type ID
 

DfltCcExpTypeId
 

Card expense type used if no mapping rule
has been specified.
 

Expense Type Category
 

DisplayedField
 

Expense type category.
 

Expense Source
 

DisplayedField1
 

Source of the transaction, either Cash or
Corporate Card.
 

Display Policy Violation Identifier
 

DisplayPolicyViolationFlag
 

Indicates whether an expense item has a
policy violation.
 

Display Policy Violation Identifier
 

DisplayViolationFlag
 

Indicates whether employees are warned
when they submit expenses that exceed
defined entertainment expense policy rate
limit.
 

Display Receipt Violation Identifier
 

DispRcptViolationFlag
 

Indicates whether a receipt missing policy
warning is displayed to the user.
 

Dispute Date
 

DisputeDate
 

Date when the individual placed this
transaction or dispute.
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Attribute Name Predefined Attribute Description

Employee Default Cost Center
 

EmpDefaultCostCenter
 

Employee's default cost center defined in
Oracle Human Capital Management.
 

Employee Name
 

EmployeeName
 

Employee's name defined in Oracle Human
Capital Management.
 

Enable Corporate Card Mapping Identifier
 

EnableCcMappingFlag
 

Indicates whether the lookup codes from
the charge file are associated with the
company's expense types.
 

Project Enabled Identifier
 

EnableProjectsFlag
 

Indicates whether the expense item is
enabled for projects.
 

End Date
 

EndDate
 

Distribution end date.
 

Exchange Rate
 

ExchangeRate
 

Rate that represents the amount one
currency can be exchanged for another at a
specific point in time.
 

Attendee
 

ExpenseAttendee
 

Attendee identified at the distribution level.
 

Expense Category Code
 

ExpenseCategoryCode
 

Expense category.
 

Expense ID
 

ExpenseId
 

Identifier of a specific expense item..
 

Expense Report ID
 

ExpenseReportId
 

Identifier of a specific expense report.
 

Expense Source
 

ExpenseSource
 

Source of the transaction, either Cash or
Corporate Card.
 

Expense Template ID
 

ExpenseTemplateId
 

Identifier of a specific expense template.
 

Expense Template Name
 

ExpenseTemplateName
 

Name of the expense report template.
 

Expense Type Category Code
 

ExpenseTypeCategoryCode
 

Grouping of expense types and additional
data fields that are relevant for a particular
grouping of expenses. An example is airfare.
This grouping allows expense types to
include information such as class of fare,
merchant, ticket number, location from, and
location to.
 

Expense Type ID
 

ExpenseTypeId
 

Identifier for a specific expense type.
 

Expense Type Name
 

ExpenseTypeName
 

Name of the expense type.
 

Formatted Amount
 

FormattedAmount
 

Formatted reimbursable amount.
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Attribute Name Predefined Attribute Description

Formatted Start Date
 

FormattedStartDate
 

Formatted expense start date.
 

 
Functional Currency Amount
 

FuncCurrencyAmount
 

Amount to be reimbursed to the individual in
functional currency for expenses incurred.
 

Attendees Includes Employees
 

HasEmployeeAttendees
 

Indicator that the expense includes employee
attendees.
 

Attendees Includes Nonemployees.
 

HasNonEmployeeAttendees
 

Indicator that the expense includes
nonemployee attendees.
 

Imaged Receipt Required Identifier
 

ImgReceiptRequiredFlag
 

Indicates whether this expense requires an
imaged receipt.
 

Include Personal Expense Identifier
 

InclPersonalExpenseFlag
 

Indicates whether the expense item includes
a personal amount.
 

Itemization Parent Expense ID
 

ItemizationParentExpenseId
 

Identifier of the parent expense of an itemized
expense item. Possible values are NULL
indicating that the expense is not itemized,
-1 indicating that the expense is a parent line
with itemization, and greater than 0 indicating
that the expense is an itemized child line and
the value is the parent line's identifier.
 

Expense Item Sequence
 

ItemSequence
 

Sequence in which expenses items are
entered into an expense report.
 

Justification
 

Justification
 

Reason an expense was incurred.
 

Justification Required Identifier
 

JustificationRequiredFlag
 

Indicates whether the expense requires
justification.
 

Last Update Date
 

LastUpdateDate
 

Who column: indicates the date and time of
the last update of the row.
 

Last Updated By
 

LastUpdatedBy
 

Who column: indicates the user who last
updated the row.
 

Last Update Login
 

LastUpdateLogin
 

Who column: indicates the session login
associated with the user who last updated
the row.
 

Location
 

Location
 

Expense location.
 

Location ID
 

LocationId
 

Identifier of a specific location.
 

Masked Card Number
 

MaskedCardNumber
 

Token or masked card number.
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Attribute Name Predefined Attribute Description

Merchant Document Number
 

MerchantDocumentNumber
 

Receipt number on the receipt issued by the
merchant.
 

Merchant Name
 

MerchantName
 

Name of the merchant where the expense
was incurred.
 

Merchant Reference
 

MerchantReference
 

Purchase identification of a transaction
provided by the merchant at the point of sale.
 

Merchant Taxpayer ID
 

MerchantTaxpayerId
 

Tax payer identifier of the merchant.
 

Expense Template Name
 

Name
 

Expense template name.
 

Number of Days
 

NumberOfDays
 

Number of days that the expense spans.
 

Number of People
 

NumberPeople
 

Number of people that attended the event
for which an expense was incurred. For
example, the number of people that attended
a business dinner or an entertainment event.
 

Object Version Number
 

ObjectVersionNumber
 

Used to implement optimistic locking. This
number is incremented every time that the
row is updated. The number is compared at
the start and end of a transaction to detect
whether another session has updated the
row since it was queried.
 

Organization ID
 

OrgId
 

Identifier of the business unit associated with
the row.
 

Original Reimbursable Amount
 

OrigReimbursableAmount
 

Original amount to be reimbursed to the
individual for this expense.
 

Parent Expense Type ID
 

ParentExpenseTypeId
 

Identifier of the parent expense of an itemized
expense item. Possible values are NULL
indicating that the expense is not itemized,
-1 indicating that the expense is a parent line
with itemization, and greater than 0 indicating
that the expense is an itemized child line and
the value is the parent line's identifier.
 

Passenger Amount
 

PassengerAmount
 

Passenger amount of the mileage expense.
 

Payment Due From Code
 

PaymentDueFromCode
 

Party responsible for payment.
 

Payment Identifier
 

PaymentFlag
 

Payment identifier from credit card
transactions table.
 

Personal Amount
 

PersonalAmount
 

Amount of the expense that is marked as
personal.
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Attribute Name Predefined Attribute Description

Person ID
 

PersonId
 

Identifier of the individual.
 

Policy Short Pay Identifier
 

PolicyShortpayFlag
 

Indicates whether the expense is short paid
due to policy noncompliance.
 

Policy Violated Identifier
 

PolicyViolatedFlag
 

Indicates whether the expense violated
company policies.
 

Posted Amount
 

PostedAmount
 

Transaction amount that was posted to the
statement or account.
 

Posted Currency Code
 

PostedCurrencyCode
 

Currency code associated with a posted
corporate card transaction.
 

Posted Date
 

PostedDate
 

Date the transaction was posted to the
statement.
 

Posted Decimal Placement
 

PostedDecimal
 

Number of decimal places used to display
the posted amount.
 

Preparer ID
 

PreparerId
 

Identifier of the person who created the
expense.
 

Project ID
 

ProjectId
 

Project identifier of the expense item.
 

Receipt Amount
 

ReceiptAmount
 

Amount of the receipt in the receipt currency.
 

Receipt Currency Code
 

ReceiptCurrencyCode
 

Receipt currency of an expense item.
 

Receipt Missing Identifier
 

ReceiptMissingFlag
 

Indicates whether the receipts are missing for
this expense.
 

Receipt Required Identifier
 

ReceiptRequiredFlag
 

Indicates whether this expense requires a
receipt.
 

Receipt Verified Identifier
 

ReceiptVerifiedFlag
 

Indicates whether the auditor verified the
receipt for this expense.
 

Reference Number
 

ReferenceNumber
 

Corporate card reference number.
 

Reimbursable Amount
 

ReimbursableAmount
 

Expense item reimbursable amount.
 

Reimbursement Currency Code
 

ReimbursementCurrencyCode
 

Expense item reimbursable currency.
 

Request ID
 

RequestId
 

Request identifier in Enterprise Service
Scheduler of the process that created or last
updated the row.
 



Oracle Financials Cloud
Implementing Expenses

Chapter 3
Expense Policies and Rules

91

Attribute Name Predefined Attribute Description

Sequence Number
 

SequenceNum
 

Sequence in which expenses items are
entered into an expense report.
 

Source Type
 

SourceType
 

Source of an expense item, such as cash or
corporate card.
 

Start Date
 

StartDate
 

Expense item start date.
 

Transaction Amount
 

TransactionAmount
 

Amount charged by the merchant in the
currency of the transaction.
 

Transaction Date
 

TransactionDate
 

Transaction date of item for detailed
transaction.
 

Transaction Status
 

TransactionStatus
 

Corporate card transaction status.
 

Transaction Type
 

TransactionType
 

Corporate card transaction type.
 

Trip Distance
 

TripDistance
 

Estimated total travel distance for a business
trip for which mileage reimbursement will be
requested.
 

Vehicle Category Code
 

VehicleCategoryCode
 

Category of vehicle driven, such as Company
or Private.
 

PrintableExpenseDistVO - Distributions Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Distributions region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Code Combination ID
 

CodeCombinationId
 

Identifier of the accounting code combination
to which that expense is charged.
 

Cost Center
 

CostCenter
 

Cost center to which the expense is charged.
 

Created By
 

CreatedBy
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of
the creation of the row.
 

Expense Distribution ID
 

ExpenseDistId
 

Identifier of the expense distribution of a
specific expense item.
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Attribute Name Predefined Attribute Description

 

Expense ID
 

ExpenseId
 

Identifier of the expense for this distribution.
 

Expense Report ID
 

ExpenseReportId
 

Identifier of the expense report, which
includes the expense corresponding to this
distribution.
 

Last Update Date
 

LastUpdateDate
 

Who column: indicates the date and time of
the last update of the row.
 

Last Updated By
 

LastUpdatedBy
 

Who column: indicates the user who last
updated the row.
 

Last Updated By Login
 

LastUpdateLogin
 

Who column: indicates the session login
associated with the user who last updated
the row.
 

Object Version Number
 

Object Version Number
 

Used to implement optimistic locking. This
number is incremented every time that the
row is updated. The number is compared at
the start and end of a transaction to detect
whether another session has updated the
row since it was queried.
 

Organization ID
 

OrgId
 

Identifier of the business unit associated with
the row.
 

Project Billable Identifier
 

PJC_ BILLABLE_FLAG
 

Indicates whether a project-related item is
available to be billed to customers.
 

Project Capitalization Identifier
 

PJC_ CAPITALIZABLE_ FLAG
 

Indicates whether a project-related item is
eligible for capitalization.
 

Project Context Category
 

PJC_ CONTEXT_ CATEGORY
 

Segment used to identify the descriptive
flexfield application context for project-related
standardized cost collection.
 

Project Contract ID
 

PJC_ CONTRACT_ID
 

Identifier of contract. Used when Oracle
Contract Billing or Oracle Grants Accounting
is installed.
 

Project Contract Line ID
 

PJC_ CONTRACT_ LINE_ID
 

Tracks contract line information. Used when
Oracle Contract Billing or Oracle Grants
Accounting is installed.
 

Project Expenditure Item Date
 

PJC_ EXPENDITURE_ ITEM_DATE
 

Date on which a project-related transaction is
incurred.
 

Project Expenditure Type ID
 

PJC_ EXPENDITURE_ TYPE_ID
 

Expenditure type used to build the
transaction descriptive flexfield for project-
related transaction distributions.
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Attribute Name Predefined Attribute Description

 

Project Funding Allocation ID
 

PJC_ FUNDING_ ALLOCATION_ID
 

Specifies the name of the project funding
override. Used when Oracle Contract Billing
or Oracle Grants Accounting is installed.
 

Project Organization ID
 

PJC_ ORGANIZATION_ ID
 

Identifier of expenditure organization used to
build the transaction descriptive flexfield for
project-related transaction distributions.
 

Project ID
 

PJC_PROJECT_ID
 

Identifier of the project used to build the
transaction descriptive flexfield for project-
related transaction distributions.
 

Reserved Project Fields
 

PJC_ RESERVED_ ATTRIBUTE1-10
 

Reserved for project-related functionality.
 

Project Task ID
 

PJC_TASK_ID
 

Identifier of the task used to build the
transaction descriptive flexfield for project-
related transaction distributions.
 

Reserved User Defined Project Fields
 

PJC_ USER_ DEF_ ATTRIBUTE1-10
 

Reserved for user-defined project
information.
 

Project Work Type ID
 

PJC_ WORK_TYPE_ID
 

Identifier of project-related classification for
worked performed.
 

Prepare Modified Identifier
 

PreparerModifiedFlag
 

Indicates whether the expense preparer
modified the account or project distribution.
 

Project Name
 

ProjectName
 

Project name to which an expense item is
assigned.
 

Project Number
 

ProjectNumber
 

Project number to which an expense item is
assigned.
 

Reimbursable Amount
 

ReimbursableAmount
 

Amount to be reimbursed to the individual
against this expense distribution.
 

Key Flexfield Segment 1-30
 

Segment1-30
 

Key flexfield: segment of the key flexfield.
 

Sequence Number
 

SequenceNum
 

Sequence in which the distributions are
created.
 

Task Name
 

TaskName
 

Task name to which an expense item is
assigned.
 

Task Number
 

TaskNumber
 

Task number to which an expense item is
assigned.
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EmployeeExpenseAttendeeVO - Employee Attendees Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the Employee
Attendees region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Amount
 

Amount
 

Amount spent on the expense attendee.
 

Attendee Party ID
 

AttendeePartyId
 

Attendee party identifier.
 

Attendee Type
 

AttendeeType
 

Attendee or recipient type of the expense
attendee.
 

Created By
 

CreatedBy
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of
the creation of the row.
 

Employee Identifier
 

EmployeeFlag
 

Indicates whether an expense attendee is an
employee.
 

Employer Address
 

EmployerAddress
 

Employer address of the expense attendee.
 

Employer Name
 

EmployerName
 

Employer name of the employee or
nonemployee attendee.
 

Employer Party ID
 

ExployerPartyId
 

Employer party identifier.
 

Expense Attendee ID
 

ExpenseAttendeeId
 

Expense attendee identifier.
 

Expense ID
 

ExpenseId
 

Related expense item identifier.
 

Formatted Amount
 

FormattedAmount
 

Formatted receipt amount.
 

Last Update Date
 

LastUpdateDate
 

Who column: indicates the date and time of
the last update of the row.
 

Last Updated By
 

LastUpdatedBy
 

Who column: indicates the user who last
updated the row.
 

Last Updated By Login
 

LastUpdateLogin
 

Who column: indicates the session login
associated with the user who last updated
the row.
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Attribute Name Predefined Attribute Description

Name
 

Name
 

Name of the employee or nonemployee
expense attendee.
 

Object Version Number
 

ObjectVersionNumber
 

Used to implement optimistic locking. This
number is incremented every time that the
row is updated. The number is compared at
the start and end of a transaction to detect
whether another session has updated the
row since it was queried.
 

Tax Identifier
 

TaxIdentifier
 

Tax identifier of the employee or
nonemployee expense attendee.
 

Title
 

Title
 

Title of the employee or nonemployee
expense attendee.
 

NonemployeeExpenseAttendeeVO - Nonemployee Attendees Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Nonemployee Attendees region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Amount
 

Amount
 

Amount spent on the expense attendee.
 

Attendee Party ID
 

AttendeePartyId
 

Attendee party identifier.
 

Attendee Type
 

AttendeeType
 

Attendee or recipient type of the expense
attendee.
 

Created By
 

CreatedBy
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of
the creation of the row.
 

Employee Identifier
 

EmployeeFlag
 

Indicates whether expense attendee is an
employee.
 

Employer Address
 

EmployerAddress
 

Employer address of the expense attendee.
 

Employer Name
 

EmployerName
 

Employer name of the employee or
nonemployee attendee.
 

Employer Party ID
 

EmployerPartyId
 

Employer party identifier.
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Attribute Name Predefined Attribute Description

Expense Attendee ID
 

ExpenseAttendeeId
 

Expense attendee identifier.
 

Expense ID
 

ExpenseId
 

Related expense item identifier.
 

Formatted Amount
 

FormattedAmount
 

Formatted receipt amount.
 

Last Update Date
 

LastUpdateDate
 

Who column: indicates the date and time of
the last update of the row.
 

Last Updated By
 

LastUpdatedBy
 

Who column: indicates the user who last
updated the row.
 

Last Updated By Login
 

LastUpdateLogin
 

Who column: indicates the session login
associated with the user who last updated
the row.
 

Name
 

Name
 

Name of the employee or nonemployee
expense attendee.
 

Object Version Number
 

ObjectVersionNumber
 

Used to implement optimistic locking. This
number is incremented every time that the
row is updated. The number is compared at
the start and end of a transaction to detect
whether another session has updated the
row since it was queried.
 

Tax Identifier
 

TaxIdentifier
 

Tax identifier of the employee or non-
employee expense attendee.
 

Title
 

Title
 

Title of the employee or nonemployee
expense attendee.
 

AttachmentVO - Attachment Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Attachment region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Document
 

DOCUMENT
 

Actual document for the associated
document type.
 

Title
 

TITLE
 

Title that the user gave the attachment.
 



Oracle Financials Cloud
Implementing Expenses

Chapter 3
Expense Policies and Rules

97

Related Topics

• Example of Modifying Expenses Email Notifications Using Oracle Business Intelligence Publisher

Modify Terms and Agreements
The default corporate policy compliance message is an acceptance statement that employees typically acknowledge by
selecting a check box when they create an expense report. The default message states that the worker has read and
accepted the corporate travel and expense policies. If you choose to display a corporate policy compliance message, you
can use the default provided or you can modify your message text and make it text only or a clickable link that navigates to
your company travel and expense policy.

Business units may have their own requirements related to enforcing acceptance of corporate policies. For example, some
business units may require specific terms and agreements text that reflects their unique acceptance message. As an
implementor, you can decide whether you want to:

• Enforce acknowledgment that the worker has read and accepts the corporate polices by presenting a required
check box to select

• Create terms and agreements text specific to a business unit

• Provide specific terms and agreements text that also acts as a link to the corporate policies

• Provide a link to corporate policies that is specific to a business unit

You decide the text message to display and whether or not to display it as a clickable link to the corporate policy. You also
decide whether or not to enforce workers' acknowledgment and acceptance of corporate policies by including a check box
before the text message that must be selected. These decisions are made on the Create or Edit Expenses System Options
page.

To navigate to the All Business Units section:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expenses System Options

2. On the Manage Expenses System Options page, Corporate Options for Expense Report subsection, select the
Enable terms and agreements check box.

3. Select the Enable corporate policy URL check box.

To navigate to the Specific Business Units section:

1. In the Setup and Maintenance work area, go to the following:

a. Offering: Financials
b. Functional Area: Expenses
c. Task: Manage Expenses System Options

2. On the Manage Expenses System Options page, Specific Business Units section, select and click a specific
business unit.

3. On the Edit Expenses System Options page, select the Corporate Options for Expense Report tab.
4. From the Enable Terms and Agreements choice list, select an option.
5. From the Enable Corporate Policy URL choice list, select an option.
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Navigation to a specific business unit: Setup and Maintenance > Search: Manage Expenses System Options > Click
Manage Expenses System Options link > Manage Expenses System Options page > Specific Business Units
section > Select and click a specific business unit > Edit Expenses System Options page > Select the Corporate
Options for Expense Report tab > Enable Terms and Agreements choice list and the Enable Corporate Policy
URL choice list.

Displaying User-Defined Terms and Agreements Text
You have several options to consider before you decide what and how to display terms and agreements text.

The following table contains several combinations of selecting or deselecting terms and agreements text with or without a
corporate policy URL. The table also describes the resulting text and links that are displayed on the Create and Edit Expense
Report page and on the Welcome page. The selections contained in the table are made on the Manage Expenses System
Options setup page for all business units.

Tip:  You can make the same combination of selections for specific business units with the same resulting text
and links displayed on the Create Expense Report Page and on the Welcome Page. Instead of selecting check
boxes, you select options from a choice list. When you make choices on the Edit Expenses System Option page,
you select options from the Enable Terms and Agreements choice list and from the Enable Corporate Policy URL
choice list.

Enable Terms and
Agreements Check Box

Corporate Policy Choice
List

Enable Corporate Policy
URL Check Box

URL Field Resulting Text and Links
Displayed on the Create
Expense Report Page
and the Welcome Page

Selected
 

Default option selected
 

Selected
 

URL Specified
 

• Check box visible
before text.

◦ A worker
must select
the check
box to
acknowledge
acceptance
of the
corporate
policies
before
submitting
an expense
report.

• Text: I have read
and accept the
corporate travel
and expense
policies.

• Clickable link
that opens to
your company's
travel and
expense policies
document.

• A clickable
link, Corporate
Policies, appears
on the Welcome
page that opens
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Enable Terms and
Agreements Check Box

Corporate Policy Choice
List

Enable Corporate Policy
URL Check Box

URL Field Resulting Text and Links
Displayed on the Create
Expense Report Page
and the Welcome Page

to your company's
travel and
expense policies
document.

Selected
 

User-defined option
selected
 

Selected
 

URL Specified
 

• Check box visible
before text.

◦ A worker
must select
the check
box to
acknowledge
acceptance
of the
corporate
policies
before
submitting
an expense
report.

• Text: User-defined
text.

• Clickable link
that opens to
a document
specified by the
URL.

• A clickable
link, Corporate
Policies, appears
on the Welcome
page that opens
to your company's
travel and
expense policies
document.

Deselected
 

N/A
 

Selected
 

URL Specified
 

• No check box
visible before text.

• Text: Corporate
Policies.

• Clickable link
that opens to
a document
specified by the
URL.

• A clickable
link, Corporate
Policies, appears
on the Welcome
page that opens
to your company's
travel and
expense policies
document.

Selected
 

User-defined option
selected
 

Selected
 

Not Applicable
 

• Check box visible
before text.
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Enable Terms and
Agreements Check Box

Corporate Policy Choice
List

Enable Corporate Policy
URL Check Box

URL Field Resulting Text and Links
Displayed on the Create
Expense Report Page
and the Welcome Page

• Text: User-defined
text.

• No link to
corporate policies.

• No clickable link
appears on the
Welcome page.

Selected
 

Not Applicable
 

Selected
 

Not Applicable
 

• No check box
visible in expense
report.

• No link to
corporate policies.

• No clickable link
appears on the
Welcome page.

Selected
 

Not Applicable
 

Selected
 

URL Specified
 

• No check box
visible in expense
report.

• Clickable link
that opens to
a document
specified by the
URL.

• A clickable
link, Corporate
Policies, appears
on the Welcome
page that opens
to your company's
travel and
expense policies
document.

Creating Lookup Codes for User-Defined Terms and Agreements Text
To create user-defined corporate policy compliance text that is displayed on the Create and Edit Expense Report page,
perform the following steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Task: Define Lookups

2. Click the Manage Standard Lookups link.
3. On the Manage Standard Lookups page, Search section, enter ORA_EXM_TERMS_AGRMT in the Lookup Type

field and click Search. The ORA_EXM_TERMS_AGRMT lookup type appears, along with its associated lookup
codes.

4. In the ORA_EXM_TERMS_AGRMT: Lookup Codes section, click the New (+) icon to add a new row to the table.
5. In the Lookup Code field, you can enter a unique value, such as Business Unit 1.
6. In the Display Sequence field, enter the sequence in which you want the meanings to display.
7. Select the Enabled check box to enable the lookup code.
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8. In the Meaning field, enter a business term that defines the lookup code. The meaning of the lookup codes are
displayed in sequential order when you enable terms and agreements.

9. In the Description field, enter a short description for the lookup code meaning. Whatever you enter for the
description is displayed when you hover over a value on the choice list.

10. Click Save or Save and Close.

Related Topics
• Overview of Lookups

Options for Configuring Expense Policies
To enforce compliance with your company's expense policies, you can specify any of the following options:

• Receipt required

• Corporate card usage

• Conversion rate

Specifying a Receipt Required Policy
If your accounts payable department requires a receipt for each expense, then you must specify the following for each
expense type that you define on the Create Expense Type page:

• A receipt requirement rule that reflects your company's receipt policy. A receipt can be required for cash only or for
corporate card and cash.

• An expense amount, over which a receipt is required

• Warning and error tolerance percentages so the application can warn the user, if opted, of a receipt required policy
violation or, in the case of an error, actually prevent submission of the expense report

Warnings are tracked by the application. You can view them in the Expense Items section on the Edit Expense Report page.
Errors aren't tracked because they prevent submission of an expense report.

Specifying a Corporate Card Usage Policy
You can set up corporate card usage policies to enforce the use of corporate cards. These policies increase your control of
the cards by enforcing compliance with the usage policies.

You can specify corporate card usage policies in the Edit Corporate Card Usage Policy dialog box by specifying cash limits
for expense categories. A cash limit is a cash ceiling, over which an employee must use a corporate card to pay for an
expense. An expense category is a grouping of expense types. For example, the expense category of Airfare includes the
following expense types: International Air and Domestic Air.

You must also specify tolerance percentages for warnings or errors as they relate to the cash limits for the expense
categories. The following table illustrates how the warning and error tolerance percentages work for corporate card usage
policies.

Cash Limit for Expense
Category of Car Rental

Warning Tolerance
Percentage

Warning Amount Error Tolerance
Percentage

Error Amount

$100
 

5%
 

$100 + $5 = $105.
 

10%
 

$100 + $10 = $110.
 

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FACIA173771
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Cash Limit for Expense
Category of Car Rental

Warning Tolerance
Percentage

Warning Amount Error Tolerance
Percentage

Error Amount

The warning tolerance is
$100 up to $105. Over
$105, the user sees a
warning.
 

The error tolerance
is over $105 up to
$110. Over $110, the
application prevents the
user from submitting the
expense report.
 

If the employee enters a cash amount over $105 for a car rental on the expense report, a warning displays, if opted, that
reminds the employee to use a corporate card, instead of cash, for car rental charges over $100. Warnings are tracked by
the application. You can view them in the Expense Items section on the Edit Expense Report page.

If the employee enters a cash amount over $110 for a car rental on the expense report, the application prevents submission
of the expense report. Therefore, errors aren't tracked by the application.

Note:  If no cash limits are defined, you can submit cash expenses of any amount.

Specifying a Conversion Rate Policy
You can define conversion rate behavior for each business unit in your company. These definitions enable you to enforce
conversion rate policies and to validate the conversion rates that employees enter for foreign currency receipts. If you enter a
conversion rate value in an expense report, or override a defaulted value, the value you enter is validated against the current
conversion rate definitions.

Note:  Conversion rate behavior applies only to cash expenses, not to corporate card expenses.

You can specify the following conversion rate behavior on the Edit Conversion Rates and Policies page:

• Type of conversion rate, whether Corporate, Spot, or User

• Whether you want the conversion rate to default onto a newly created expense report

Note:  The default conversion rate is only applicable to cash transactions.

• Warning and error tolerance percentages so the application knows when to warn the user, if opted, of a conversion
rate policy violation or, in the case of an error, actually prevent submission of the expense report

• Warning and error tolerance percentages, if opted, for specific currencies

The following table illustrates how warning and error tolerance percentages work for conversion rate policies.

Conversion Rate Warning Tolerance
Percentage

Warning Tolerance Error Tolerance
Percentage

Error Tolerance

Conversion Rate Type =
Corporate where 1 GBP
= 1.579 USD.
 
For this example, the
employee reports
expenses on the expense
report in GBP, but is
reimbursed in USD.

5%
 

1.579 + .07895 =
1.65795
 
The warning tolerance
is 1.579 USD up to
1.65795. If the user
enters a conversion rate
over 1.65795, a warning
displays.

10%
 

1.579 + .1579 = 1.7369
 
The error tolerance is
over 1.65795 up to
1.7369. If the user enters
a conversion rate over
1.7369, the application
prevents the user from
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Conversion Rate Warning Tolerance
Percentage

Warning Tolerance Error Tolerance
Percentage

Error Tolerance

    submitting the expense
report.
 

If the employee enters a cash amount for a meal of 25 GBP on the expense report and indicates a conversion rate over
1.65795, a warning displays, if opted, that reminds the employee to use a conversion rate less than 1.65795. Warnings are
tracked by the application. You can view them in the Expense Items section on the Edit Expense Report page.

If the employee enters a cash amount for a meal of 25 GBP on the expense report and indicates a conversion rate over
1.7369, the application prevents submission of the expense report. Errors aren't tracked by the application.

Note:  If a conversion rate isn't defined for the applicable reimbursement currency in Oracle Fusion General
Ledger, the application can't enforce the conversion rate policy.

Expense Category-Specific Fields
An expense category is a broad application-defined expense classification, such as Accommodations, Airfare, Car Rental,
Meals, and Entertainment. Each expense category has fields associated with it, known as category-specific fields. For
example, Accommodations is an expense category that has the following category-specific fields: Merchant Name and
Checkout Date. Similarly, the Entertainment expense category has the category-specific field of Merchant Name. You can
capture additional expense information for each expense category by optionally enabling the category-specific fields provided
with the application. The category-specific fields are visible in the expense report based on the display action you set. You
can set the display action for each category-specific field as follows:

• Hidden: the field isn't displayed.

• Required: the field is displayed for each expense item in the expense category and the user is required to enter
data.

• Optional: the field is displayed for each expense item in the expense category, but the user isn't required to enter
data.

You can enable the display action for the category-specific fields in each expense category by business unit. The fields you
enable display for all expense reports for the selected business unit.

How You Capture Tax-Related Information in Expense
Reports
You can display tax-related fields in expense reports for the purpose of capturing tax-related information. To capture tax-
related information, you must enable the option to display tax-related fields in expense reports. Select the Display tax fields
on expense report check box on the Edit Tax Fields page. Then, for each business unit, define the display action of each
tax-related field. You can define the display action of tax-related fields for all locations and then define exception display
action for specific countries. For example, Merchant Name and Taxpayer ID are tax-related fields for which you can define
display action.
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The display actions available for each tax-related field are as follows:

• Hidden: Tax-related field isn't displayed in the expense report.

• Optional: Tax-related field is displayed for each expense item in the expense category, but the user isn't required to
enter data.

• Required: Tax-related field is displayed for each expense item in the expense category and the user is required to
enter data

Note:  If you set the display action for the fields in each expense category at the business unit level, then the
enabled fields appear in all expense reports for the given business unit.

Options for Showing or Hiding the Tax Classification Code
Whether to show or hide the Tax Classification Code choice list from employees on the UI is a management decision based
on your company's practices. Some companies let their employees assign a tax classification code to their expenses. Others
don't want employees to have that ability. You can choose from the following options:

• Show the Tax Classification Code on the UI

• Hide the Tax Classification Code from the UI

• Hide the Tax Classification Code from the UI and assign it on the back end

Show the Tax Classification Code on the UI
The following table describes how to show the Tax Classification Code choice list on the UI.

Hide or Show Option Edit Tax Fields Page--Setup and
Maintenance

Create Expense Type Page--
Setup and Maintenance

Create Expense Item Page--
Expense Entry

Show the Tax Classification
Code choice list on the UI.
 

• Implementor selects
the Display tax fields on
expense report check
box.

• Implementor selects
Optional or Required from
the Tax Classification
Code choice list.

Not applicable.
 

Employees select an option
from the Tax Classification Code
choice list when creating an
expense report.
 

Hide the Tax Classification Code from the UI
The following table describes how to hide the Tax Classification Code choice list from the UI.

Hide or Show Option Edit Tax Fields Page--Setup and
Maintenance

Create Expense Type Page--
Setup and Maintenance

Create Expense Item Page--
Expense Entry

Hide the Tax Classification Code
choice list from the UI.
 

• Implementor selects
the Display tax fields on
expense report check
box.

Not applicable.
 

Tax Classification Code choice
list is not visible for employees
to select from when creating an
expense report.
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Hide or Show Option Edit Tax Fields Page--Setup and
Maintenance

Create Expense Type Page--
Setup and Maintenance

Create Expense Item Page--
Expense Entry

• Implementor selects
Hidden from the Tax
Classification Code
choice list.

Tip:  When the Display tax fields on expense report option is selected, the Location field becomes mandatory on
the Create Expense Item page.

Hide the Tax Classification Code from the UI and Assign it on the Back End
The following table describes an alternate option to hide the Tax Classification Code choice list from the UI and assign the tax
classification code on the back end.

Hide or Show Option Edit Tax Fields Page--Setup and
Maintenance

Create Expense Type Page--
Setup and Maintenance

Create Expense Item Page--
Expense Entry

Hide the Tax Classification Code
choice list from the UI and assign
the tax classification code on the
back end.
 

• Implementor selects
the Display tax fields on
expense report check
box.

• Implementor selects
Hidden from the Tax
Classification Code
choice list.

Implementor assigns the same
or a different tax classification
code to each expense type.
 

• Tax Classification Code
choice list is not visible.

• Tax classification code
is automatically applied
behind the scenes:

◦ To the expense
item when the user
saves the page.

◦ To Oracle Fusion
Payables.

How You Capture Company-Specific Information
You can configure Oracle Fusion Expenses to capture company-specific information about expense reports for each
expense by enabling descriptive flexfields provided at the expense type level. A descriptive flexfield is a configurable field that
captures additional information. For each expense type, you can capture up to 15 fields of additional information. This can be
context-sensitive information based on the expense type or information that is collected across expense types called global
descriptive flexfields.

To enable the capture of additional company-specific information in expense reports:

1. Set up descriptive flexfields.
2. Enable descriptive flexfields.

Set Up Descriptive Flexfields
Set up the descriptive flexfield, EXM_EXPENSES, that is provided by the application. You can enter expense types and fields
you want to show for each expense type on the Manage Descriptive Flexfields for Expense Reports page.



Oracle Financials Cloud
Implementing Expenses

Chapter 3
Expense Policies and Rules

106

To implement context-sensitive or global descriptive flexfields in Expenses, you must:

• Identify expense types on the line level for which you want to capture information and the fields you want to add for
each expense type. These fields are context-sensitive descriptive flexfields.

• Identify the common information that you want to capture across expense types. These fields are global descriptive
flexfields.

• Determine how you want the context-sensitive and global descriptive flexfields to render to the user.

Note:  The expense type you enter in the descriptive flexfield definition must exactly match the expense types
you defined in the expense templates. Otherwise the descriptive flexfield won't be visible.

Enable Descriptive Flexfields
To capture the additional information defined in the descriptive flexfields, you must enable descriptive flexfields in the expense
report. You can set the system option, Enable Descriptive Flexfields, to Yes on the Manage Expenses System Options
page. By default, this option is set to No.

You can set this option at the implementation level on the Manage Expenses System Options page, which applies to all
business units. Alternatively, you can specify exceptions for specific business units on the Create System Options: Specific
Business Unit dialog box.

How You Create Expense Report Header Descriptive
Flexfields
You can configure Oracle Expenses to capture company-specific information for each expense report by enabling descriptive
flexfields at the expense report level. A descriptive flexfield is a configurable field that captures additional information. For each
expense report, you can capture up to 27 additional fields of information.

The types of descriptive flexfields that you can create include:

• Global

• Business unit-specific

• User-defined, context-sensitive

For each type of descriptive flexfield you create, you determine how you want the fields to render. To begin, in Setup and
Maintenance on the Manage Descriptive Flexfields for Expense Reports page, select the predefined descriptive flexfield
named Expense Report Header and click the Edit icon. This predefined descriptive flexfield enables you to create and
place descriptive flexfields of your choice in the header section of expense reports.

Creating Global Descriptive Flexfields
Global descriptive flexfields identify the common information that you want to capture across all expense reports. On the
Edit Descriptive Flexfield: Expenses Report Header page in the Global Segments section, you can create global descriptive
flexfields according to your business requirements.
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Creating Business Unit-Specific Descriptive Flexfields
Business unit-specific descriptive flexfields identify the common information that you want to capture across a specific
business unit. On the Edit Descriptive Flexfield: Expenses Report Header page in the Context Segment section, do the
following:

1. In the Prompt field, enter Business Unit.
2. From the Value Set choice list, select the predefined value set named ORA_EXM_BUSINESS_UNIT.

This value set contains the names of all business units in your organization.

Then, create a context for each business unit that requires specific descriptive flexfields by clicking Manage Contexts.
For example, if you are creating descriptive flexfields for the business unit, Vision Operations, then you must also create a
context named Vision Operations.

Note:  The business unit name you enter as the context display name must match the business unit name
that you select from the Value Set choice list. Otherwise, the business unit-specific descriptive flexfield that you
create won't work.

Creating User-Defined Descriptive Flexfields
User-defined descriptive flexfields identify context sensitive information you want to capture for each expense report. For
example, suppose a user-defined context is Expense Purpose, which captures additional descriptive information related
to Sales, Training, Relocation, or Miscellaneous. On the Edit Descriptive Flexfield: Expenses page in the Context Segment
section, do the following:

1. In the Prompt field, enter the user-defined context, Expense Purpose.
2. From the Value Set choice list, select a value set that contains the values for which you intend to create descriptive

flexfields.

Note:  You many need to create a value set if one doesn't already exist.

The value set contains the names of various contexts of interest.

Then, create a context for each business unit that requires specific descriptive flexfields by clicking Manage Contexts. The
user-defined name you enter as the context display name must match the name that you select from the Value Set choice
list. Otherwise, the user-defined descriptive flexfield that you create won't work.

Note:  In the expense report header, you can create either business unit-specific descriptive flexfields or user-
defined descriptive flexfields. You cannot have both in the expense report header at the same time. Global
descriptive flexfields can always appear with either business unit-specific descriptive flexfields or user-defined
descriptive flexfields.

Note:  Display of expense report level descriptive flexfields isn't dependent on the Enable Descriptive
Flexfield option on the Manage Expenses System Options page.

Related Topics
• Overview of Flexfields

• Overview of Flexfield Configuration

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FACIA193101
http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FACIA1123603
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• Flexfield Components

Expense Types
An expense type is a potential expense that employees or contingent workers can incur. Expense types are granular
expenses. For example, if Accommodations is an expense category, then possible expense types are Hotel, Motel, and Bed
and Breakfast.

Setting up expense types in Expenses includes the following actions:

• Creating expense types

• Itemizing expense types

• Enabling project-enabled expense types

• Enabling automatic population of the tax classification code

Creating Expense Types
When you create an expense type on the Create Expense Type page, you assign an account to the expense type. This
enables the application to allocate expenses to a specific account. Additionally, you can specify whether receipts are required
when users submit expense reports for approval. You can also require submission of a receipt over a specified amount.
Receipt submission requirements can be set up for cash expenses, corporate card expenses, or both.

After creating expense types, associate them with corporate card expense types on the Card Expense Type Mapping tab of
the Create Expense Template page. Corporate card expense types come predefined with Expenses or you can add them
as additional lookups. Associating defined expense types with corporate card expense types enables Expenses to correctly
derive expense types during the corporate card transaction upload process.

Itemizing Expense Types
Itemization is the breaking down of charges in a granular fashion so they can be applied to specific accounts. Itemization
applies to both corporate card expense types and cash.

You set up itemization on the Itemization tab of the Create or Edit Expense Type page according to your company's
requirements. You decide whether to enable, disable, or require itemization by employees or contingent workers when they
create an expense item during expense entry. During itemization setup, you also decide one of the following:

• Whether expense types you define are eligible during expense entry for itemization only.

• Whether expense types you define are also available as an independent, single expense type.

Note:  When itemization is set up as Required or Enabled, include at least one expense type on the Itemization
tab of the Create Expense Type page.

Specify whether a card expense type is a candidate for automatic itemization on the Card Expense Type Mapping tab of
the Create Expense Template page. If you enable automatic itemization for an expense type, you must then select a default
itemization expense type. A default itemization expense type is one to which expenses are automatically populated when
they are outside the defined itemization. For example, suppose a deploying company maps corporate card expense types
to expense types and identifies a default itemization expense type called Miscellaneous. When the corporate card feed file is
uploaded to Expenses, any unmapped expense types default to the Miscellaneous expense type.

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FACIA1876474
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Note:  If automatic itemization is disabled for a specific expense type, then the expense type is not automatically
itemized for you.

Enabling Project-Enabled Expense Types
Project-enabled expense types are associated with a project expenditure type in Oracle Fusion Project Costing if the user
is allowed to enter project information. For example, a project-enabled expense type enables a consultant to allocate his
consulting expenses to a specific project and its tasks during expense creation report.

To set up project-enabled expense types on the Project Expenditure Type Mapping tab of the Create Expense Type page,
select the Enable projects check box. You must also select a default project expenditure type, which is a project expense
type to which unspecified project unit expenses are assigned. Additionally, you can specify whether receipts are required for
project expenses when the user submits an expense report.

The project-enabled expense type can be mapped to a specific project unit and a project expenditure type on an exception
basis. It's the association of a project-enabled expense type with a project unit and a project expenditure type that derives
accounting in Oracle Projects Costing.

Note:  Before you can project-enable expense types, you must perform the following prerequisite setup in
Oracle Fusion Project Foundation:

• Project unit: A unique identifier of a group of projects that are managed as a unit.
• Project expenditure type: A classification of cost.

Enabling Automatic Population of the Tax Classification Code
When you create an expense type on the Create Expense Type page, you can specify the tax classification code that applies
to the expense type. The tax classification code specified during the setup of an expense type is automatically populated onto
the Create Expense Item page during expense entry. If necessary, the user can override the specified tax classification code
when creating an expense item if the tax field is enabled on the report.

Options for Controlling the Behavior of Expense Fields
You can control the behavior of certain fields on the Create Expense Item page. You can choose to update the following
modifiable expense fields at the most granular level or at a less granular level:

• Description

• Merchant Name

• Number of Days

• Expense Location

If you want to modify expense fields on specific UI pages, you can set up the modifiable expense fields at the most granular
level. The most granular setup occurs at the expense type level.

When you set up modifiable expense fields, you can specify expense field behavior for:

• All expense types associated with an expense template

• Specific expense types
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Alternately, you can perform a less granular implementation of the modifiable expense fields with the setups for:

• Expense policies

• Tax fields

• Expense fields by category

• The profile option, EXM_LINE_DESCR_REQUIRED, referred to as Description Line Required

A less granular level implementation is setup that is not dependent on a specific expense type.

Modifiable Expense Fields Displayed by Expense Category
The Description field and the Expense Location field display in all expense categories. However, the Merchant Name field
and the Number of Days field only display for certain categories.

The following exception table summarizes the default visibility of the Merchant Name field and the Numbers of Days field
when you initially receive the application.

Expense Category Default Display of Merchant Name Field Default Display of Number of Days Field

Accommodations
 

Yes
 

Yes
 

Airfare
 

Yes
 

No
 

Car Rental
 

Yes
 

Yes
 

Entertainment
 

Yes
 

No
 

Meals
 

Yes
 

No
 

Mileage
 

No
 

No
 

Miscellaneous
 

Yes
 

Yes
 

Per Diem
 

No
 

No
 

If you want to change the behavior of any of the modifiable fields, you can do so.

All Expense Types Associated with an Expense Template
On the Expense Fields tab of the Create Expense Report Template page, you can set a value of Null, Hidden, Optional, or
Required for the following modifiable expense fields:

• Description

• Expense Location

• Number of Days

• Merchant Name
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When you create a new expense template, the default value for all of the preceding modifiable expense fields is Hidden.
A Null value indicates that no setup has occurred and that you do not intend to use the expense template to specify the
behavior of the modifiable expense field.

The values you select for the modifiable expense fields at the expense template level are applicable to all expense types
available in the expense template. You can set up any exceptions at the expense type level.

Specific Expense Types
On the Expense Fields tab of the Create Expense Type page, you can set a value of Use setup from expense template,
Hidden, Optional, or Required for the following modifiable expense fields:

• Description

• Expense Location

• Number of Days

• Merchant Name

The default value is Use setup from expense template. If you retain the default value for any of the modifiable expense
fields and the expense template setup is Null for any of the modifiable expense fields, it means that no setup exists at the
expense template level or at the expense type level.

On the Policies tab of the Create Expense Type page, you can assign an expense policy to an expense type. Different
expense policies require you to enter information in different expense fields. Contradictions can arise between an expense
field value for an expense policy and the expense field setup at the expense type level or at the expense template level. If a
contradiction occurs, the application asks you to either change the expense field value or select a different expense policy.

Setup Precedence of Modifiable Expense Fields
Expenses follows a precedence when multiple setups exist for modifiable expense fields. For example, if you set the Number
of Days field at the expense type level to Optional and the same field at the expense template level is set to Required, the
application complies with the expense type level setting.

The following table contains the setup precedence of the modifiable fields and their corresponding setup object, setup task,
and setup page.

Setup Precedence of Modifiable Fields Setup Up and Setup and Maintenance Task Page

1 = Highest Precedence
 

Expense Type
 
Manage Expense Report Templates
 

Create Expense Type Page, Expense Fields
tab
 

2
 

Expense Template
 
Manage Expense Report Templates
 

Create Expense Report Template Page,
Expense Fields tab
 

3
 

Expense Policies
 
Manage Policies by Expense Category
 

Create Expense Policy
 

4
 

Line Description Required Profile Option
 
Manage Profile Options
 

Manage Profile Options
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Setup Precedence of Modifiable Fields Setup Up and Setup and Maintenance Task Page

5
 

Tax Fields
 
Manage Tax Fields
 

Edit Tax Fields
 

6
 

Expense Fields by Category
 
Manage Expense Fields by Category
 

Manage Expense Fields by Category
 

Options for Creating Expense Templates
An expense template is a grouping of related expense types that are defined for a specific business unit. Examples of
groupings of related expense types include expense templates for travel, education, and relocation. Expense templates
enable companies to control the expense types visible to each business unit. Additionally, if your company processes card
transactions and you want expense types automatically assigned during card transaction processing, you must set a default
template.

When creating expense templates, it's advisable to consider the following actions:

• Using expense templates

• Defining default expense templates

• Inactivating expense templates

Using Expense Templates
When employees create expense items in the Create Expense Item dialog box to add to new or existing reports, they select
a specific expense template.

The following rules apply to expense templates:

• Each business unit can have multiple expense templates associated with it.

• Expense templates cannot be shared across business units.

Note:  If your company operates in multiple countries, you must create one expense template per business
unit. If your users use multiple languages within a business unit, then you must implement expense
templates in each of those languages.

Defining Default Expense Templates
A default expense template is the first expense template that you create on the Create Expense Template page with
corporate card expense type mapping. The application automatically sets the first template as the default template. This
action occurs whether or not you select the Set as default check box on the Create Expense Template page. You can also
change the default template, as long as the one you are changing to has corporate card expense type mapping.

The purpose of a default expense template is to automatically populate expense types to credit card transactions. Thus,
when employees or contingent workers create expense reports, they can see the expense types assigned to the corporate
card transactions. The default expense template uses the corporate card expense type mapping to associate expense types
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with the corporate card transactions. This association occurs when the corporate card feed file containing corporate card
charges is uploaded to Expenses.

The following rules apply to default expense templates:

• Each business unit can have only one default expense template.

• For any business unit, you can have a default expense template with additional expense templates.

• For any business unit, you can have a default expense template with no additional expense templates.

Note:  If neither a default expense template nor an expense template is associated with a business unit, you
can't implement Expenses.

Inactivating Expense Templates
Deploying companies do not typically inactivate expense templates because they can't use them after the end date. It's
therefore advisable to leave the Effective End Date field blank, unless you intend to retire the expense template. Any
expenses that are incurred after an end date can't be reported using an inactivated expense template. It's more likely that you
would inactivate individual expense types, rather than inactivate an expense template.

To inactivate an expense template, enter a date in the Effective End Date field on the Create Expense Template page.
You can also inactivate individual expense types in the same way on the Create or Edit Expense Type page. However, the
expense template end date overrides the end date for individual expense types. Note that employees can still use inactivated
templates to enter expenses on a report for the period in which the expense report was active.

Caution:  If you decide to inactivate a default expense template, then no corporate card mapping occurs if no
other default expense template is identified.

How Expense Item Accounting Is Derived
This topic provides an example of the expense item accounting flow so you can understand how expense item accounting
works. With this understanding, you can set up default expense accounts properly to generate valid expense account
combinations.

Before you can derive distributions, you must:

• Define default expense accounts in your human resources application for each person who uses Oracle Expenses
Cloud.

• Decide whether or not to give employees the capability of changing the company segment and the cost center
segment

• Decide whether or not to give employees the capability of changing all segments in the default expense account

• Set up the natural expense account for expense types in the expense template.

Settings That Affect Expense Item Accounting
The following setups affect expense item accounting:

• Default expense account set up
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Every person who uses Expenses must be set up with a default expense account in your human resources
application.

Note:   If you don't set up default expense accounts for all users, they can't submit expense reports.

• Natural expense account setup
When you create an expense report template on the Create Expense Report Template page, you set up expense
types and specify the natural expense account for each expense type. The natural expense account is a segment in
the default expense account.

• Optional expense accounting privilege assignment
You can assign the expense accounting privilege named Override Expense Account Allocation for all employees.
Then, they can change the Company and Cost Center segments of the default expense account on the Create or
Edit Expense Item page.
To set up the Override Expense Account Allocation privilege, navigate to: Setup and Maintenance > Tools >
Security Console.

• Optional accounting profile option setup
You can set the accounting profile option named EXM_ALLOW_FULL_ACCT_OVERRIDE to Yes for all or specific
employees. Then, they can change any segment of the default expense account on the Create or Edit Expense Item
page.
To set the accounting profile option for all employees, navigate to: Setup and Maintenance and search for and select
Manage Administrator Profile Values. Search for the profile option named EXM_ALLOW_FULL_ACCT_OVERRIDE in
the Profile Option Code field and set the Profile Value choice list to Yes at the site, product, or user level.

How Expense Item Accounting Is Derived
The example in the following table describes how expense item accounting works.

Step Action Initial Expense Account Resulting Default Expense
Account

1.
  An employee's default expense

account is set up in the human
resources application where:

• 10 = Company
• 520 = Department
• First set of four zeros =

Natural Expense Account

01-520-0000-0000-000
 

Not applicable.
 

2.
 

Employee creates an expense
report and selects the expense
type of Hotel.
 
Hotel = 7670 in the Travel
expense template.
 

01-520-0000-0000-000
 

01-520-7670-0000-000
 



Oracle Financials Cloud
Implementing Expenses

Chapter 3
Expense Policies and Rules

115

Step Action Initial Expense Account Resulting Default Expense
Account

3.
  Employee has the expense

accounting privilege of Override
Expense Account Allocation
assigned him.

Employee sees the following
segments on the Create
Expense Item page:

• Company segment 01.
Employee changes 01 to
02.

• Department segment
520. Employee changes
520 to 540.

01-520-7670-0000-000
 

02-540-7670-0000-000
 

4.
  Accounting profile option named

EXM_ALLOW_FULL_ACCT_OVERRIDE
is enabled.

Employee sees the entire
default expense account with
all the segments on the Create
Expense Item page. He can
change any or all segments.

• Segment 0000. Employee
changes 0000 to 3251.

• Segment 000. Employee
changes 000 to 478.

02-540-7670-0000-000
 

02-540-7670-3251-478
 

If you change accounting segments on the Create or Edit Expense Item page, the change is applied to the Expenses
accounting distributions in the background. When the expense report is processed for reimbursement, Oracle Payables
Cloud pulls the expense item accounting information from Expenses to generate accounting. The resulting invoice or payment
request reflects the accounting.

Entertainment Expense Policy
An entertainment expense policy is a policy that you define to manage entertainment and gift expenses for which employees
are reimbursed. Your company must comply with laws and regulations and guard against inappropriate expenditures that
may arise when employees entertain or give gifts to customers. To assist with this effort, you can define entertainment
spending rules, enable entertainment policy violations, and capture information about event attendees and gift recipients.

When you define an entertainment expense policy, you perform the following actions:

• Define types of rate limits and number of currencies

• Determine whether to include attendee types as the rate determinant

• Determine whether to enforce the entertainment expense policy and how

• Specify attendee-related information to capture

• Define rate limit amounts
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• Associate the entertainment expense policy with an expense type

In the Setup and Maintenance work area, use the following:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Policies by Expense Category

To navigate to the Create Entertainment Policy page, select Entertainment from the Create Policy choice list.

Define Types of Rate Limits and Number of Currencies
In the Rate Definition section on the Create Entertainment Policy page, you decide whether to enable rate limits for the
entertainment expense policy. If you enable them, you can:

• Select a type of rate limit, whether yearly, by instance, or both.

• Specify whether the entertainment expense policy rate is defined by a single currency or multiple currencies.

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a conversion rate in
Oracle Fusion General Ledger.

Determine Whether to Include Attendee Types as the Rate Determinant
A rate determinant for an entertainment policy determines the policy rate amount limit that an employee can be reimbursed
for entertainment or gift expenses. An entertainment expense policy has one rate determinant, which is attendee types.

In the Rate Determinants section on the Create Entertainment Policy page, you decide whether to include types of attendees
as the rate determinant. To include them, you can define different policy rates for different attendee types, such as:

• Public sector attendees

• Private sector attendees

Determine Whether to Enforce the Entertainment Expense Policy and How
In the Policy Enforcement section on the Create Entertainment Policy page, you decide whether to enforce the entertainment
expense policy. To enforce it, select one of the following:

• Reimburse only the rate limit amount when an expense exceeds the defined rate. For example, if the rate limit is 25
USD for a gift to a customer and an employee spends 30, he is reimbursed 25.

• Generate a policy violation when an expense exceeds the defined rate.

◦ Warning: A percentage is used to calculate a warning. The warning tolerance amount is calculated as follows:
Policy Rate * (1+Warning Tolerance/100)

If you submit an expense in a report that has an amount that is greater than the warning tolerance, you will
see a warning if the Display warning to user check box is selected in the Policy Enforcement section on the
Create Entertainment Policy page.

Note:  A warning is always displayed to the approver, whether or not the Display warning to user
check box is selected.
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◦ Error: A percentage is used to calculate an error. The error tolerance amount is calculated as follows:

Policy Rate * (1+Error Tolerance/100)

If you submit an expense in a report that has an amount that is greater than the error tolerance, you're
prevented from submitting the expense report.

Specify Attendee-Related Information to Capture
You decide which of the following event attendee information to capture in the Add Attendees dialog box. You can do it by
selecting any of the following check boxes in the Enable Attendee Information section on the Create Entertainment Policy
page:

• Require attendee amount: If selected, employees are required to enter amounts that were actually spent on event
attendees.

• Require employee name: If selected, employees are required to enter at least one employee as an event attendee.

• Display employee attendee information: If selected, an Employees section is visible in the Add Attendees dialog
box.

• Display nonemployee attendee information: If selected, a Nonemployees section is visible in the Add
Attendees dialog box.

Define Rate Limit Amounts
After you finish defining the entertainment expense policy and save it, you can then define entertainment rate limit amounts in
the Create Rates dialog box.

Note:  Rates with overlapping start and end dates are invalid.

Associate the Entertainment Expense Policy with an Expense Type
Before you can associate the entertainment policy with an expense type, you must first activate the policy from the Manage
Policies by Expense Category page. You can do it by selecting the policy and then selecting the Activate option from the
Actions menu.

The final sequence of steps is as follows:

1. On the Create Expense Report Template page, create a template for entertainment or select an existing
entertainment template.

2. On the Expense Types tab on the Create Expense Report Template page, create an entertainment expense type.
3. In the Create Expense Type dialog box, create an entertainment expense type.
4. On the Policies tab in the Create Expense Type dialog box, select the entertainment expense policy, specify the

start date, and optionally the end date.

After the entertainment policy rate is set, a violation is raised when an employee submits a report that contains an expense
that violates the policy.



Oracle Financials Cloud
Implementing Expenses

Chapter 3
Expense Policies and Rules

118

Set Up an Accommodations Expense Policy
Your company can set up and enforce accommodations expense policies to help control, manage, and reduce spending for
accommodations expenses. Two examples of accommodations expense policies are the enforcement of a hotel expense limit
of 200 USD per day and the enforcement of hotels that are on the company's preferred merchant list.

This topic covers the following aspects of setting up an accommodations expense policy.

• Setting Up an Accommodations Policy

• Setting Up Policy Violations

• Completing the Accommodations Rate Spreadsheet

• Associating the Accommodations Expense Policy with an Expense Type

Setting Up an Accommodations Policy
The following procedure enables you to set up an accommodations expense policy and complete the accommodations rate
spreadsheet for uploading to the application.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, select Accommodations from the Create Policy choice list.
3. On the Create Accommodations Expense Policy page in the Rate Definition section, do the following:

a. Select the Single currency radio button.
b. Currency = USD.

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a
conversion rate in Oracle Fusion General Ledger.

4. In the Rate Determinants section, do the following:

a. Select the Roles check box.
b. Select the Locations check box.
c. Role Type = Job.
d. Select the Geographical locations check box.

5. In the Policy Enforcements section, do the following:

a. Select the Policy violation warning check box.
b. Warning Tolerance Percentage = 10.
c. Select the Display warning to user check box.
d. Select the Prevent report submission check box.
e. Error Tolerance Percentage = 20.

The preceding accommodations expense policy says the following: The accommodations expense policy is set up with a
single instance daily rate in US dollars, by job, by geographical location, and is enforced by a warning and error.
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Setting Up Policy Violations
You can set up policy violations for accommodations expense policies as shown in the following table.

Policy Violation Application's Action Effect Calculation

Warning
 

Generates a warning
policy violation when an
accommodations expense
exceeds the defined tolerance.
 

You see a warning if you
selected the Display warning
to user check box.

A warning is always displayed to
the approver, whether or not you
select the Display warning to
user check box.

Policy Rate * (1+Warning
Tolerance/ 100)
 

Error
 

Generates an error
policy violation when an
accommodations expense
exceeds the defined tolerance.
 

You see an error and you are
prevented from submitting the
accommodations expense.
 

Policy Rate * (1+Error Tolerance/
100)
 

Completing the Accommodations Rate Spreadsheet
To complete an accommodations rate spreadsheet, perform the following steps:

1. On the Create Accommodations Policy page, click the Create Rate button.
2. Download the predefined spreadsheet to your local drive for completion.

Note:  If you select rate determinants in the Rate Determinants section, you complete the predefined
spreadsheet. If you don't select any rate determinants, you create accommodations rates in the
Create Rates dialog box.

3. On the Create Accommodations Rates spreadsheet, complete the fields as shown in the following table.

Role Geographical Location Daily Limit Start Date

ACC500. Accounting Manager
 

All Others, San Francisco, CA,
United States
 

200
 

1/1/2014
 

ACC500. Accounting Manager
 

All Others, New York, NY,
United States
 

220
 

1/1/2014
 

ACC500. Accounting Manager
 

All Others, All Others, All Others,
United States
 

185
 

1/1/2014
 

SAL600. Salesperson
 

All Others, San Francisco, CA,
United States
 

195
 

1/1/2014
 

SAL600. Salesperson
 

All Others, New York, NY,
United States
 

215
 

1/1/2014
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Role Geographical Location Daily Limit Start Date

SAL600. Salesperson
 

All Others, All Others, All Others,
United States
 

170
 

1/1/2014
 

SAL700. Salesperson
 

All Others, San Francisco, CA,
United States
 

250
 

1/1/2014
 

SAL700. Salesperson
 

All Others, New York, NY,
United States
 

255
 

1/1/2014
 

SAL700. Salesperson
 

All Others, All Others, All Others,
United States
 

222
 

1/1/2014
 

All Others
 

All Others, All Others, All Others,
All Others
 

200
 

1/1/2014
 

4. Click the Upload button.

When rates are successfully uploaded, the policy status becomes valid. To use this rate policy for calculation of
accommodations expenses, you must:

1. Activate the accommodations expense policy.

a. On the Manage Policies by Expense Category page, select the accommodations expense policy you created
and click the Activate button.

2. Assign the accommodations expense policy to an expense type.

Assigning the Accommodations Expense Policy to an Expense Type
To assign the accommodations expense policy to an expense type, complete the following steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, click the Create icon or select an applicable template for a
business unit.

3. On the Create Expense Report Template page, create a template for accommodations expenses.
4. On the Expense Types tab click the Create icon to open the Create Expense Type dialog box.
5. In the Create Expense Type dialog box, select Accommodations from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the accommodations expense policy you

created, specify the start date, and optionally specify an end date.

Set Up a Meals Expense Policy
Your company can set up and enforce meal expense policies to help control, manage, and reduce spending for meal
expenses. Examples of scenarios where a meals expense policy is applicable include the following: a salesperson requests
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reimbursement for a lunch with customers, a consultant requests reimbursement for meals on a business trip, an employee
requests reimbursement for meals while attending an off-site workshop.

This topic covers the following aspects of setting up a meals expense policy.

• Setting Up a Meals Expense Policy

• Setting Up Policy Violations

• Completing the Meals Rate Spreadsheet

• Associating the Meals Expense Policy with an Expense Type

Setting Up a Meals Expense Policy
The following procedure enables you to set up a meals expense policy and complete the meals rate spreadsheet for
uploading to the application.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page select Meals from the Create Policy choice list.
3. On the Create Meals Expense Policy page in the Rate Definition section, do the following:

a. Select the Single instance limit check box.
b. Select the Single currency radio button.
c. Currency = USD US Dollar

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a
conversion rate in Oracle Fusion General Ledger.

4. In the Rate Determinants section, do the following:

a. Select the Role check box.
b. Role Type = Job.

5. In the Policy Enforcements section, do the following:

a. Select the Policy violation warning check box.
b. Warning Tolerance Percentage = 10.
c. Select the Display warning to user check box.
d. Select the Prevent report submission check box.
e. Error Tolerance Percentage = 20.

The preceding meals expense policy says the following: The meals expense policy is set up with a single instance rate in US
dollars, by job, and is enforced by a warning and an error.

Setting Up Policy Violations
You can set up policy violations for a meals expense policy as shown in the following table.
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Policy Violation Application's Action Effect Calculation

Warning
 

Generates a warning policy
violation when a meals expense
exceeds the defined tolerance.
 

You see a warning if you
selected the Display warning
to user check box.

A warning is always displayed to
the approver, whether or not you
select the Display warning to
user check box.

Policy Rate * (1+Warning
Tolerance/ 100)
 

Error
 

Generates an error policy
violation when a meals expense
exceeds the defined tolerance.
 

You see an error and you are
prevented from submitting the
meals expense report.
 

Policy Rate * (1+Error Tolerance/
100)
 

Completing the Meals Rate Spreadsheet
To complete a meals rate spreadsheet, perform the following steps.

1. On the Create Meals Policy page, click the Create Rates button.
2. Download the predefined spreadsheet to your local drive for completion.

Note:  If you select rate determinants in the Rate Determinants section, you complete the predefined
spreadsheet. If you don't select any rate determinants, you create meals rates in the Create Rates
dialog box.

3. On the Create Meals Rates spreadsheet, complete the fields contained in the following table.

Role Single Instance Limit (USD) Start Date

ACC500. Accounting Manager
 

120
 

1/2014
 

SAL600. Salesperson
 

150
 

1/2014
 

SAL700.Sales Manager
 

180
 

1/2014
 

All Others
 

150
 

1/2014
 

4. Click the Upload button.

When rates are successfully uploaded, the policy status is valid. To use the rates spreadsheet for calculation of meal
expenses, you must:

1. Activate the meals expense policy.

a. On the Manage Policies by Expense Category page, select the meals expense policy that you created and
click the Activate button.

2. Assign the meals expense policy to an expense type.
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Assigning the Meals Expense Policy to an Expense Type
To assign the meals expense policy to an expense type, complete the following steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, click the Create icon or select an applicable template for a
business unit.

3. On the Create Expense Report Template page, create a template for meals expenses.
4. On the Expense Types tab, click the Create icon to open the Create Expense Type dialog box.
5. In the Create Expense Type dialog box, select Meals from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the meals expense policy you created, specify

the start date, and optionally specify an end date.

Itemize Meals Expense Categories
You can itemize meals expense categories. Itemizing meals helps you capture the breakdown of meal expenses, such as tips
and taxes.

You must have one of the following roles to enable meals itemization:

• Application Implementation Consultant

• Application Implementation Consultant Financial Administrator

• Expense Manager

To itemize a meal expense type, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, select the applicable template and click the Edit icon.
3. On the Edit Expense Report Template page, Expense Types tab, select the meal expense type that you want to

itemize and click the Edit icon.
4. On the Itemization tab, select one of the following values from the Itemization choice list:

◦ Enabled: to optionally enable itemization

◦ Required: to make itemization mandatory

5. Click the Include check box for the expense types that you want to make available for itemization.
6. Click Save and Close.
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Set Up an Airfare Policy
Your company can set up and enforce airfare expense policies to help control, manage, and reduce spending by employees
for airfare. An example of a scenario where an airfare expense policy is applicable is when a consultant flies to Finland for a
business trip and then submits an expense report for reimbursement of the airfare.

To set up an airfare policy, you perform the following steps:

1. Entering general information
2. Setting up airfare policy violations
3. Creating a flight class policy
4. Activating the airfare policy
5. Assigning the airfare policy to an expense type

Entering General Information
To set up general information, complete the following steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, select Airfare from the Create Policy choice list.
3. On the Create Flight Class Policy page, Flight Class Determinant section:

◦ The Role check box is already selected by default.

◦ From the Role Type choice list, select Job.

The preceding airfare policy says the following: The airfare policy is set up by job and a policy violation is enforced by a
warning.

Setting Up Airfare Policy Violations
In the Policy Enforcement section, accept the following defaults:

• Policy violation warning radio button

• Display warning to user check box.

The following table describes what employees see when you set up warning and error policy violations for an airfare policy.

Application's Action Effect

Warning
 

Generates a warning policy violation when an
airfare expense violates the policy.
 

You see a warning if you selected the Display
warning to user check box.
 
A warning is always displayed to the
approver, whether or not you select the
Display warning to user check box.
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Application's Action Effect

Error
 

Generates an error policy violation when an
airfare expense violates the policy.
 

You see an error and you are prevented from
submitting the expense report.
 

Creating a Flight Class Policy
You can optionally create a flight class policy where you define which job roles can fly which flight classes based on flight
duration or type of flight, whether domestic or international. An example of a flight class policy includes the following:

1. Vice Presidents and over who fly longer than 8 hours for an international flight can purchase a first class ticket.
2. Vice Presidents and under who fly less than 8 hours for a domestic flight must purchase economy class ticket.

Activating the Airfare Policy
To use the airfare policy, you must:

1. Activate the airfare policy.

a. In the Setup and Maintenance work area, go to the following:

i. Offering: Financials
ii. Functional Area: Expenses
iii. Task: Manage Policies by Expense Category

b. On the Manage Policies by Expense Category page, select the airfare expense policy that you created and
click Activate.

2. Assign the airfare policy to an expense type.

Assigning the Airfare Policy to an Expense Type
To assign the airfare policy to an expense type, complete the following steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, select an applicable template for a business unit or click the
Create icon.

3. On the Create Expense Report Template page, create a template for Airfare expenses.
4. On the Expense Types tab, click the Create icon.
5. In the Create Expense Type dialog box, select Airfare from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the Airfare policy you created, specify the start

date, and optionally specify an end date.
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Set Up a Car Rental Policy
Your company can set up and enforce car rental expense policies to help control, manage, and reduce spending by
employees for car rentals. An example of a scenario where a car rental expense policy is applicable is when a consultant rents
a car during a business trip and then submits an expense report for reimbursement of the car rental.

To set up a car rental policy, you complete these steps:

1. Setting up a car rental policy
2. Setting up car rental policy violations
3. Completing the car rental rate spreadsheet
4. Activating the car rental policy
5. Assigning the car rental policy to an expense type

Setting Up a Car Rental Policy
To set up a car rental policy, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, from the Create Policy choice list, select Car Rental.
3. On the Create Car Rental Policy page in the Rate Definition section:

a. Select the Single currency option.
b. From the Currency choice list, select USD US Dollar.

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a
conversion rate in Oracle General Ledger.

4. In the Rate Determinants section:

a. Select the Role check box.
b. From the Role Type choice list, select Job.

The preceding car rental policy says the following: The car rental policy is set up with a daily limit in US dollars, by job, and is
enforced by a warning and an error.

Setting Up Car Rental Policy Violations
To set up car rental policy violations, complete these steps in the Policy Enforcement section:

1. Select the Policy violation warning check box.
2. Enter 10 in the Warning Tolerance Percentage field.
3. Select the Display warning to user check box.
4. Select the Prevent report submission check box.
5. Enter 20 in the Error Tolerance Percentage field.
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The following table describes what employees see when you set up warning and error policy violations, as well as the
calculation used to derive the policy violation.

Policy Violation Application's Action Effect Calculation

Warning
 

Generates a warning policy
violation when a car rental
expense exceeds the defined
tolerance.
 

You see a warning if you
selected the Display warning to
user check box.
 

Note: A warning is always
displayed to the approver,
whether or not you select
the Display warning to user
check box.

 

Policy Rate * (1+Warning
Tolerance/ 100)
 

Error
 

Generates an error policy
violation when a car rental
expense exceeds the defined
tolerance.
 

You see an error and you are
prevented from submitting the
expense report.
 

Policy Rate * (1+Error Tolerance/
100)
 

Completing the Car Rental Rate Spreadsheet
To complete a car rental rate spreadsheet, compete these steps:

1. On the Create Car Rental Policy page, click Create Rates.
2. Download the predefined spreadsheet to your local drive for completion.

Tip:  If you select rate determinants in the Rate Determinants section, you complete the predefined
spreadsheet. If you don't select any rate determinants, you create car rental rates in the Create Rates
dialog box.

3. On the Create Car Rental Rates spreadsheet, complete the fields as shown in the following table.

Role Daily Sum Limit (USD) Start Date

ACC500. Accounting Manager
 

100
 

1/2014
 

SAL600. Salesperson
 

120
 

1/2014
 

SAL700.Sales Manager
 

150
 

1/2014
 

All Others
 

90
 

1/2014
 

4. Click Upload.

When rates are successfully uploaded, the policy status is Valid.
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Activating the Car Rental Policy
To use the car rental rates spreadsheet for calculation of car rental expenses, you must:

1. Activate the car rental policy.

a. In the Setup and Maintenance work area, go to the following: Navigate: Setup and Maintenance > Manage
Policies by Expense Category task > Go to Task > Manage Policies by Expense Category page.

• Offering: Financials
• Functional Area: Expenses
• Task: Manage Policies by Expense Category

b. On the Manage Policies by Expense Category page, select the car rental policy that you created and click
Activate.

2. Assign the car rental policy to an expense type.

Assigning the Car Rental Policy to an Expense Type
To assign the car rental policy to an expense type, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, select an applicable template for a business unit or click the
Create icon.

3. On the Create Expense Report Template page, create a template for Car Rental expenses.
4. On the Expense Types tab, click the Create icon.
5. In the Create Expense Type dialog box, select Car Rental from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the Car Rental policy you created, specify the start

date, and optionally specify an end date.

Set Up a Miscellaneous Expense Policy
Your company can set up and enforce miscellaneous expense policies to help control, manage, and reduce spending for
miscellaneous expenses. Examples of miscellaneous expense policies include policies for laundry, internet cable, and parking.

This topic covers the following aspects of setting up a miscellaneous expense policy:

• Setting Up a Miscellaneous Expense Policy

• Setting Up Policy Violations

• Completing the Miscellaneous Rate Spreadsheet

• Associating the Miscellaneous Expense Policy with an Expense Type
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Setting Up a Miscellaneous Expense Policy
The following procedure enables you to set up a miscellaneous expense policy and complete the miscellaneous rate
spreadsheet for uploading to the application.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, select Miscellaneous from the Create Policy choice list.
3. On the Create Miscellaneous Expense Policy page in the Miscellaneous Eligibility Rule section, do the following:

a. Select the Minimum number of days for miscellaneous expense reimbursement check box.
b. Days = 5.

4. In the Rate Type section, select the Rate limit radio button.
5. In the Rate Definition section, do the following:

a. Select the Single instance limit check box.
b. Select the Single currency radio button.
c. Currency = USD US Dollar.

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a
conversion rate in Oracle Fusion General Ledger.

6. In the Rate Determinants section, do the following:

a. Select the Role check box.
b. Role Type = Job.

7. In the Policy Enforcements section, do the following:

a. Select the Policy violation warning check box.
b. Warning Tolerance Percentage = 10.
c. Select the Display warning to user check box.
d. Select the Prevent report submission check box.
e. Error Tolerance Percentage = 20.

The preceding miscellaneous expense policy says the following: You must accrue five days of miscellaneous expenses before
the miscellaneous expense is eligible for reimbursement. This part of the policy is typically used when a company wants
to enforce a laundry policy where the employee can only be reimbursed for laundry expenses if the trip is greater than a
specified number of days. The preceding miscellaneous expense policy is set up with a single instance rate in US dollars, by
job, and is enforced by a warning and an error.

Setting Up Policy Violations
You can set up policy violations for a miscellaneous expense policy as shown in the following table.
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Policy Violation Application's Action Effect Calculation

Warning
 

Generates a warning policy
violation when a miscellaneous
expense exceeds the defined
tolerance.
 

You see a warning if you
selected the Display warning
to user check box.

A warning is always displayed to
the approver, whether or not you
select the Display warning to
user check box.

Policy Rate * (1+Warning
Tolerance/ 100)
 

Error
 

Generates an error policy
violation when a miscellaneous
expense exceeds the defined
tolerance.
 

You see an error and you are
prevented from submitting the
miscellaneous expense.
 

Policy Rate * (1+Error Tolerance/
100)
 

Completing the Miscellaneous Rate Spreadsheet
To complete a miscellaneous rate spreadsheet, perform the following steps:

1. On the Create Miscellaneous Policy page, click the Create Rates button.
2. Download the predefined spreadsheet to your local drive for completion.

Note:  If you select rate determinants in the Rate Determinants section, you complete the predefined
spreadsheet. If you don't select any rate determinants, you create miscellaneous rates in the Create
Rates dialog box.

3. On the Create Miscellaneous Rates spreadsheet, complete the fields as shown in the following table.

Role Single Instance Limit (USD) Start Date

ACC500. Accounting Manager
 

155
 

1/1/2014
 

SAL600. Salesperson
 

150
 

1/1/2014
 

SAL700.Sales Manager
 

160
 

1/1/2014
 

All Others
 

150
 

1/1/2014
 

4. Click the Upload button.

When rates are successfully uploaded, the policy status is valid. To use the miscellaneous rate policy for calculation of
miscellaneous expenses, you must:

1. Activate the miscellaneous expense policy.

a. On the Manage Policies by Expense Category page, select the miscellaneous expense policy that you created
and click the Activate button.

2. Assign the miscellaneous expense policy to an expense type.
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Assigning the Miscellaneous Expense Policy to an Expense Type
To assign the miscellaneous expense policy to an expense type, perform the following steps:

1. In the Setup and Maintenance work area, search for the Manage Expense Report Templates task and click the Go
to Task icon to open the Manage Expense Report Templates page.

2. Click the Create icon or select an applicable template for a business unit.
3. On the Create Expense Report Template page, create a template for miscellaneous expenses.
4. On the Expense Types tab, click the Create icon to open the Create Expense Type dialog box.
5. In the Create Expense Type dialog box, select Miscellaneous from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the miscellaneous expense policy you created,

specify the start date, and optionally specify an end date.

Capture Attendee Information for Expense Categories
Several industries have enacted gift and entertainment regulations to provide transparency and to curtail the amount spent
on individuals to prevent gift recipients from influencing business decisions. To comply with local and industry-specific
regulations, you can easily capture attendee information for any expense category.

First, you create an Entertainment policy with only the capture of attendee information specified. Therefore, the policy will not
validate policy rates. Then, you assign this policy to any expense category except entertainment. When the worker creates
an expense report and enters an expense item that is associated with the Entertainment policy, the application enforces
the entry of attendee and gift recipient details. The attendee details that the worker is required to provide when creating
expense items for an expense report is based on the selections you specified for the capture of attendee information during
the Entertainment policy setup.

To capture attendee information, you must:

• Set up an Entertainment policy with only the capture of attendee information specified.

• Assign the Entertainment policy to an expense type.

Set Up an Entertainment Policy
To set up an Entertainment policy, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, click Create Policy, and select Entertainment to create a
policy.

3. In the Rate Definition section on the Create Entertainment Policy page, deselect the Enable rate limit option.
4. In the Capture Attendee Information section, select the applicable information.
5. Click Save and Close.
6. On the Manage Policies by Expense Category page, select the newly created Entertainment policy and click

Activate to make it available for use.
7. Click Done.
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Assign an Entertainment Policy to an Expense Type
To assign an Entertainment policy to an expense type, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, select an expense template, and click the Edit icon.
3. On the Edit Expense Report Template page, select the expense type to associate with the Entertainment policy.
4. Click the Edit icon.
5. On the Edit Expense Type page, select the Policies tab.
6. In the Attendees Policy section, click the Add Row icon.
7. From the Policy Name choice list, select the Entertainment policy that you created, and enter the start date.
8. Click Save and Close.

How You Set Up a Mileage Expense Policy
You can set up a mileage expense policy to allow employees to claim mileage reimbursement for travel expenses incurred
by using their personal vehicles for business activities. In most countries, mileage reimbursement rates are determined by the
central government.

Based on government mileage regulations and your company policy, you can set up a mileage expense policy by defining:

• Mileage eligibility rules

• Mileage rate determinants

• Mileage add-on rates

Mileage reimbursement is automatically calculated by the application based on your definition of the eligibility rules, rates
determinants, and add-on rates.

In the Setup and Maintenance work area, use the following:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Policies by Expense Category

On the Manage Policies by Expense Category page, click the Create Policy choice list and select Mileage. The create
Mileage Policy page appears.

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a conversion rate in
Oracle Fusion General Ledger.
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Mileage Eligibility Rules
In the Mileage Eligibility Rules section, you specify the rules that determine whether employees can claim mileage
reimbursement for using their personal or company provided vehicles. The following table lists the mileage eligibility rules and
their descriptions.

Mileage Eligibility Rule Description

Standard Mileage Deduction
 

A specified number of miles is deducted from the total miles traveled before the mileage rate
calculation is applied.
 

Minimum Distance for Mileage Eligibility
 

A minimum distance must be traveled before the mileage rate calculation is applied.
 

Commute Mileage Deduction
 

Commute distance between home and office if you're required to deduct it from the trip distance.
 

Mileage Rate Determinants
In the Mileage Rate Determinants section, you specify the determinants on which the mileage reimbursement policy is based.
The following table lists selected mileage rate determinants and their descriptions.

Mileage Rate Determinants Description

Role
 

Mileage rates are based on employees' grades, positions, or jobs.
 

Distance Threshold
 

Mileage rates are based on the distance traveled in a single trip or during a period of time.
 

Vehicle Category
 

Mileage rates are based on vehicle category, such as Company or Private.
 

Vehicle Type
 

Mileage rates are based on vehicle type, such as Car, Motorcycle, or Van.
 

Fuel Type
 

Mileage rates are based on fuel type, such as Diesel, Petrol, Hybrid, or Electric.
 

Mileage Add-On Rates
In the Add-On Rates section, your company can add passenger rates and company-specific rates for inclusion in the mileage
reimbursement policy. The following table lists additional rate types and their descriptions.

Add-On Rates Description

Single rate per passenger
 

One mileage reimbursement rate that applies to each passenger, regardless of the number of
passengers in the vehicle.
 

Rates by mileage determinants
 

Mileage rate reimbursed per passenger varies by multiple mileage rate determinants that you
defined, such as Vehicle Category, Vehicle Type, or Role.
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Add-On Rates Description

Rates by range of passengers
 

Mileage rate reimbursed per passenger varies by the number of passengers in the vehicle. For
example, the mileage reimbursement rate is .25 USD per mile for the first three passengers and .20
USD per mile thereafter.
 

Rate by mileage determinants and range
of passengers
 

Mileage rate reimbursed per passenger varies by multiple mileage rate determinants that you defined
and by the number of passengers in the vehicle. For example, the mileage reimbursement rate
is .10 USD for the first two passengers traveling in a diesel car and .07 USD for the remaining
passengers. Similarly, .08 USD for the first two passengers traveling in a hybrid car and .05 USD for
the remaining passengers.
 

Restrict number of passengers
reimbursed
 

Indicates whether the number of passengers included for reimbursement is limited to a specific
number.
 

Company-Specific Rates
 

Company-specific mileage rate types that you can add to the mileage reimbursement calculation,
such as .30 USD for hauling a trailer and .50 USD for driving on forest roads.
 

Once you finish setting up the mileage expense policy, you must:

• Complete the mileage rate spreadsheet and load the spreadsheet to the application, or complete the Create Rates
dialog box, depending on the complexity of the policy.

• Activate the mileage reimbursement policy.

• Set up cumulative mileage determinants when applicable.

• Assign the mileage reimbursement policy to expense types.

Example of Completing a Mileage Rate Spreadsheet
This example demonstrates how to set up a mileage policy given government mileage regulations and how to complete the
mileage rate spreadsheet for uploading to the application.

The following table summarizes key decisions to consider before setting up a mileage policy.

Decisions to Consider In This Example

What country does the mileage
reimbursement policy apply to?
 
What is the general reimbursement
policy for this country?
 

In Finland, mileage is reimbursed if the employee uses his personal vehicle for business purposes.
 

What vehicle types are included in this
country's mileage policy?
 

• For a car, 45 cents per kilometer for the first 5,000 kilometers and 40 cents per kilometer for
additional kilometers.

• For a motorcycle, 34 cents for the first 5,000 kilometers and 30 cents per kilometer for
additional kilometers.

• For a motorboat, 78 cents per kilometer for engine power less than 50 hp and $1.14 cents
per kilometer for engine power more than 50 hp.

• For a snowmobile, $1.08 cents per kilometer.

What is the unit of measure?
 

Kilometers
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Decisions to Consider In This Example

Will the mileage policy rates be defined
for a single currency or for multiple
currencies?
 
If a currency rate conversion is
necessary to verify a policy rate limit,
you must define a conversion rate in
Oracle Fusion General Ledger.
 

Single currency = Euro
 

What determinants are the mileage rates
based on?
 

• Distance threshold = By period.

Selecting By period implies that the mileage calculation is based on cumulative mileage.
• Vehicle type = Vehicle Type
• Fuel Type = Fuel Type

Have you defined the mileage
determinant values?
 

Define lookup types and lookup codes for vehicle types and fuel types.
 

What passenger rates or passenger
information will be included in the
mileage policy, if any?
 

• Single rate per passenger.
• 3 cents per person when the employee transports other persons, where arranging such

transportation is the duty of the employer.

What company-specific rates need to be
added to the mileage policy, if any?
 

• 7 cents when the job or duty requires transporting a trailer attached to the car.
• 11 cents when the work or duty requires transporting a caravan attached to the car.
• 21 cents when the work or duty requires transporting a resting hut, or similar facility, attached

to the car.
• 3 cents when the employee transports machines or appliances weighing more than 80 kilos,

or unusually big machines or appliances, or must take a dog in the car to perform his duty or
work.

• 9 cents for driving a car on forest roads or on closed building sites because the employee's
duty or work requires such driving.

What are the add-on rate types? Have
you defined the add-on rate types?
 

Define a lookup type and lookup codes for the add-on rate types.
 

Prerequisites
1. Define the mileage determinant values that you want to use.

◦ In this example, you need to define values for the two determinants that you have chosen; Vehicle Type and
Fuel Type.

◦ Create a new lookup type and add the applicable values as lookup codes.

2. Define the company-specific additional rate types that you want to use.

In this example, you need to define the following rate types: Trailer attached to the car, Transporting a caravan,
Transporting a resting hut, Transporting heavy machinery, Dog in the car, and On forest road.
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Setting Up a Mileage Policy
1. On the Manage Policies by Expense Category page, click the Create Policy choice list and select Mileage to open

the Create Mileage Policy page.
2. On the Create Mileage Policy page, complete the fields as shown in the following table.

Field Value

Country
Finland
 

Rate Currency
Single Currency = EUR Euro
 

Unit of Measure
Kilometer
 

Distance Threshold Period
By period
 

Vehicle Type
Lookup type that defines the applicable vehicle types.
 

Fuel Type
Lookup type that defines the applicable fuel types.
 

Passenger Rate Type
Single rate per passenger.
 

Company-Specific Rate Type
Lookup type that defines the additional rate types.
 

Completing the Mileage Rate Spreadsheet
1. On the Create Mileage Policy page, click the Create Rate button.

Note:  In this example, you download a predefined spreadsheet to your local drive for completion
because you selected mileage rate determinants and add-on rates on the Create Mileage Policy page.
If, however, you create a mileage policy for a single currency with no mileage rate determinants or add-
on rates, you create the mileage rate in a dialog box, rather than in a spreadsheet.

2. On the Create Mileage Rates spreadsheet in the Mileage Rates region, complete the fields as shown in the following
table.

Distance Threshold Vehicle Type Fuel Type Rate Start Date End Date

5000
 

Car
 

All Other
 

0.45
 

1/1/2010
 

Car
 

All Other
 

0.4
 

1/1/2010
 

5000
 

Motorcycle
 

All Other
 

0.34
 

1/1/2010
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Distance Threshold Vehicle Type Fuel Type Rate Start Date End Date

Motorcycle
 

All Other
 

0.3
 

1/1/2010
 

Motorboat
 

< 50 hp
 

0.78
 

1/1/2010
 

Motorboat
 

=> 50 hp
 

1.14
 

1/1/2010
 

Snowmobile
 

All Other
 

1.08
 

1/1/2010
 

3. On the Create Mileage Rates spreadsheet in the Passenger Rates region, complete the fields as shown in the
following table.

Calculation Method Rate Start Date End Date

Amount
 

0.03
 

1/1/2010
 

4. On the Create Mileage Rates spreadsheet in the Additional Rates region, complete the fields as shown in the
following table.

Distance
Threshold

Vehicle Type Fuel Type Calculation
Method

Rate Type Rate Start Date End Date

Car
 

All Other
 

Amount
 

Trailer
attached to
the car
 

0.07
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Transporting
a caravan
 

0.11
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Transporting
a resting hut
 

0.21
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Transporting
heavy
machinery
 

0.03
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Dog in the car
 

0.3
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Driving on a
forest road
 

0.09
 

1/1/2010
 

5. On the Create Mileage Rates spreadsheet, click the Upload button.

The policy status becomes valid when rates are successfully uploaded. To use this rate policy for mileage
calculation, you must activate the policy and assign it to an expense type.
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How You Upload Cumulative Mileage from a Third Party
You can upload accumulated mileage-to-date from a legacy system into Oracle Expenses Cloud for a midyear changeover.
Uploading accumulated mileage includes the following actions:

• Performing prerequisites

• Creating a cumulative mileage data file

• Uploading a cumulative mileage data file

• Viewing uploaded cumulative mileage

If both of the following statements are true, you upload cumulative mileage for your employees to Expenses:

• Your mileage rates vary by the total distance traveled during a time period

• You will go live with the application during the current tax year.

Performing Prerequisites
Before you can upload accumulated mileage, you must:

• Define the cumulative mileage determinants in Setup and Maintenance.

• Optionally, create vehicle type, vehicle category, and fuel type lookup codes in Setup and Maintenance.

Creating a Cumulative Mileage Data File
The Upload Cumulative Mileage process accepts cumulative mileage in a text file format as shown in the following table.

Caution:  To avoid data corruption, you can only run the Upload Cumulative Mileage process once per business
unit, unless you are editing existing entries before employees submit additional mileage expenses.

Field Type Description

Person Number.
 

Char (30)
 

• Required
• Must match the person number in the

application.

Accumulated Mileage
 

Number (12)
 

• Required
• Last two digits are decimal places.

Cumulative as of Date
 

MMDDYYYY
 

• Optional.
• If empty, it's assumed to be the

upload date.

Vehicle Category Lookup Code
 

Char (30)
 

Required if cumulative mileage determinant is
by vehicle category.
 

Vehicle Type Lookup Code
 

Char (30)
 

Required if cumulative mileage determinant is
by vehicle type.
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Field Type Description

Fuel Type Lookup Code
 

Char (30)
 

Required if cumulative mileage determinant is
by fuel type.
 

Reimbursement Amount
 

Number(12)
 

• Optional.
• Last two digits are decimal places.

Reimbursement Currency
 

Char(3)
 

• Required if reimbursement amount is
present.

• Three-digit currency.

The following table illustrates sample file entries that you can enter in a text editor to upload cumulative mileage from a third
party. The sample file entries include person number fields with their associated accumulated mileage as of a certain date,
along with the vehicle type.

Person Number Mileage Number Vehicle

10026335772
 

513800000008012014
 

Car
 

10026335790
 

00100210020008022014
 

Car
 

10026335778
 

513800000008012014
 

Car
 

10026335796
 

00100210020008022014
 

Car
 

Uploading a Cumulative Mileage Data File
On the Manage Cumulative Mileage Determinants page, select a cumulative mileage determinant. From the Actions menu,
select Upload. Navigate to: Setup and Maintenance > Search: Manage Cumulative Mileage Determinants.

Viewing Uploaded Cumulative Mileage
After you upload the cumulative mileage, employees can view their mileage in the application by activating the Expense Items
infotile in the Travel and Expenses work area. Then, they select the View Cumulative Mileage option from the Actions menu.
The resulting Cumulative Mileage dialog box allows employees to view cumulative mileage by time period if the mileage rate
is based on a distance threshold. For example, in the UK, employees are reimbursed 45 pounds for the first 10,000 miles
traveled in a car or van and 25 pounds over 10,000 miles.

Integrate with Google Maps for Trip Distance Calculation
Google Maps is a web mapping service developed by Google. Your company can opt to integrate with Google Maps so
employees can automatically and accurately calculate their mileage trip distance. The trip distance is then used to calculate
employees' mileage reimbursement when submitting expense reports.
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This is how it works. Google Maps uses starting locations, midway points, and destination locations to calculate trip
distances. Your company's mileage reimbursement policy may deduct the commute distance between home and office from
the total trip distance. If this is the case, the following calculation applies:

Trip Distance = Total Distance - Commute Distance 

Mandatory Setups to Integrate with Google Maps
To integrate with Google Maps, you must:

• Obtain a Google Map key from Google.

• Enable the Google Maps for Mileage Expenses feature.

a. In the Offerings work area, select the Financials offering.
b. Click the Change Feature Opt In link.
c. On the Opt In: Financials page, select Expenses.
d. Click the Features icon.
e. On the Edit Features: Expenses page, select the Enable check box for the Enable Google Maps for Mileage

Expenses feature.

• Set up a Google Map key.

a. In the Setup and Maintenance work area, select:

• Offering: Financials
• Functional Area: Expenses
• Task: Manage Expenses System Options

b. On the Manage Expenses System Options page, All Business Units section or the Specific Business Units
section, User Options for Expense Report subsection, in the Google Map Key field, enter the Google Map
key, which is an alphanumeric code that communicates with Google Maps.

• Enable single page expense entry.

a. Complete steps 1 to 4 for enabling the Google Maps for Mileage Expenses feature.
b. On the Edit Features: Expenses page, select the Enable check box for the Usability Enhancements for

Expenses feature.
c. Select the Single Page Expense Entry check box.

• Create a mileage policy, optionally include a commute deduction rule, and then assign the mileage policy to an
expense type to activate the policy.

Optional Setups to Integrate with Google Maps
To integrate with Google Maps, you can opt to complete these setups:

• Enable commute mileage deduction.

If enabled on the Create Mileage Policy page, you can opt to set up the commute mileage deduction as optional
or required. If enabled, the application captures the commute distance between home and office and incorporates
it in the trip distance and reimbursement calculation. If you don't set up employees' home addresses in Human
Capital Management, employees can enter their home addresses directly in the Calculate Mileage dialog box when
calculating trip distance.

• Set up preferred locations.
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You can optionally set up preferred locations by creating lookup codes for the lookup type
ORA_EXM_MILEAGE_LOCATIONS. Preferred locations are frequent starting locations or travel destinations that your
company defines. You can set up lookup codes to represent preferred locations that you can select when you want
Google Maps to calculate a trip distance. A lookup code meaning represents a location that you can select and a
lookup code description is the address of the preferred location.

a. In the Setup and Maintenance work area, select:

• Offering: Financials
• Functional Area: Expenses
• Task: Manage Expense Report Auditing Lookup Types

b. On the Manage Expense Report Auditing Lookup Types page, search and select the lookup type
ORA_EXM_MILEAGE_LOCATIONS.

How You Set Up Expense Report Auditing
You can examine, verify, and adjust the contents of expense reports as needed. Auditing expense reports ensures that
employees comply with your company's policies without having to audit all submissions. You can automate several
processes related to expense report auditing.

To set up expense report auditing, you can perform the following first four steps in any order:

1. Create audit selection rules.
2. Create audit list rules.
3. Create expense template and type rules.
4. Create receipt and notification rules.
5. Assign audit rules to business units.

For the last step, you assign the audit rules created in steps 1 to 4 to business units.

Note:  To set up expense report auditing, you must create at least one audit selection rule, audit list rule, or
expense template and type rule and then assign it to a business unit. Otherwise, Expenses can't audit expense
reports.

Create Audit Selection Rules
To enable automatic selection of expense reports for audit, select audit selection rules on the Create Audit Selection Rule
page. Audit selection rules are criteria that Expenses uses to automatically select expense reports for audit.

When you set up audit selection rules, you can optionally specify audit types. Audit types are alphanumeric codes that you
create which print on the cover sheet of each expense report. These codes identify the type of audit to be performed by the
auditor.

Expenses divides expense reports into the following audit categories:

• Automatic Approval

• Original Receipts Audit

• Imaged Receipts Audit

• No Receipts Required Audit
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For example, your alphanumeric code can read: Autoapproval, Paper Receipts Audit, Paperless Audit, or No Receipts
Required. Alternatively, you can create codes known only to your Expense Audit department. Audit types provide your audit
department with a convenient method for sorting paper receipt packages.

Create Audit List Rules
To enable automatic selection of individuals for the audit list, you can:

• Select audit list rules on the Create Audit List Rule page.

• Specify the number of days a violator remains on the audit list.

Audit list rules are criteria that Expenses uses to automatically place violators on the Manage Audit List Membership page.

When an employee submits an expense report, Expenses determines whether the employee has violated an audit list rule.
If he has, he is automatically added to the Manage Audit List Membership page with an end date that matches the value
you entered for the Number of Days an Individual Remains on the Audit List. When the end date is before the current
date, the violator becomes inactive. The violator's name, however, remains on the Manage Audit List Membership page for
historical purposes.

If you select the criterion Maximum Number of Days to Wait for Original Receipt Package on the Create Audit List Rule
page and you enter a value for the maximum number of days to wait, you must also enter a value in the Original Receipt
Package Received Date field for all expense reports on the Audit Expense Report page. After you save and assign the audit
list rule to a business unit, Expenses automatically places employees on the Manage Audit List Membership page who have:

• Pending receipts greater than the maximum number of days to wait

• Submitted receipts that were received after the maximum number of days to wait

Note:  An employee membership is considered active when the current date is between the start date and
the end date or no end date exists. If an active employee on the Manage Audit List Membership page violates
another audit list rule, Expenses adds the new violation and restarts the count for the number of days to remain
on the audit list.

Create Expense Template and Type Rules
To enable selection of expense reports for audit based on expense template and type, set up expense template and type
rules on the Create Expense Template and Type Rule page. These rules can apply to an expense template only or to an
expense type within an expense template. When an employee submits an expense report, Expenses determines whether
it meets the criteria for expense template and type rules. If it does meet the criteria, the report is automatically selected for
audit.

For example, the following table shows Entertainment expense type values associated with the Travel expense template.
Together, they form the Travel and Entertainment rule.

Expense Template Expense Type Expense Type
Amount

Expense Type
Cumulative Amount

Expense Type
Currency

Expense Type
Period

Travel
 

Entertainment
 

250.00
 

250.00
 

USD
 

Month
 

The preceding granular Travel (template) and Entertainment (expense type) rule is interpreted as follows: If the employee
spends more than $250 US dollars in a month on Entertainment using the Travel expense template, then the employee's
expense report is selected for audit.
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You can also create broader rules that are based solely on a specific expense template without an associated expense type.
For example, suppose you want to create a rule for the Training template, then all expense reports that use the Training
template are selected for audit.

Create Receipt and Notification Rules
To enable receipt and notification rules, set them up on the Create Receipt and Notification Rule page.

Create receipt and notification rules to specify:

• Type of expense report receipts required: original, imaged, or both

• Stage at which imaged receipts must be attached to the expense report

• When missing and overdue receipts are overdue

• When expense report payment holds occur

• Action Expenses takes if an employee doesn't respond to notifications for missing and overdue receipts

When an employee submits an expense report, Expenses determines whether receipts are required and acts according to
the receipt and notification rules you specified. Receipt and notification rules are applied at various points throughout the
expense report process. Some receipt and notification rules are applied during expense entry, some are applied during the
Overdue Tracking process, and others are applied during the Process Expense Reimbursement process.

Assign Audit Rules to Business Units
The final audit setup step is to assign the following audit rules to business units on the Manage Expense Report Audit and
Receipt Rule Assignments page:

• Audit selection rules

• Expense template and type selection rules

• Audit list rules

• Receipt and notification rules

You can assign all or any audit rules to all business units in the All Business Units section. In the Specific Business Units
section, you can assign specific audit rules to specific business units.

The rules that you assign to a business unit remain active during the effective period that you specify. If you don't enter an
end date, the rules remain active indefinitely. To change the behavior of an audit rule, you must apply an end date to the
existing rule and then create and assign a new one. If you don't assign an audit rule to a business unit, Expenses doesn't
apply the audit rule to any business unit.

Note:  If you assign an audit list rule to a business unit, you must ensure that you also assign an audit selection
rule to the same business unit that has the criterion, Audit expense reports of individuals on the audit list,
activated. This allows Expenses to automatically add employees to the audit list and monitor the number of
days they remain on the list. If you don't assign an audit list rule to a business unit, but you do assign an audit
selection rule that uses the criterion, Audit expense reports of individuals on the audit list, you can still add
employees to the audit list manually.
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Audit Selection Rules
Audit selection rules are criteria that you select on the Create Audit Selection Rule page. These rules determine which
expense reports are automatically selected for audit if the audit selection rule is true. If you don't select any audit selection
rules, Oracle Fusion Expenses automatically approves all expense reports.

Expenses includes the following audit selection rules:

• Audit the specified percentage of all expense reports.

• Audit expense reports greater than a specified amount.

• Audit expense reports with required receipts.

• Audit expense reports with missing imaged receipts.

• Audit expense reports with policy violations.

• Audit expense reports of individuals on the audit list.

• Audit expense reports with expenses older than a specified number of days.

Audit the Specified Percentage of All Expense Reports
Expenses randomly selects for audit the percentage of expense reports that you specify in the Audit Percentage field in
the Random Selection section. Reports that aren't selected for audit due to an explicit audit selection rule are candidates for
random audit selection.

Tip:  To audit all expense reports, enter 100 in the Audit Percentage field.

Audit Expense Reports Greater than a Specified Amount
Expenses selects for audit all expense reports where the total report amount is greater than the amount you specify for the
audit selection rule. For this audit selection rule, you specify the amount and the ledger currency to use.

For any expense report where the ledger currency you specified is not the same as the reimbursement currency, Expenses
converts the report currency to the ledger currency and calculates the expense report amount. Expenses uses the conversion
rate in the General Ledger Daily Rates table that was in effect on the expense report submission date. If the calculated
expense report amount is greater than the amount you specified for the audit selection rule, the report is selected for audit.

Note:  If no conversion rate is defined in the General Ledger Daily Rates table for the expense report ledger
currency on the expense report submission date, Expenses ignores this audit selection rule and the report is not
selected for audit.

Audit Expense Reports with Required Receipts
Expenses selects for audit all expense reports with at least one expense line that requires a receipt. This audit selection rule
doesn't consider whether the employee actually provided the receipts.
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Audit Expense Reports with Missing Imaged Receipts
Expenses selects for audit all expense reports for which an imaged receipt is missing.

Audit Expense Reports with Policy Violations
Expenses selects for audit all expense reports with at least one expense line that has a policy violation.

Audit Expense Reports of Individuals on the Audit List
Expense reports of employees who are listed on the Manage Audit List Membership page are automatically audited if their
status is active as evidenced by no end date or the current date is before the end date.

To ensure automatic auditing of employees' expense reports listed on the Manage Audit List Membership page, you must:

1. Assign this audit selection rule to the applicable business unit on the Rule Assignments page.
2. Select an applicable audit list rule and assign it to the same business unit you specified in step 1.

Note:  If you don't assign the audit list rule you selected in step 2 to the business unit specified in step
1, you can only add individuals to the Manage Audit List Membership page manually.

Audit Expense Reports with Expenses Older than a Specified Number of Days
Expenses reviews the receipt date of all expenses submitted with an expense report. If at least one receipt date is older
than the expense report submission date by the specified number of days, the report is selected for audit. For example, if
the expense report submission date is October 15 and the maximum age of expenses in the report is 7 days, the report is
selected for audit if it contains expense items earlier than October 8. The audit selection rule calculation is submission date
minus maximum age of expenses.

How You Add to or Remove Employees from the Audit List
The audit list on the Manage Audit List Membership page is the list of employees whose expense reports are automatically
selected for audit if an audit list rule is violated. You can also manually add employees to the audit list. The audit list is not
maintained by each business unit. Instead, one audit list is available across all business units.

With Oracle Fusion Expenses, you can:

• Automatically add and remove employees from the audit list.

• Manually add or remove employees from the audit list.

• Manually add or remove employees from the audit list during auditing.

Automatically Add and Remove Employees from the Audit List
During setup on the Create Audit List Rule page, you can select any of the following audit list rules:

• Maximum number of days to wait for original receipt package

• Allowable total monthly amount of all expense reports
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• Allowable number of policy violations per month

• Allowable number of expense reports per month

Expenses automatically adds employees to the audit list if they violate any audit list rules you select.

You can automatically add employees to the audit list by performing all of the following actions:

• On the Create Audit List Rule page, select audit list criteria to create an audit list rule.

Expenses uses audit list rules to automatically place employees on the audit list if they violate the audit list rules that
you select.

• For each audit list criterion that you select, specify the number of days that the application automatically monitors the
expense reports of the active employees on the audit list.

Note:  If another audit list violation occurs for an employee during the time period he remains on the audit
list, the application resets the count for the same number of days to remain on the list.

• On the Create Expense Report Audit Selection Rule page, select the Audit expense report of individuals on the
audit list rule in the Additional Rules section.

Audit selection rules are the criteria that Expenses uses to automatically select expense reports for audit.

• On the Rule Assignments page, associate the audit list rule and the audit selection rule with a business unit.

You can automatically remove employees from the audit list by performing the following action:

• On the Create Audit List Rule page, enter a value for the number of days that the application automatically monitors
the expense reports of employees on the audit list. When the number of monitoring days is complete, the employee
is no longer automatically monitored by the application and he is inactivated on the Manage Audit List Membership
page.

Note:  For both automatic and manual additions or deletions from the audit list, you can add reasons to the
Audit List Addition Reason choice list by configuring the lookup EXM_AUDIT_REASON.

Manually Add or Remove Employees from the Audit List
On the Manage Audit List Membership page, you can select any of the following predefined reasons from the Audit List
Addition Reason choice list to manually add employees to the audit list:

• Expenses amounts near threshold

• High frequency of same expense types

• Disproportionate number of cash expenses

• Violates an undefined policy

You can manually remove employees from the audit list on the Manage Audit List Membership page by:

• Specifying an end date. If no end date is specified, an employee remains on the audit list indefinitely.

• Selecting a reason from the Audit List Addition Reason choice list:
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Manually Add or Remove Employees from the Audit List During Auditing
While auditing an expense report on the Audit Expense Report page, you can manually add employees to the audit list by:

• Selecting the Add to audit list check box if visible.

• Selecting a reason from the Reason choice list:

While auditing an expense report on the Audit Expense Report page, you can manually remove employees from the audit list
by:

• Selecting the Remove from audit list check box if visible.

• Selecting a reason from the Reason choice list:

Options for Setting Up Receipt Management Rules
Receipt management ensures that all required expense report receipts are submitted by employees. To do this, you can
create receipt and notification rules to determine:

• When to send notifications to employees

• When to place payment holds on expense reports due to missing or overdue receipts

You can assign receipt and notification rules to each business unit in your company to reflect your business policies. When
you set up receipt and notification rules according to your company's policies, employees aren't reimbursed for expenditures
until missing or overdue original or imaged receipts are submitted.

When you set up receipt management rules for your company, you can specify the following:

• Type of receipts

• Granularity of receipt requirements

• Receipt requirements

Type of Receipts
The first and most important receipt management decision is to specify the type of receipt your company requires for
expense report submission. You can require:

• Original receipts

• Imaged receipts

• Original and imaged receipts

You can specify your company's receipt requirement in the header of the Create Receipt and Notification Rule page. Original
receipts are paper receipts that employees receive after incurring an expense. Imaged receipts are expense receipts that have
been converted to a digital image by a camera, scanner, or fax so they can be attached to the online expense report.

Note:  If you specify that imaged receipts are required, you must also specify the point in the expense report
process at which their attachment to the expense report is required.
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Granularity of Receipt Requirements
The second receipt management decision is to specify the level on which you want to define receipt rules. You can specify
receipt rules at all, any, or none of the following levels:

• Organization level: Create Receipt and Notification Rule page

Note:  If you don't select a required type of receipt on the Create Receipt and Notification Rule page, then
Expenses selects Originals only as the default type of receipt required.

• Template level: Create Expense Template page, Receipt Requirement tab

• Expense type level: Edit Expense Type page, Receipt Requirement tab

The following table indicates the sequence in which Expenses processes receipt and notification rules. It starts with the
lowest level and moves to the highest level.

Sequence in Which Expenses
Processes Receipt and Notification
Rules

Level

Lowest level
 

Expense type
 

Middle level
 

Template
 

Highest level
 

Organization
 

Receipt Requirements
The third receipt management decision is to specify receipt requirements. You can define them on the Receipt Requirement
tabs of the Create Expense Template page or the Edit Expense Type page.

You can specify receipt requirements for:

• Cash expense lines

• Corporate card expense lines

• Negative expense lines

• Disallowance of missing receipts

• Display of missing receipt warning

Expense Report Payment Hold Rules
You can set up expense report payment hold rules for individuals and corporate card issuers in the Expense Report Payment
Hold section on the Create Receipt and Notification Rule page. You can then schedule and periodically run the Process
Expense Report Reimbursement process to check whether any payment hold rules are in effect.

An expense report payment hold rule is a component of the receipt and notification rule that is assigned to a specific business
unit. A payment hold rule places current or future expense reports on hold when receipts aren't received or when they're
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overdue. When expense report payment hold rules are implemented, reimbursement to the individual or payment to the
corporate card issuer can't occur until expense report holds are released.

The Process Expense Report Reimbursement process also checks whether expense report payment holds can be released.
Payment holds are released when:

• The expense auditor manually releases the payment hold on the Audit Expense Report page by selecting the
Release Hold option on the Actions menu.

• Based on receipt status, Expenses detects that receipts are received, waived, or declaration received and
automatically releases the payment hold.

Holding expense report payments from individuals and corporate card issuers can include the following reasons:

• Hold payment if receipts are required, but not yet received.

• Hold payment if receipts are overdue on a previously submitted expense report.

All submitted expense reports that require receipts are evaluated. When the rule is set to hold payment when
receipts are overdue, payments for all subsequent reports are placed on hold if any have outstanding receipts.

Note:  If an expense report is placed on payment hold due to overdue or required receipts that are not yet
received, neither the individual nor the corporate card issuer is reimbursed. This rule is applicable only when
the payment liability for the card issuer is Both Pay and the Apply Hold Rule To option is set to Report of both
individuals and corporate card issuers.

Your company schedules and periodically runs the Process Expense Report Reimbursement process, which checks whether
any payment hold rules are in effect. If they are, Expenses places payment holds on expense reports according to the
specified payment hold rules. Individuals who have expense report payments held receive a notification. When receipts are
received or waived, Expenses automatically releases holds. Alternatively, the expense auditor can manually release a payment
hold at his discretion.

Tip:  By default, payments aren't held for project-only expense reports. However, you can specify inclusion
of project-only expense reports as eligible for payment holds by selecting the Apply hold rules to expense
reports check box. Every expense line contains a project-related information check box in the Expense Report
Payment Hold section on the Create Receipt and Notification Rules page.

FAQs for Expense Policies and Rules

Can expense types be used across expense templates?
No. You can't define an expense type in an expense template and reference that same expense type in another expense
template.

You can, however, create an expense type with the same name in another expense template. Expense types are template-
specific.

Related Topics

• What's an expense template

http://www.oracle.com/pls/topic/lookup?ctx=fa19c&id=FAWDE148321
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How can I enable users to select reimbursement currencies for each
expense report?
You must set the setup option, Allow Reimbursement Currency Selection, to Yes and enable multiple currencies in Oracle
Fusion Payables. If you don't want to allow users to select the reimbursement currency, set this option to No.

By default, this setup option is set to No, which means that the expense report is reimbursed in your ledger currency. You
can optionally set the option at the implementation level on the Manage Expenses System Options page, which applies to
all business units. Alternatively, you can specify exceptions for specific business units in the Create System Options: Specific
Business Unit dialog box.

How can I enable users to select payment methods in expense
reports?
You must set the system option, Enable Payment Method, to Yes. If you don't want to allow users to select the payment
method for reimbursement of each expense report, set the option to No.

By default, this option is set to No. The application uses the default payment method, such as check or EFT, that was set up
for the users' reimbursement. You can optionally set the option at the implementation level on the Manage Expenses System
Options page, which applies to all business units. Alternatively, you can specify exceptions for specific business units in the
Create System Options: Specific Business Unit dialog box.

How can I display the barcode?
Set the system option, Display Bar Code, to Yes. The barcode is displayed on the printed copies. This system option
enables you to fax receipts and the expense report cover sheet with the barcode on it to a server. The server attaches the
receipts to the expense reports. You can set this system option at the implementation level on the Manage Expenses System
Options page, which applies to all business units. You can also specify exceptions for specific business units in the Create
System Options: Specific Business Unit dialog box.

Related Topics

• Why do I have to configure the barcode font mapping

How can I configure expense report number prefixes for different
business units?
If you select alphanumeric prefixes for expense report numbers, then you must enter the Expense Report Number Prefix
as a setup option. You can define prefixes at the implementation level on the Manage Expenses System Options page, which
applies to all business units. You can also specify exceptions for specific business units or define the prefix for each business
unit on the Create System Options: Specific Business Unit dialog box.
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How can I enable a printable expense report format and assign it to a
business unit?
Your company can create printable expense report formats in BI Publisher Enterprise to meet legal or expense report
formatting requirements.

You can then assign the formats to any of the business units on the Manage System Options page. To assign a printable
expense report format to an existing business unit, click the applicable business unit link. On the Edit System Options page,
select a value from the Printable Expense Report Format choice list. If the business unit that you want to assign a printable
expense report format to doesn't exist in the Specific Business Units section, click Create. Then select a business unit from
the Business Unit choice list. Now select a value from the Printable Expense Report Format choice list.

How can I change a default expense template for a business unit?
Every business unit can have only one default expense template. If you enable an expense template as the default template,
you can select another template as the default. Only templates that have corporate card mapping enabled are eligible to
become the new default expense template. If the expense template is eligible, then the Set as default check box in the
header section is enabled for selection.

To set another expense template as the default, navigate to the Manage Expense Report Templates page. Find the template
you want to specify as the new default expense template and click its name. In the Edit Expense Report Template page,
select the Set as default check box in the header region and save the template. If the template doesn't meet the criteria for
a default expense template, then the Set as default check box is disabled. In that case, confirm that the Enable corporate
card mapping check box is selected.

How can I enable expense auditors to audit expense reports for
specific business units?
You can enable expense auditors to audit expense reports for specific business units by assigning them specific expense
auditor data roles for the business units. For example, to allow an expense auditor to audit reports for the Vision Operations
business unit, assign the Expense Auditor Vision Operations data role to the auditor.

What's a rate determinant?
A rate determinant for an entertainment expense policy is a variable that determines the policy rate amount limit for which an
employee can be reimbursed for entertainment or gift expenses. An entertainment expense policy has one rate determinant,
which is attendee types. Since attendee types is a rate determinant, you can define different policy rate amounts for different
event attendee types, such as a public sector client or a private sector client.
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How can the administrator enable the Oracle Fusion Expenses mobile
application on an iPhone or iPad?
Using the mobile device, users must download and install the Oracle Fusion Expenses mobile application from the Apple
Store at http://www.apple.com/iphone/from-the-app-store/. Users require the following information to use the mobile
application:

Host URL: If your company has a specific URL for the Oracle Fusion Financials domain, then the host URL is the URL for
the Financials domain. The following URL is an example: https://fusion-fin.mycompany.com:7002. If your company has a
single URL for the entire Oracle Fusion Applications, then the host URL is the one you use for Oracle Fusion Applications. The
following URL is an example: https://fusion.mycompany.com. The server must use an HTTPS connection.

User Name and Password: User's user name and password that is used to access the Expenses web-based application.

If your company doesn't enable Oracle Fusion applications outside its firewall, users must connect to your company's
network using a Virtual Private Network (VPN). The VPN is used for the initial connection and to upload expense items
to Expenses web-based application. For convenience, users can enter expenses on the mobile device when they aren't
connected to VPN.
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4  Travel

How You Set Up Prerequisites for Travel Partner Integration
A travel partner is an online booking provider or a travel agency that provides travel services to your employees. Before
you can set up a travel partner and booking sites in Oracle Fusion Expenses, your company must perform the following
prerequisite steps:

• Select a travel partner.

• Configure booking sites.

• Configure travel policies and policy violations.

• Determine employee access methods.

• Set up employees.

Select a Travel Partner
Your company selects a travel partner based on the travel needs of your employees and the travel booking support provided
by the travel partner in countries where your employees are located. If you choose, you can also use the services of a travel
partner for specific countries only.

Note:  Expenses currently supports travel partner integration with GetThere. GetThere may provide your travel
booking services directly or through a travel agency.

Configure Booking Sites
A booking site is an instance of your travel partner's booking tool that is configured for a group of employees. Your company
may require one or more booking sites, which are configured in the travel partner's system. Your company may require
multiple booking sites depending on your operations.

• Your company operates in multiple countries or regions.

• Your company's travel policies vary based on employee job roles.

For example, employees in the management level of executive vice president and over are eligible to stay in luxury
hotels, while employees in the management level of vice president and under are not eligible. Similarly, employees
in the management level of executive vice president and over are eligible to fly first class, while employees in the
management level of vice president and under are only eligible for business class.

• Your company wants booking sites displayed in the language of each country or region.

Your travel partner configures your booking site instances in its system and provides you with the site names that represent
those instances, as well as the sign in credentials for administrative access.
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Configure Travel Policies and Policy Violations
You create travel policies in the travel partner's system to enforce your company's travel policies. For each booking site that
you set up, you must configure travel policies and policy violations. When you set up your travel partner in Expenses, the
travel policy violations and justifications are downloaded to Expenses with the itineraries.

Determine Employee Access Methods
Your company must decide how your employees will access and sign in to the booking sites. Your company can enable sign
in access in one of the two following ways.

• Single sign-on (SSO)

• Authentication by travel partner

If your company already has a system that centrally manages all user accounts and passwords, known as Federated
authentication with an identity provider, and sign in to all systems are routed through this central system, you can use the
same capability for accessing your booking sites. When you enable SSO, employee passwords are not stored in your travel
partner's system. You can enable SSO for all or for specific booking sites.

Caution:  When you set up employees in booking sites with SSO enabled, it is advisable for employee user
names in booking sites to match the corresponding user names in your IdP. For example, if employee user
names are their email identifiers, then it's advisable for the user names in the booking sites to also be email
identifiers.

An alternative way to enable sign in access is authentication by your travel partner. In this scenario, you associate your
employees with booking sites in your travel partner's system, along with their user names and passwords. When employees
access the booking sites, they enter their user names and passwords and the booking sites validate the sign in credentials.
For this access alternative, user names do not have to match that of any other system.

Set Up Employees
After your travel partner configures your booking site instances in its system, you can set up your employees and their sign in
credentials in your travel partner's system. If your travel policies vary by job roles or other criteria, you must set up the relevant
information for each employee in the travel partner's system. This information also determines your employees' access to
relevant booking sites.

Setting Up a Travel Partner and Booking Sites: Explained
A travel partner is an online booking provider or a travel agency that provides travel services to your employees. A booking
site is an instance of your travel partner's booking tool that is configured for a group of employees.

Before you can set up a travel partner and booking sites, your company must perform the following prerequisite steps in the
travel partner's system:

• Select a travel partner.

• Configure booking sites.

• Configure travel policies and policy violations.

• Determine employee access methods.



Oracle Financials Cloud
Implementing Expenses

Chapter 4
Travel

155

• Set up employees.

The following table contains mandatory and optional setups that you complete at the travel partner or booking site levels to
integrate with a travel partner.

Mandatory Setups Level Page

Yes
 

itinerary import
 

Travel partner
 

Manage Travel Partner
Integration
 

No
 

itinerary validation rules
 

Travel partner or booking site
 

Manage Travel Partner
Integration or Create or Edit
Booking Site
 

Yes
 

booking sites
 

Booking site
 

Create or Edit Booking Site
 

Yes
 

booking site links
 

Booking site or travel partner
 

Create or Edit Booking Site
or Manage Travel Partner
Integration
 

No
 

booking site assignments
 

Booking site
 

Create or Edit Booking Site
 

Itinerary Import
To import itineraries into Expenses from your travel partner, you must enter the following information at the travel partner level.

• Connection user name and password

Your travel partner provides the user name and password to your company.

• Super site name

The travel partner's system assigns a name to your company.

Itinerary Validation Rules
Your reliance on accurate travel data to make strategic, company-wide travel decisions is essential. To improve the accuracy
of travel data and to provide visibility of policy violations to approvers and auditors, you can enable validations on itineraries
when they are imported into Expenses. You manage itinerary validation rules on the Manage Travel Itinerary Validation Rules
page. You can optionally assign itinerary validation rules at the travel partner level or the booking site level, based on your
company's global and regional business requirements. You can also override an itinerary validation rule at the booking site
level.

Booking Sites
You must create booking sites to import itineraries and to permit your employees to navigate to booking sites from the
Expenses work area. Your travel partner provides you with a booking site identifier for each of your company booking sites.
Site identifiers identify your booking sites to your travel partner and are required for itinerary import.

Note:  You must create at least one booking site for your travel partner.
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Booking Site Links
To allow employees to access travel booking sites from the Expenses work area, you can define a booking site link in the
following ways:

• Default booking site URL:

All your employees use this link if they are not assigned to a specific booking site.

To select this option, enter an URL at the partner level in the Default Booking Site Link field in the Booking Sites
section on the Manage Travel Partner Integration page. By default, all employees use this URL to access the travel
partner unless you specify a booking site-specific URL on the Create Booking Site page.

Note:  An URL entered at the booking site level on the Create Booking Site page overrides the URL
entered at the partner level on the Manage Travel Partner Integration page.

• Booking site-specific URLs:

Each booking site has a specific link. Even if you have a single travel partner site, you can define an exception using
a site-specific link. You may have to use booking site-specific URLs when:

◦ Your company uses a SSO for most, but not all, of its locations. You need specific booking sites due to local
or regional regulations. Your company uses a SSO for most, but not all, of its locations.

◦ You need specific booking sites due to local or regional regulations.

To select this option, enter an URL at the booking site level in the Site Booking Link field on the Create Booking Site page.

Whether you select the default booking site URL or the booking site-specific URLs option, you can enter any of the following
access links:

• Single sign-on (SSO)

◦ From the Travel tab in the Expenses work area, employees navigate to their assigned booking site after the
application signs them in automatically.

• Authentication by travel partner or travel agency

◦ Employees navigate to the travel partner or travel agency's authentication page where they provide their user
name and password and then they are taken to their assigned booking sites.

If your company permits SSO, you enter the SSO URL from the identity provider as the booking site link. When employees
click Book Travel in the Expenses work area, they are automatically signed in and they automatically navigate to their
assigned booking sites.

If your company doesn't permit SSO, employee credentials are authenticated by the travel partner or the travel agency. When
employees click Book Travel in the Expenses work area, they navigate to the booking site URL that you set up. However, they
must enter their credentials and sign in to the booking site.

The applicable URL can be your travel partner's site URL or a travel agency's booking site URL, depending on how you
access your travel sites.
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Booking Site Assignments
Assignment of employees to a booking site on the Create Booking Site page is required only if you select the booking site-
specific URLs option as described in the Booking Site Links section of this topic. When you assign employees to booking
sites, information you enter in Expenses and in GetThere results in automatic navigation of employees to the correct booking
site when they click Book Travel on the Trips page.

In your travel partner's system, you have set up employees and the travel sites to which they have access. In the Site
Assignments section on the Create Booking Site page, instead of individually assigning employees to sites, you specify the
association based on two parameters, country and employment. Within employment, site assignment of employees can be
set up by job role or job management level.

The following table contains examples of employee booking site assignments by country, by employment groups, and by type
of employment.

Scenario Assignment by Country Employment Groups to Which
Assignment is Applicable

Assignment by Employment
Type

Booking site is accessible to all
employees in the company.
 

All countries
 

All employment
 

Not applicable
 

Booking site is accessible to all
employees in the US.
 

Specific country
 

All employees
 

Not applicable
 

Booking site is accessible to
all senior vice presidents in the
company, except in Australia.
 

All countries with exceptions
 

Specific employment
 

Job management level
 

Note:  Before you can select the Job role or Job management level option in the Site Assignments section on
the Create Booking Site page, you must set up job roles and job management levels in Oracle Human Capital
Management.

How You Set Up Travel Integration
You integrate with your travel partner to improve employee travel booking experience, to provide visibility to travel actions and
patterns, and to facilitate reporting on noncompliant travel. In addition, the resulting travel data enables you to make cost-
effective decisions and help with travel supplier negotiations.

When you enable travel integration, the following actions can occur:

• Itinerary data is imported into Expenses from your travel partner and trips are automatically created for valid
itineraries.

• Updates to itineraries are imported into Expenses from your travel partner until the employee takes the trip.

• The travel administrator corrects itineraries with validation errors.

• Employees manage their trips.

• Expense reports are automatically created and appear in the Expenses work area.
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• Approvers and auditors can view the difference between booked and actual travel expenses, booking policy
violations, and justifications provided by users.

The following figure illustrates how a deploying company integrates with a travel partner.

Integrating with a Travel Partner
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Note:  Expenses supports integration with GetThere.

To set up travel integration in Expenses, you must perform the following required setup tasks:

• Enable Travel Integration

• Configure Travel Partner and Travel Sites
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• Schedule Travel Itinerary Import Process

• Assign Travel Administrator

To improve the quality of travel data and to enhance employees' user experience, you can set up the following optional tasks:

• Define Itinerary Validation Rules

• Enable Automatic Creation of Trip-Based Expense Reports

Enable Travel Integration
To receive itinerary data from your travel partner, you must enable travel integration. To do this, select Yes for the Enable
Travel option on the Manage Expenses System Options page. You can set this option for all business units or for specific
business units that are enabling travel integration.

In the Setup and Maintenance work area, use the following to navigate to the Manage Expenses System Options page:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Expenses System Options

Configure Travel Partner and Travel Sites
Your travel partner and its booking sites store the following information about your company's setup:

• Connection information to your travel partner for itinerary import

• Travel sites defined by your company

• Booking site links

• Association of your employees with booking sites.

You can integrate with your travel partner and set up booking sites on the Manage Travel Partner Integration page.

In the Setup and Maintenance work area, use the following to navigate to the Manage Travel Partner Integration page:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Travel Partner Integrations

Schedule Import Travel Itineraries Process
To automatically import itineraries into Expenses at predefined intervals, you must schedule the Import Travel Itineraries
process. The first run of the process imports itineraries according to the specified import process start date and time.
Subsequent runs import itineraries that are created or updated since the last import. You can schedule the process to import
itineraries for each booking site. The process imports itineraries in both active and ticketed statuses. A ticketed status means
that the travel partner or merchant has issued a ticket to the employee for the trip. Because the process runs in near real-
time, it's advisable to schedule it frequently.

Note:  The Import Travel Itineraries process also imports itineraries that have a status of Canceled. If itineraries
were canceled before importation, they won't have any details. If itineraries are canceled after importation, their
status is updated accordingly.
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You can schedule the Import Travel Itineraries process from the Travel Administration work area Tasks pane by clicking
the Import Travel Itineraries link. Navigation: Travel Administration > Import Travel Itineraries > Advanced button >
Schedule tab. Alternately, you can schedule it from the Scheduled Processes work area. Navigation: Navigator > Tools >
Scheduled Processes > Schedule New Process > Job > Name: Import Travel Itineraries.

Assign Travel Administrator
To monitor imported itineraries and resolve itinerary data errors, you must have a travel administrator. To provide the travel
administrator with access to the Travel Administration work area, you must assign him or her the job role of Travel Manager.

In the Setup and Maintenance work area, use the following to navigate to the Manage Users page:

• Offering: Financials

• Task: Manage Users

Optionally, Enable Itinerary Validation Rules
Your reliance on accurate travel data to make strategic, company-wide travel decisions is essential. You can optionally enable
travel itinerary validation rules to be applied when travel itineraries are imported. An itinerary validation rule identifies data
errors so the travel administrator can correct them. Additionally, you can enable itinerary validation rules if you want expense
report approvers and auditors to view booking policy violations and the associated justifications provided by employees.

Additional setup is required if you choose to enable the following validations for use in creating validation rules:

• Airline class of ticket

• Location

• Merchant

• Policy violation

The following table describes the validations that require additional setup, their validation types, source names, and high-level
setup actions.

Validations Validation Type Source Name High-Level Set Up

Airline class of ticket
 

Lookup
 

EXM_ TICKET_CLASS
 

1. Add lookup codes to the
EXM_TICKET_CLASS
lookup type on the
Manage Travel Policy
Lookup Types page.

2. Alternatively, you can
create a new class of
ticket lookup type that
starts with the prefix
EXM_TRAVEL

In the Setup and Maintenance
work area, use the following to
navigate to the Manage Travel
Policy Lookup Types page.

• Offering: Financials
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Validations Validation Type Source Name High-Level Set Up

• Task: Manage Travel
Policy Lookup Types

Location
 

Trading Community Architecture
 

Not applicable
 

1. Review geographies
on the TCA Manage
Geographies page.

2. Create a missing
geography hierarchy for
all possible city, state,
and country values for
itinerary reservations.

In the Setup and Maintenance
work area, use the following
to navigate to the Manage
Geographies page:

• Offering: Financials
• Task: Manage

Geographies

Merchant
 

Table
 

EXM_MERCHANT
 

1. Open the predefined
Merchant Codes
spreadsheet from the
Manage Merchant
Codes task in the Travel
Administration work area.

2. Ensure that all
merchants for itinerary
reservations appear in the
spreadsheet.

3. Add any needed
merchants to the
spreadsheet.

Policy Violation
 

Lookup
 

EXM_ POL_ VIOLATION_ TYPES
 

1. Add lookup codes to the
EXM_POL_VIOLATION
_TYPES lookup type on
the Manage Travel Policy
Lookup Types page.

2. Alternatively, you can
create a new booking
policy lookup type that
starts with the prefix
EXM_TRAVEL.

In the Setup and Maintenance
work area, use the following to
navigate to the Manage Travel
Policy Lookup Types page:

• Offering: Financials
• Task: Manage Travel

Policy Lookup Types

You can assign itinerary validation rules to your travel partner or to its booking sites. Creation and assignment of the validation
rules occurs on the Create Travel Itinerary Validation Rules page. Navigation: Navigator > My Information > Expenses
> Travel Administration > Manage Travel Itinerary Validation Rules task > Create icon > Create Travel Itinerary
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Validation Rules page. Alternatively, you can access the Manage Travel Itinerary Validation Rules page from the Setup and
Maintenance work area.

Optionally, Enable Automatic Creation of Trip-Based Expense Reports
You can optionally enable automatic creation of expense reports based on trips. Automatic creation of reports simplifies and
expedites expense entry for employees. To do this, you can take the following steps:

1. Select Yes for the Enable Automatic Travel Expense Report Creation option on the Manage Expenses System
Options page. When travel is enabled, the default value for this option is Yes. You can set this option for all business
units or for specific business units.

In the Setup and Maintenance work area, use the following to navigate to the Manage Expenses System Options
page:

◦ Offering: Financials

◦ Task: Manage Expenses System Options

2. Schedule the Create Trip Expense Report process to automatically create expense reports from trips. This process
creates expense reports from corporate card transactions that match those transacted over the trip's duration.
The timing of the expense report creation is based on each employee's preference as specified on the Expenses
Preferences page. Navigation: Navigator > Tools > Scheduled Processes > Schedule New Process > Job >
Name: Create Trip Expense Report.

When automatic creation of expense reports is enabled, employees can choose to generate expense reports upon
completion of their trips or when they receive the first corporate card transaction. Employees can also choose to manually
initiate creation of expense reports.

How You Set Up Travel Itinerary Validation Rules
Your reliance on accurate travel data to make strategic, company-wide travel decisions is essential. To improve the accuracy
of travel data and to provide visibility of policy violations to approvers and auditors, you can enable validations that act on
itineraries when you import them.

You can setup itinerary validation rules on the Manage Travel Itinerary Validation Rules page. You can enforce them by
assigning them to a travel partner or to a specific booking site.

The application executes two types of itinerary validation rules:

• Validations that always occur

• Validations that you can enable

Validations That Always Occur
The Import Travel Itineraries process has validations that identify:

• Invalid itineraries to reject

• Itineraries with critical validation errors
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Itineraries that are rejected and didn't import are displayed in the Itinerary Import Failures dialog box by clicking on the
nonzero value of the Itinerary Import Failures count for a process shown in the Travel Itinerary Import Requests table in the
Travel Administration work area. They can have any of the following errors:

• The itinerary status is Null.

• The last modified time stamp on the itinerary is null or is an invalid format.

• The itinerary has an Invalid reservation, where the reservation confirmation number is null.

• An unexpected error occurs while attempting to import the details for an itinerary.

Note:  Validations that always occur do not require any setup.

Trips aren't created for itineraries that failed import and you can't access their details for correction. The Import Travel
Itineraries process attempts to reimport failed itineraries for the number of days past the initial failed import specified by the
process parameter.

Itineraries with critical validation errors that require you to fix them before a trip can be created include those with:

• Missing or unmatched employee numbers

• Missing pricing information, such as amount and currency, for one or more reservations

• An unexpected error while validating an itinerary

You can fix itineraries with critical validation errors in the Review Travel Itinerary Import Results page. Clicking the nonzero
value of the Critical Validation Errors count for a process shown in the Travel Itinerary Import Requests table in the Travel
Administration work area, navigates you to the Review Travel Itinerary Import Results page displaying those errors.

Trips are also not created for itineraries with critical validation errors. The Import Travel Itineraries process continues to
revalidate all itineraries with validation errors and create a trip for itineraries once critical validation errors are fixed.

Validations That You Can Enable
To enhance the quality of trip data, you can enable a set of itinerary validations. The following itinerary validations require
additional setup as described:

• Policy violation validations

• Merchant validation

• Location validation

• Ticket's air class validation

• Currency code and amount

• Date and time

• Flight or train number

The following table describes the validations that you can enable with their associated setup steps.
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Validation Steps to Enable Validations

Policy violation validations
  The Import Travel Itineraries process validates policy violations provided by your travel partner

against the policy violations specified as the source lookup assigned to the policy violation validation
rules on the Manage Travel Itinerary Validation Rules page.

1. In the Setup and Maintenance work area, use the following to navigate to the Manage Travel
Policy Lookup Types page.:

◦ Offering: Financials

◦ Task: Manage Travel Policy Lookup Types

2. Navigate as follows: Setup and Maintenance > Manage Travel Policy Lookup Types
task > Go to Task icon > Manage Travel Policy Lookup Types page.

3. Configure the lookup codes in the EXM_POL_VIOLATION_TYPES lookup type to include the
violations provided by your travel partner or create a new EXM lookup type and codes for
booking violations.

4. Define the lookup code meaning to match the policy violation meaning provided by your
travel partner.

If you receive policy violations in languages other than your base language, you must set up
language-specific text for the lookup code meaning to support policy violations in different
languages.

For example, your company has two booking sites, US and France. Your travel partner provides
policy violations in the regional language, which is French. Both booking sites enforce a policy
violation if the lowest fare isn't selected. If an employee doesn't select the lowest fare, he must
justify the policy violation using the following reason: Needed a direct flight due to time constraints.

To enforce the lowest fare policy for itineraries from both sites during itinerary import, you must
define the policy violation message as the meaning in English, as well as in French.

Itineraries with policy violations that don't exist in the application are tagged as an Unmatched Value
validation error.

Merchant validation
 

1. To add missing merchant codes to merchant reference data, navigate to the Travel
Administration work area.

2. Click the Manage Merchants Codes link.
3. Download the spreadsheet, add new merchants, and upload.

Itineraries with merchants that don't exist in the application are tagged as an Unmatched Value
validation error.

Location validation
  A location validation is performed against the geography data stored centrally in the Oracle Fusion

Applications Trading Community Architecture.

1. To add or change a missing location to reference data, first review the values in the Review
Travel Itinerary Import Results page.

2. Define missing locations in Oracle Fusion Trading Community Architecture.

In the Setup and Maintenance work area, use the following to navigate to the Manage
Geographies page:

◦ Offering: Financials

◦ Task: Manage Geographies

Itineraries with locations that don't exist in the application are tagged as an Unmatched Value
validation error.
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Validation Steps to Enable Validations

Ticket's air class validation
  Validation of a ticket's air class is performed against the EXM_TICKET_CLASS lookup type. You can

configure the lookup type to add new classes of air tickets.

1. To add a missing ticket's air class to reference data, first review the values in the Review
Travel Itinerary Import Results page.

2. In the Setup and Maintenance work area, use the following to navigate to the Manage Travel
Policy Lookup Types page.

◦ Offering: Financials

◦ Task: Manage Travel Policy Lookup Types

3. To add a missing ticket's air class to reference data, create a new lookup code for the lookup
EXM_AIR_CLASS_OF_TICKETS and define the same meaning provided by your travel
partner.

4. If you use a company-defined lookup code for the ticket's air class validation, add the new
code in this lookup.

Itineraries with air ticket classes that don't exist in the application are tagged as an Unmatched
Value validation error.

Currency code and amount
 

Setup isn't required. The currencies from Oracle Fusion General Ledger are used for validation.
 

Date and time
 

Setup isn't required. This is a standard date and time validation.
 

Flight or train number
 

Setup isn't required. The application validates that the flight or train number is present.
 

Note:   For itineraries that fail the validations that you can enable, the application creates trips. The travel
administrator can correct the validation errors and the itineraries as needed.

Resolving Travel Itinerary Import and Validation Issues:
Explained
You run the Import Travel Itineraries process to validate and import travel itineraries from your travel partner into Oracle Fusion
Expenses. When you run the process, the following results may occur:

• The Import Travel Itineraries process completes with an error.

• The Import Travel Itineraries process completes with a warning or success but doesn't import any itineraries.

• The Import Travel Itineraries process completes with a warning.

Import Travel Itineraries Process Completes with an Error
The process completes with an error when:

• It can't establish a connection with your travel partner.

• It encounters an unexpected error.

• The travel partner's portal or booking site is unavailable.
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To identify the error, review the log and output details of the Import Travel Itineraries process by performing the following
steps:

1. Navigate to the Travel Administrator work area.
2. Select the applicable process.
3. From the Action menu, select View Process Details.
4. In the View Process Details dialog box, click the log .txt file.
5. In the View Output Parameters column, click the output file.

Verify that the travel partner integration values described in the following table are set up correctly. Navigation: Setup
and Maintenance work area > Manage Travel Partner Integrations task > Go to Task > Manage Travel Partner
Integrations page.

In the Setup and Maintenance work area, use the following to navigate to the Manage Travel Partner Integrations page.

• Offering: Financials

• Task: Manage Travel Partner Integrations

Invalid Value Log File Error Page

Connection User Name and Password
 

CreateSesssionWS failed with authentication
error.
 

Manage Travel Partner Integration page
 

Super Site Name
 

CreateSesssionWS failed with authentication
error.
 

Manage Travel Partner Integration page
 

Create Session Web Service Definition
Language (WSDL) location
 

CreateSessionWS failed with
InaccessibleWSDLException.
 
An error occurs only when the travel partner
asks you to change a WSDL location and you
enter it incorrectly.
 

Manage Travel Partner Integration page
 

Retrieve Itinerary Locator WSDL location
 

RetrieveItinLocatorWS failed with
InaccessibleWSDLException
 
An error occurs only when the travel partner
asks you to change a WSDL location and you
enter it incorrectly.
 

Manage Travel Partner Integration page
 

Retrieve Itinerary Details WSDL location
 

RetrieveItinDetailWS failed with
InaccessibleWSDLException
 
An error occurs only when the travel partner
asks you to change a WSDL location and you
enter it incorrectly.
 

Manage Travel Partner Integration page
 

Note:  If you see a log file that indicates that the EndSessionWS failed with InaccessibleWSDLException, the
Import Travel Itineraries process won't result in an error even if the End Session WSDL location was updated
incorrectly. These atypical sessions are removed by your travel partner eventually.

If you want to reset the entries in the WSDL fields to the original values, the following table describes the original WSDL
locations.
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Web Service Name Web Service URL

Create Session
 

http: //webservicessabre. com/ wsdl/sabreXML10. 00/ usg/ SessionCreateRQwsdl
 

Retrieve Itinerary Locator
 

http: //webservicessabre. com/ wsdl/sabreXML10. 00/GetThere/GTERP_
TravelItineraryLocatorRead1. 0.0RQ.wsdl
 

Retrieve Itinerary Details
 

http: //webservicessabre. com/ wsdl/sabreXML10. 00/GetThere/GTERP_ TravelItineraryRead1.
0.0RQ.wsdl
 

End Session
 

http: / / webservicessabre com/ wsdl/ sabreXML10 00/ usg/ SessionCloseRQwsdl
 

Tip:  If web service connection issues persist after ruling out set up issues, contact your travel partner's
administrator or your support representative to validate WSDL locations or to determine whether the travel
partner's portal or booking site is down. For other unexpected errors, contact Oracle Support.

Import Travel Itineraries Process Completes with a Warning or Success But
Doesn't Import Itineraries
To review warnings, review the log and output details of the Import Travel Itineraries process by performing the steps
mentioned in the previous section of this topic.

The following table describes the results when the Import Travel Itineraries process completes with a warning or a success
but doesn't import any itineraries.

Invalid Value Result Page

Site Identifier
 

• No errors in the log file.
• The count for new itineraries imported

is zero in the output file.
• The Import Travel Itineraries process

completes with a warning or success.

Create Booking Site page

In the Setup and Maintenance work area,
use the following to navigate to the Manage
Travel Partner Integrations page.

• Offering: Financials
• Task: Manage Travel Partner

Integrations

Import Travel Itineraries Process Completes with a Warning
The Import Travel Itineraries process completes with a warning when:

• Itineraries fail importation

• Itineraries have critical validation errors

• Itineraries have invalid data

• Itineraries have unmatched values

To review warnings, review the log and output details of the Import Travel Itineraries process by performing the steps
mentioned in the previous section of this topic.
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The following table describes the cause and resolution for itinerary import failures.

Log Error Message Cause Resolution

The itinerary could not be imported because
it is missing a value in the Status attribute.
 

• The itinerary status is null. 1. Review the import failure message in
the Itinerary Import Failures dialog
box.

2. The Import Travel Itineraries process
automatically reattempts to import
failed itineraries for a specified number
of user-defined days

3. If itineraries continue to fail, contact
your travel partner's representative to
resolve issues.

The itinerary can't be imported because the
time stamp that indicates whether or not the
itinerary has been modified is invalid.
 

The last modified time stamp on the itinerary
is null.
 

1. Review the import failure message in
the Itinerary Import Failures dialog
box.

2. The Import Travel Itineraries process
automatically reattempts to import
failed itineraries for a specified number
of user-defined days.

3. If itineraries continue to fail, contact
your travel partner's representative to
resolve issues.

Missing message text.
 
The itinerary can't be imported because
it contains a reservation, which was not
reserved and is missing a confirmation
number.
 

Itinerary has a reservation confirmation
number that is null.
 

1. Review the import failure message
in the Itinerary Import Failures dialog
box. The Import Travel Itineraries
process automatically reattempts to
import failed itineraries for a specified
number of user-defined days.

2. If itineraries continue to fail, contact
your travel partner's representative to
resolve issues.

This itinerary can't be imported because the
following error was returned by the itinerary
details web service: {ERROR}.
 

An unexpected error occurs while attempting
to import the details for an itinerary.
 
The Import Travel Itineraries process
continues to import itineraries, even if it
encounters an unexpected error with a
specific itinerary.
 

1. Review the import failure message
on the Itinerary Import Failures dialog
box.

2. The Import Travel Itineraries process
automatically reattempts to import
failed itineraries for a specified number
of user-defined days.

3. If itineraries continue to fail, contact
Oracle Support.

Your request cannot be completed at this
time. Verify your request and try again.
 

Itinerary details can't be retrieved since the
itinerary has multiple travelers.
 

1. Review the import failure message
on the Itinerary Import Failures dialog
box.

2. The Import Travel Itineraries process
automatically reattempts to import
failed itineraries for a specified number
of user-defined days.

3. Your travel partner does not support
itineraries booked for multiple
travelers.
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Errors due to a validation failure are resolved by travel administrators. The following table contains the error, cause, and
resolution of critical validation errors.

Validation Error Cause Resolution

Invalid employee number:

• The employee number is null.
• The employee number doesn't match

the employee number in Oracle Fusion
Human Capital Management.

• The employee's user profile in your
travel partner's site has a null or invalid
employee number.

• The employee number is not sent from
your travel partner.

• The traveler is an applicant and not an
employee.

1. Correct the user profile in your travel
partner's site.

2. From the Travel Administration work
area, navigate to the Resolve Travel
Itinerary Import Errors page.

3. Assign the correct employee to the
itinerary.

Missing reservation pricing information
 

• Your travel partner booking site
allows employees to book a split flight
across two airlines in which pricing is
unavailable.

1. Contact your corporate travel
agency to update the missing pricing
information.

2. From the Travel Administration work
area, open the Review Travel Itinerary
Import Results page to update the
missing pricing information for that
itinerary.

3. To eliminate errors in the future,
consider a configuration change at the
travel booking site to prevent booking
without pricing information.

Unexpected error
 

• The application encountered an
unexpected error while validating an
itinerary.

• The Import Travel Itineraries process
continues to import itineraries, even if
it encounters an unexpected error with
a specific itinerary.

Review the Import Travel Itineraries process
log file by performing the following steps:

1. Navigate to the Travel Administrator
work area.

2. Select the applicable process.
3. From the Action menu, select View

Process Details.
4. In the View Process Details dialog

box, click the log .txt file.
5. If you can't diagnose the error,

contact Oracle Support.

Note:  After itinerary import failures and critical validation errors are resolved, rerun the Import Travel Itineraries
process in the Validate only process mode to remove errors so a trip can be automatically created from itinerary
import.

The following table describes the validation error, cause, and resolution of invalid data validation errors.

Validation Error Cause Resolution

Invalid data
 

• Missing data
• Invalid data format

1. From the Travel Administration work
area, open the Review Travel Itinerary
Import Results page.

2. Correct the errors and rerun the
Import Travel Itineraries process
to revalidate the errors or wait for
the next scheduled Import Travel
Itineraries process to revalidate.
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Validation Error Cause Resolution

3. Contact your travel partner and take
steps to prevent future errors.

The following table describes the validation error type, cause, and resolution of unmatched value validation errors.

Validation Error Cause Resolution

Unmatched values for policy violation.
 

Missing booking policy violation mapping
 

1. Review the values on the Review
Travel Itinerary Import Results page
and select the correct policy violation.

2. To add missing booking
policy violation mapping to
reference data, create a new
lookup code for the lookup
EXM_POL_VIOLATIONS_TYPES and
define the meaning with the booking
policy violation text.

3. To enforce booking policy violation
validation for booking sites set up in a
foreign language, define the booking
policy violation as the lookup code
meaning for the foreign language.

4. If you use a company-defined lookup
type for policy violation validation, add
the new policy violations as lookup
codes for this company-defined
lookup type.

5. If a lookup code for the missing
booking policy violation already exists,
ensure that the lookup code meaning
is defined exactly as the booking
policy violation that is provided by your
travel partner.

Unmatched value for airline, hotel, rail, car
rental code, or name.
 

Missing merchant codes
 

1. Review the values in the Review Travel
Itinerary Import Results page and
select the correct merchant code.

2. To add missing merchant codes to
merchant reference data, navigate to
the Travel Administration work area.

3. Click the Manage Merchants link.
4. Download the spreadsheet, add new

merchants, and upload.

Unmatched value for class of ticket for air
reservation
 

Missing class of air ticket
 

1. Review the values in the Review Travel
Itinerary Import Results page and
select the correct air ticket class.

2. To add a missing class of air ticket
to reference data, create a new
lookup code for the lookup type
EXM_TICKET_CLASS and define the
meaning with the class of air ticket.

3. To enforce class of air ticket validation
for booking sites setup in a foreign
language, define the class of air ticket
as the lookup code meaning for the
foreign language.

4. If you use a company-defined lookup
type for class of air ticket validation,
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Validation Error Cause Resolution

add the new class of air ticket as
lookup codes for this company-
defined lookup type.

5. If a lookup code for the missing class
of air ticket already exists, ensure
that the lookup code meaning is
defined exactly as the class of air
ticket provided by your travel partner.

Unmatched value for location.
 

Missing location
 

1. Review the values in the Review Travel
Itinerary Import Results page and
select the correct location.

2. To add a missing location to reference
data, define missing locations in
Oracle Fusion Trading Community
Architecture that map to the city,
state, and country values sent by your
travel partner.

Navigation: Setup and Maintenance
work area > Manage Geographies
task > Manage Geographies page.

Managing Trip Expense Reports
Watch: This video tutorial shows you how to manage trip expense reports if your company is integrated with GetThere, a
corporate travel service. The content of this video is also covered in text topics.

 

Automatic Trip Expense Reports
Your company can choose whether to automatically or manually create expense reports from business trips. A business trip
is a collection of items that make up an employee's business travel. For example, a trip may include a travel itinerary and a
cash advance. The contents of an automatic trip expense report is based on whether an employee was issued a corporate
card or uses cash only. The application automatically creates a trip expense report if the employee selects the application to
initiate report creation on the Expenses Preferences page.

If an employee was issued a corporate card, the automatic trip expense report contains corporate card transactions.
Expenses attempts to match the travel itinerary reservation with a corporate card transaction.

If an employee doesn't have a corporate card, the automatic trip expense report process creates a report with cash expense
items that correspond to each travel reservation item. Other nontravel cash expenses generated by the employee aren't
included in this trip expense report.

To automate expense reports based on trips, the following people perform these setup tasks:

• The system administrator chooses to automate trip expense reports.

• Each employee selects the timing of the automatic trip expense reports.

https://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:11649
https://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:11649
https://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:11649
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Allow Automatic Trip Expense Reports
If your company chooses to automate expense reports from trips, your implementor selects Yes from the Enable Expense
Report Automatic Creation choice list in the Processing Options for Expense Report section on the Manage System Options
page.

In the Setup and Maintenance work area, use the following to navigate to the Manage System Options page:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Expenses System Options

Select Timing of Automatic Trip Expense Reports
Once your implementor chooses to automate expense reports from business trips, employees can then select whether they
want themselves or Expenses to initiate automatic trip expense reports. Employees specify their preference by selecting
an option in the Expense Report Automatically Created from Trip section. Navigation: User's name choice list > Set
Preferences > Expenses Preferences

The following table describes the timing of the initiation options.

Initiation Option Description

Employee initiates
 

Employee selects a trip on the Trips page in the Expenses work area and clicks Create Report from
Trip or navigates to the Edit Travel Itinerary page.
 

Application initiates upon first
expenditure
 

This option is the default value. The process, Process Trip Expense Report, automatically creates an
expense report when the first corporate card transaction related to a trip is uploaded to Expenses.
 
When the process is subsequently run, the expense report is updated with any new corporate card
transactions that are related to the trip.
 
If a new expense report is needed, the application creates one. For example, the application
generated one expense report, which was submitted for approvals. Any remaining transactions are
added to a new trip expense report.
 

Application initiates upon trip completion
 

The process, Process Trip Expense Report, automatically creates an expense report when a trip is
completed that contains corporate card transactions that are related to the completed trip.
 
When the process is subsequently run, the expense report is updated with any new corporate card
transactions that are related to the trip.
 
If a new expense report is needed, the application creates one. For example, the application
generated one expense report, which was submitted for approvals. Any remaining transactions are
added to a new trip expense report.
 

Tip:  Mobile device users who download corporate card transactions and submit them from their mobile devices
are advised to select the Employee initiates option.
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5  Cash Advances

Cash Advance Approval Rules
Cash advance approval rules are configurable rules for approving cash advances. A cash advance is an advance payment to
an employee that covers out-of-pocket and incidental expenses while traveling or legitimate business expenses.

Oracle Fusion Expenses integrates with Approvals Management Extensions of the Oracle Service-Oriented Architecture (SOA)
suite and Oracle Business Process Management Suite (BPM) to allow deploying companies to build flexible approval routing
rules. This ensures that proper approval authority is enforced.

The BPM Worklist provides an interface to administer the cash advance approval rules based on your company's
business needs. A BPM Worklist administrator, such as a user with the Financial Application Administrator
(FUN_FINANCIAL_APPLICATION_ADMINISTRATOR) role can access the cash advance approval rules in the BPM Worklist.

When you submit a cash advance request, Expenses invokes the cash advance approval process, which in turn invokes a
set of cash advance approval rules created in AMX to build the list of approvers. AMX then sends out approval notifications
to the approvers identified by the cash advance approval rules. This process is repeated until all cash advance approvals are
complete.

The predefined cash advance approval rule routes every cash advance request by an employee to his or her immediate
supervisor for approval. Once the immediate supervisor approves the cash advance request, it is automatically sent to the
expense auditor for final approval.

If you are authorized to manage cash advance approval rules, you can:

• Navigate to the BPM Worklist.

• Modify the predefined cash advance rule.

Navigate to the BPM Worklist
The cash advance approval rules are managed through the BPM Worklist application. Users who are authorized to manage
the cash advance approval rules see an Administration link displayed in the corner of the application.

To create new rules or modify existing rules, click the Administration link, click the Task Configuration tab, click the Data
Driven tab, and then select the FinExmWorkflowCashAdvanceApproval approval flow in the panel. The cash advance
approval flow contains the predefined rule set: Approval by immediate supervisor.

Modify the Predefined Cash Advance Rule
The predefined rule set for approval of cash advances using the supervisory hierarchy is called CashAdvanceApprovalStage:
CashAdvanceApprovalRuleSet. This predefined cash advance rule defines the approval of cash advances of any amounts by
the immediate supervisor.

You can modify the predefined cash advance rule by performing any of the following tasks:

• Modifying the predefined cash advance rule

• Adding new cash advance rules

• Deleting existing cash advance rules
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The following table contains parameters for the predefined CashAdvanceApprovalStage : CashAdvanceApprovalRuleSet rule
set that you can modify to accommodate your cash advance approval needs.

Field Predefined Value Description

List Builder
 

Supervisory
 

This rule set uses the supervisory hierarchy to
retrieve approvers.
 

Response Type
 

Required
 

The approval notification requires a response.
 

Number of Levels
 

1
 

The maximum number of supervisory levels
required for completion of cash advance
approval. You can modify the numbers of
levels required by changing the value. For
example, if you change 1 to 2, two levels of
approvals will be required.
 

Starting Participant
 

HierarchyBuilder.
getManager("supervisory"Task. creator
-1,"","")
 

The first approver in the approval chain.
 

Top Participant
 

HierarchyBuilder.
getPrincipal("FINUSER30"-1"","")
 

The last approver in the approval chain.
 
The approval process does not go beyond
this participant in the approval hierarchy.
 
To use this rule without additional
modification, you must change the
predefined last approver user name to the
last approver name in your organization, cost
center, or department.
 

Auto Action Enabled
 

False
 

This parameter enables or disables the
automatic approval action.
 

Auto Action
 

Null
 

The type of automatic approval action taken,
such as Approve or Reject.
 

The administrator of the cash advance approval rules can perform the following modifications:

• Create additional rules.

For example, you can define new rules to conform to your company's cash advance approval policies.

• Add additional levels of supervisory approval.

For example, if the cash advance amount exceeds the threshold that the administrator configured, the cash advance
request is sent to the next supervisory level for approval.

• Set up automatic cash advance approval.

For example, if the cash advance amount is under a certain amount, then the cash advance is automatically
approved and it does not require the supervisor's approval. This feature expedites the approval process for smaller
amounts, since the need to wait for the supervisor's approval is eliminated.
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To modify an existing cash advance approval rule in the Data Driven configuration page, select the rule set to modify and click
the Edit icon in the Tasks to be configured pane. You can now add, modify, or delete rules within the specified rule set. The
changes take effect when you click the Commit Task icon in the Tasks to be configured pane. Saving changes by clicking the
Save icon saves the changes, but it does not activate them. If needed, you can undo changes by clicking the Reset icon.

Upload a Cash Advance File from a Third-Party System
You can provide cash advance data using a comma-separated plain text .csv file that is uploaded to Oracle Universal Content
Management using the File Import and Export page. After the file is uploaded, the expense auditor runs the Upload Cash
Advance process from the Scheduled Processes page.

Valid cash advance records are created or updated directly into the cash advance tables. Rejected records are listed in the
output file, along with the reason for rejection.

The following table contains fields in the cash advance file that you create in TextPad and upload.

Note:  Each line in TextPad must contain at least 10 elements. If more than 10 elements are used, it's assumed
that the Purpose field contains one or more commas and these extra fields are concatenated.

Field Required Notes Maximum Characters

Cash Advance Number
 

Yes
 

Not applicable
 

60
 

Person Number
 

Yes
 

• Either the person number
or the email must be
provided.

• If both, they must match.
• A valid and active

employee record must
exist.

• When a person has
multiple assignments,
only the current
assignment is used.

120
 

Email
 

Yes
 

• Either the person number
or the email must be
provided.

• If both, they must match.

960
 

Unapplied Amount
 

Yes
 

Not applicable
 

18
 

Status
 

Yes
 

• Status must be either
APPROVAL_COMPLETE
or PAID.

• For a status of PAID,
indicate the unapplied
amount.

30
 

Cash Advance Type
 

Yes
 

Must be one of the existing
lookup codes for the EXM_
CASH_ ADVANCE_TYPE lookup

30
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Field Required Notes Maximum Characters

type. The values are OTHER and
TRAVEL.
 

Due Date
 

No
 

MMDDYYYY
 

8
 

Trip Start Date
 

No
 

MMDDYYYY
 

8
 

Trip End Date
 

No
 

MMDDYYYY
 

8
 

Purpose
 

Yes
 

This last field can contain
commas.
 

240
 

Uploading the Cash Advance File
To upload the cash advance file, follow these steps:

1. Sign in to Expenses as the expense auditor.
2. Navigate to: Navigator > Tools > File Import and Export.
3. On the File Import and Export page, click the Upload (+) icon.
4. In the Upload File dialog box, click Browse to find the file that you want to upload.
5. From the Account choice list, select fin/expenses/import.
6. Click Save and Close .

Running the Upload Cash Advance Process
To run the Upload Cash Advance process, follow these steps:

1. Navigate to: Navigator > Tools > Scheduled Processes.
2. On the Scheduled Processes page, click Schedule New Process.
3. In the Schedule New Process dialog box, select the Job option.
4. From the Name choice list, select Upload Cash Advances and click OK.
5. In the Process Details dialog box in the File Name field, enter the same file name that you uploaded in Step 4 in

the previous task.
6. From the Allow update of existing records choice list, select Yes and click Submit.

If you select Yes, you can update existing cash advances. If you select No, you can't update existing cash
advances. You can only create new cash advances.

Note:  If you select Yes to update an existing record, but the existing cash advance has already been
invoiced, the record is rejected.

7. Click the Refresh icon.

The upload cash advance details appear.
8. Review the .log and .txt files by clicking the attachment links.
9. Sign out as the expense auditor.

10. Sign in to Expenses as an employee.
11. From the Expenses work area, review the Cash Advances infotile.



Oracle Financials Cloud
Implementing Expenses

Chapter 5
Cash Advances

177

How Accounting Entries for Cash Advances Are Distributed
When a cash advance is paid to an employee, the amount to be reclaimed from the employee is tracked in the Cash Advance
Clearing account. Then, when the cash advance is applied to an expense report, the amount is reversed from the clearing
account.

The following table shows an example of a cash advance of 500 USD and an expense report with a total amount of 500 USD.

Document Amount

Cash Advance
 

500 USD
 

Expense Report
 

700 USD
 

Data in the preceding table is used in subsequent sections to illustrate how accounting entries are distributed when each
document is processed.

Setting That Affects Accounting Entries
The setting that affects accounting entries for cash advances is the Cash Advance Clearing account on the Manage
Expenses System Options page. This setting can only be implemented for a business unit.

The clearing account for each cash advance is derived by overlaying the natural account from the Cash Advance Clearing
account on the Default Expense account of the employee.

How Accounting Entries are Distributed
After a cash advance is approved and audited, it is processed to Oracle Payables as a payment request.

The following table summarizes the accounting distribution that is generated when the cash advance is processed in
Payables.

Account Debit Credit

Cash Advance Clearing
 

500 USD
 

Not applicable
 
 

Employee Liability
 

Not applicable
 

500 USD
 

The following table summarizes the accounting distribution that is generated when the cash advance is applied to the
expense report and the expense report is processed in Payables.
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Account Debit Credit

Cash Advance Clearing
 

Not applicable
 

500 USD
 

Employee Liability: Reclaim cash advance
 

500 USD
 

Not applicable
 

Employee Liability: Expense report
 

Not applicable
 

700 USD
 

Expense
 

700 USD
 

Not applicable
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6  Spend Authorizations

Overview of Spend Authorizations
A spend authorization is a request by an employee for approval of estimated expenses for a future activity. A spend
authorization request proceeds through the following process, which the employee initiates:

• Employee submits a spend authorization request

• Manager approves the spend authorization request

• Employee submits an expense report

Employee Submits a Spend Authorization Request
The process for a spend authorization begins when an employee requests authorization for future expenses. The employee
completes the Request Authorization page by clicking the Authorizations infotile on the Oracle Expenses work area. Expenses
tracks all requests by an employee for authorization of future expenses.

Manager Approves the Spend Authorization Request
The employee submits the spend authorization request to his manager for approval. If the manager rejects the request or
requests more information, Expenses returns the request to the employee who takes appropriate action.

Employee Submits an Expense Report
After incurring business expenses, the employee creates and submits an expense report to his manager for approval. When
an approved spend authorization request exists, the employer may require the employee to attach it to the expense report at
either the expense report header or at the lines.

Attaching the spend authorization to the expense report allows managers and expense auditors to compare approved
estimated expenses against incurred expenses. If budgetary control is enabled, the employee may be alerted when he
makes expense report entries that are contrary to a previous authorization. Such violations are visible to the manager and the
expense auditor.

How You Configure Spend Authorization Request Approval
Rules
You can configure approval rules for approval of spend authorization requests. Oracle Business Process
Management Suite (BPM) provides the UI to administer and manage approval rules. A BPM Worklist administrator
can access approval rules in the BPM Worklist if he is assigned the role of Financial Application Administrator
(FUN_FINANCIAL_APPLICATION_ADMINISTRATOR).

When you submit a spend authorization request for approval, Expenses invokes the approval process. The approval process
prompts a set of approval rules created in the BPM Worklist to build the list of approvers. After an approver responds to an
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approval notification, BPM sends an approval notification to the next approver. BPM continues sending approval notifications
to the approvers in the approval hierarchy until all approvals are complete.

To configure or modify spend authorization rules, complete these steps:

1. In the Setup and Maintenance work area, use the following to navigate to the BPM Worklist:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Approval Rules

2. In the BPM Worklist, select the Task Configuration tab.
3. From the Tasks to be configured pane, select FinExmWorkflowSpendAuthorization.
4. Select the Assignees tab.
5. Click the Switch to Vertical Layout link. An approval hierarchy displays.
6. On the Authorization rectangle, click the diamond icon and select Go to rule.

The spend authorization approval flow contains a predefined rule set with its associated approvers as described in the
following table.

Rule Set Approver

SpendAuthorizationRuleSet

• SpendAuthorizationManagerRule

Supervisor

• Approval rule with one level of supervisory hierarchy

SpendAuthorizationRuleSet: Approval by Supervisor
The predefined rule set for approval of spend authorization that uses the supervisory hierarchy is called
SpendAuthorizationRuleSet. The predefined rule is as follows:

Approval by the immediate supervisor of spend authorizations with a total over 0

You can change the predefined rules, delete, or add rules as needed. The following table lists the parameters for the
SpendAuthorizationRuleSet.

Rule Field Predefined Value Description

SpendAuthorizationMan-
agerApprovalRule
 

Condition
 

AuthorizedTotal is same or
greater than 0
 

Attribute that stores the spend
authorization request total in the
reimbursement currency.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

  Response Type
 

Required
 

The approval notification requires
a response.
 

  Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
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Rule Field Predefined Value Description

  Starting Participant
 

HierarchyBuilder. getManager
("supervisory", Task. payload .
ownerUserName-1"","")
 

Person for whom the spend
authorization is requested.
 

  Top Participant
 

HierarchyBuilder. getPrincipa
l("FINUSER30", -1,"","")
 

Last approver in the approval
chain. Approval doesn't go
beyond this participant in a
hierarchy. To use this rule
as is, you must change the
predefined last approver user
name to the last approver in your
organization.
 

Note: This must be
changed to reflect the
last approver in your
organization.

 

  Auto Action Enabled
 

False
 

Automatic approval action is
disabled.
 

  Auto Action
 

Null
 

No automatic approval action.
 

  Rule Name
 

SpendAuthorizationManagerRule
 

Name of rule.
 

Options for Setting Up Spend Authorizations with
Budgetary Control
A spend authorization is a request by an employee for approval of estimated expenses for a future activity. For example, if an
employee plans a business trip, he or she can request approval for anticipated expenses before taking the trip.

When you set up spend authorizations, you can consider these options:

• Enable spend authorizations

• Specify attachment location of spend authorizations

• Define spend authorization behavior

• Specify spend authorization numbering

• Control visibility of spend authorizations

• Enable budgetary control

You can set up spend authorizations for all business units in your organization or you can create exceptions for specific
business units.
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Note:  Before you start, you must first select a business unit in Oracle Expenses on the Authorizations tab of the
Edit Specific Business Unit dialog box. Doing this enables budgetary control to validate anticipated expenses
against a specific budget, ledger, and business unit.

Enable Spend Authorizations
In the Setup and Maintenance work area, use:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Cash Advance and Authorization Policies

To enable spend authorizations on the Manage Cash Advance and Authorization Policies page, select Yes from the Enable
Authorizations choice list.

Specify Attachment Location
You can allow employees to attach an approved spend authorization at the expense report header level or at the expense line
level.

To specify the attachment location of spend authorizations on expense reports, from the Attach Authorization choice list,
select Header Only, Lines Only, or No.

Note:  The Header Only option is only applicable when budgetary control isn't enabled.

Define Spend Authorization Behavior
Depending on your business needs, you can specify the attachment of a spend authorization to an expense report as
optional or required. From the Behavior choice list, select Optional or Required.

Specify Spend Authorization Numbering
You can optionally specify alphanumeric prefixes for spend authorization identification numbers.

To specify a prefix such as SA, that stands for Spend Authorization, enter a value in the Prefix field.

Control Visibility of Spend Authorizations
Approved spend authorizations are visible in the Expenses work area or from the authorization selection choice list for the
number of days you specify in the Visibility in Days field. The default value is 180 days. You can either increase or decrease
the number of days by one or you can enter any positive whole number directly.

Check or Reserve Funds
Depending on your business requirements, you can choose to only check funds or to reserve funds by selecting the Check
funds or Reserve funds option. If you select Check funds, you can decide whether to present a warning to employees if
funds are insufficient to cover an estimated expense. The warning options are Yes or No.
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Enable Budgetary Control
If you want to check funds to determine whether sufficient funds are available for estimated expenses, you must enable
budgetary control. To enable budgetary control in the Setup and Maintenance work area, use:

• Offering: Financials

• Functional Area: Budgetary Control and Encumbrance Accounting

• Task: Manage Budgetary Control

Complete these steps:

1. On the Manage Budgetary Control page, click the applicable business unit.
2. On the Edit Budgetary Control and Encumbrance Accounting page near Budgetary Control, select the Enable

check box.
3. Select Yes from the Enabled choice list for the business function, Expense Management.
4. Click the corresponding Transaction Type Details icon and enable the transaction subtype of Spend authorization

expense item for the transaction type of Spend authorization by selecting Yes.
5. From the Enabled choice list for the business function, Payables Invoicing, select Yes.
6. Click the corresponding Transaction Type Details icon and enable the transaction subtype of Spend authorization

payment request for the transaction type of Invoice by selecting Yes.

Video
Watch: This video tutorial shows you how to request a spend authorization for an upcoming trip. After you return from the trip,
we will create an expense report and attach the approved spend authorization lines to their respective expense items in the
report.

 

Worked Example
In this example, you request a spend authorization for an upcoming trip. After you return from the trip, you will create an
expense report and attach the approved spend authorization lines to their respective expense items in the report.

This topic show you how to:

• Create a spend authorization.

• Approve the spend authorization.

• Create an expense report and attach authorization lines.

• Submit the expense report.

Create a Spend Authorization
To create a spend authorization, complete these steps:

1. Sign in as an employee.
2. Click the House icon

https://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:26261
https://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:26261
https://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:26261
https://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:26261
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3. On the Home page, click Me > Expenses > Travel and Expenses work area.
4. In the Travel and Expenses work area, click the Actions menu.
5. Select the Request Authorization option.
6. On the Request Authorization page in the Purpose field, enter Oracle Open World.
7. From the Expense Location choice list, search and select United States.
8. From the State Date field, enter a date one month from today's date.
9. From the End Date field, enter a date that is four days after the Start Date.

10. Click the Create icon near the Estimated Expenses section.
11. On the Estimate Expense page from the Template choice list, select Travel.
12. From the Type choice list, select Airfare.
13. From the Amount choice list, select USD.
14. In the field near the Amount choice list, enter 650.00.
15. In the Description field, enter Airfare to Oracle Open Word.
16. Click Save and Create Another.
17. On the Estimate Expense page from the Template choice list, select Travel.
18. From the Type choice list, select Meals.
19. From the Amount choice list, select USD.
20. In the field near the Amount field, enter 375.00.
21. In the Description field, enter Meals at Oracle Open World.
22. Click Save and Create Another.
23. On the Estimate Expense page from the Template choice list, select Travel.
24. From the Type choice list, select Hotel.
25. From the Amount choice list, select USD.
26. In the field near the Amount choice list, enter 800.00.
27. In the Description field, enter Accommodations at Oracle Open World.
28. Click Save and Close.
29. On the Authorization page, click Submit.

Approve the Spend Authorization
To approve the spend authorization as the manager, complete these steps:

1. Sign out as an employee.
2. Sign in as a manager.
3. On the springboard, click the Bell icon.
4. From the Notifications choice list, select Pending Notifications.
5. Locate the spend authorization you just created and click the Action Required: Authorization Approval link.
6. On the approval form for the spend authorization, click Approve.
7. In the Approve dialog box, enter the following in the Comment field: I approve this spend authorization request for

the trip to Oracle Open World.
8. Click Submit.
9. Click Approve.

10. Sign out as a manager.
11. Sign in as an employee.
12. In the Travel and Expenses work area, click the Authorizations infotile.
13. Click the Approved link on the Authorizations infotile.
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Create an Expense Report and Attach Authorization Lines
To create the expense report and attach authorization lines to the expense items, complete these steps:

1. In the Travel and Expenses work area, click the Expense Reports infotile.
2. Click the Create icon.
3. On the Create Expense Report page in the Purpose field, enter Attended Oracle Open World.
4. Click Save.
5. Click Create Item near the Expense Items section.
6. On the Create Expense Item page from the Template choice list, select Travel.
7. From the Type choice list, select Airfare.
8. From the Expense Location choice list, search and select United States.
9. Click OK.

10. From the Amount choice list, select USD.
11. In the field near the Amount choice list, enter 650.00.
12. In the Description field, enter Airfare to Oracle Open World.
13. Click the Attach icon near Authorization.
14. In the Select Estimated Expense dialog box from the Authorization choice list, select the authorization you created.
15. Select the Airfare authorization line.
16. Click the OK.
17. On the Create Expense Item page, click Create Another.
18. On the Create Expense Item page from the Template choice list, select Travel.
19. From the Type choice list, select Meals.
20. From the Expense Location choice list, search and select United States.
21. From the Amount choice list, select USD.
22. In the field near the Amount choice list, enter 110.00.
23. In the Description field, enter Meals at Oracle Open World.
24. Click the Attach icon near Authorization.
25. In the Select Estimated Expense dialog box from the Authorization choice list, select the authorization you created.
26. Select the Meals authorization line.
27. Click OK.
28. On the Create Expense Item page, click Create Another.
29. On the Create Expense Item page from the Template choice list, select Travel.
30. From the Type choice list, select Hotel.
31. From the Expense Location choice list, select United States.
32. From the Amount choice list, select USD.
33. In the field near the Amount choice list, enter 800.00.
34. In the Description field, enter Hotel stay at Oracle Open World.
35. In the Itemization section, enter these values:

Field Name Entry

Type choice list
 

Room Charge
 

Daily Amount
 

200.00
 

Days
 

4
 

Amount
 

800.00
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36. In the Itemization section, click the Attachment icon near Authorization.
37. On the Select Estimated Expense dialog box from the Authorization choice list, select the authorization you created.
38. Select the Hotel authorization line.
39. Click OK.
40. Click Save and Close.

Submit the Expense Report
1. On the Expense Report page, select the I have read and accept the corporate travel and expense policies

check box.
2. Click Submit.
3. In the warning that indicates one or more required imaged receipts are not attached, click Yes.

How Budgetary Control and Spend Authorizations Work
Together
If your organization requires the ability to track and control expenditures against a budget, you can enable Oracle Budgetary
Control. This is especially helpful for public sector and commercial organizations that require:

• Visibility into budget commitments and expenditures

• Adherence to legal requirements

• Control of excessive spending

• Approval of anticipated expenses

• Validation of anticipated expenses against a specific budget for an applicable ledger and business unit

To support this requirement, Expenses integrates with Budgetary Control. The process begins when an employee creates
and submits a spend authorization for approval. The approving manager checks whether funds are available against the
budget and optionally views the results. When the manager approves the spend authorization, funds are automatically
reserved. After the employee incurs expenses, he or she creates an expense report and attaches the approved spend
authorization estimated lines to it. After the manager approves the expense report, it's processed for reimbursement, which
results in a payment request. The payment request generates an invoice, which is validated, and subsequently the employee
or the card issuer is paid.
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This diagram shows how the spend authorization and the budgetary control process work together to control excessive
spending.
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Effects of Enabling Budgetary Control
When your company enables budgetary control, these actions are available:

• When an employee submits a spend authorization for approval, Budgetary Control evaluates whether funds are
available for the anticipated expenses for a specific business unit, ledger, and budget date.

• The status of the funds check is visible to the approving manager.

• The approving manager can recheck funds and view results directly from the authorization approval notification.

• After the manager approves a spend authorization, funds are reserved automatically.

• After the employee incurs expenses, he or she can associate the approved spend authorization with the actual
expenses and submit the expense report for approval.
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7  Image Processing

How Receipt Images Are Processed
To ensure the validity of employee expenses, companies often require their employees to submit receipts for their expenses.
Organizations vary in their receipt submission requirements. Common methods of receipt submission include faxing or
emailing receipts to accounts payables. You can enable receipt of expense-related images by fax, email, or from a file
location on a server. Oracle Expenses Cloud integrates with Oracle WebCenter Imaging and Oracle WebCenter Capture. This
integration enables automatic attachment of receipt images to their respective expense reports.

Note:  When you configure the application to require receipt images before manager approval, the expense
reports aren't routed for approval until receipts are received. That is, Oracle WebCenter Imaging calls the
approval process after the receipt images are received.

Before you can properly configure the application with Oracle WebCenter Imaging and Oracle WebCenter Capture to process
receipt images, you must first understand the receipt image process.

Note:  Expenses Cloud accepts images only through email. Fax isn't supported with Expenses Cloud.

The following figure illustrates the receipt image process.
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How Receipt Images Are Processed
Receipt images are processed in the following stages:

• Oracle WebCenter Capture receives receipt images.

• Oracle WebCenter Capture processes the receipt image file to identify the expense report identifier.
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• Oracle WebCenter Imaging retrieves images for further processing and calls the Add Attachment to Expense Report
service.

You can send receipt images to Oracle WebCenter Capture by fax, email, or by uploading receipt image files to a folder
location that is accessible by Oracle WebCenter Capture. You can upload receipt image files to a specific location manually or
by using a File Transfer Protocol (FTP) process.

Oracle WebCenter Capture checks for receipt image files in predefined folders for each method of delivery. It scans the
receipt image file for a barcode, derives the expense report identifier, and creates a text file for each receipt image file. The
receipt image files and corresponding text files are transferred by Oracle WebCenter Capture to a predefined folder that is
accessible by Oracle WebCenter Imaging.

Note:  You must print the printable expense report page and fax or email it as the first page of your receipt
images. The first page of the receipt image file must be the printable expense report page with the barcode.
Otherwise Oracle WebCenter Capture can't accurately process the receipt image file.

Oracle WebCenter Imaging scans the predefined folder for receipt image files and the corresponding text files with expense
report identifiers for attachment to expense reports. Oracle WebCenter Imaging then stores the receipt image file in the
Universal Content Management server. It then passes the location address of the receipt image file in Universal Content
Management to the Add Attachment to Expense Report service. The Add Attachment to Expense Report service creates the
attachments for the expense report in the attachments tables in Oracle Applications Cloud.

How Receipt Image-Processing Components Work
Together
Oracle Expenses Cloud uses Oracle WebCenter Capture and Oracle WebCenter Imaging to receive and process receipt
image files. Using these services, the application can automatically attach receipts to expense reports and users can navigate
to the Expenses work area to view expense report attachments. To store the receipt images, Oracle WebCenter Imaging
uses Universal Content Management.

Note:  Setup is applicable only for Expenses On-Premises implementations. For Expenses Cloud, setup is
predefined.

The following figure illustrates the Oracle WebCenter Capture components that affect receipt image processing.

Note:  Expenses Cloud accepts images only through email. Fax isn't supported with Expenses Cloud.
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To Oracle WebCenter Imaging

The following figure illustrates the Oracle WebCenter Imaging components that affect receipt image processing.
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Oracle WebCenter Capture
The receipt images sent to Oracle WebCenter Capture by fax, email, or uploaded to a folder location, whether manually or
automatically, are received by components called providers. For each method of receipt image delivery, a corresponding
provider receives the image. The following types of providers support the methods of receipt image delivery:

• The fax provider receives images sent to Oracle WebCenter Capture by fax.

• The email provider receives images sent to Oracle WebCenter Capture by email.

• The FTP provider receives images sent to a file location that is accessible by Oracle WebCenter Capture.

• The folder provider receives images manually uploaded to a file location that is accessible by Oracle WebCenter
Capture.

Your company must configure the necessary providers to support the delivery methods that are applicable to its business.
For detailed information about configuring providers, see the Oracle WebCenter Capture User's Guide.

Oracle WebCenter Capture is composed of the following components that receive and process image files:

• Providers

• Import server:

◦ Imports documents from providers

◦ Looks for images on a scheduled frequency

◦ Retrieves and stores receipt images in a folder
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• Recognition server:

◦ Checks for images

◦ Parses the barcode in the receipt image file to derive the expense report identifier

Note:  If there are multiple receipt image files with the same barcode number, Oracle WebCenter Capture
creates a single metadata file. This single receipt image file can contain multiple pages of receipt images.

• Commit server:

◦ Creates the metadata file with the extension .exmdat, which contains the expense report identifier and the
image location

◦ Transfers receipt image and metadata files to the commit folder that Oracle WebCenter Imaging accesses to
look for receipt image files that are waiting to be processed

Oracle Image Processing and Management
Oracle WebCenter Imaging uses one component, the input agent directory, to process receipt image files. The input agent
directory is the location where Oracle WebCenter Imaging scans for receipt images and the metadata files to process. This
directory and the Oracle WebCenter Capture commit folder point to the same storage host, which is configured at the time of
deployment.

Oracle WebCenter Imaging is configured to retrieve files from the input agent directory and checks the directory periodically
for new files. Based on the configuration in the input definition Expense Reports Input, Oracle WebCenter Imaging recognizes
the files by the file name mask *.exmdat. The metadata file contains two fields: Full File Path and Expense Report
Identifier separated by a delimiter. Oracle WebCenter Imaging uses the "|" delimiter to derive the two fields from the
metadata file.

Oracle WebCenter Imaging retrieves the receipt image files from the input agent directory and stores it in Universal
Content Management. Oracle WebCenter Imaging then initiates the Add Attachment to Expense Report service defined
in the workflow configuration to attach the receipt image to the expense report. It does this by creating an entry in the
FND_ATTACHMENTS table. The attachment record stores the URL to the Universal Content Management location of the
attachment. If the expense report hasn't been submitted for approval, the Add Attachment to Expense Report service initiates
the expense report approval process.

Add Attachment to Expense Report Service
The application provides the Add Attachment to Expense Report service to attach receipt images to expense reports and
optionally initiate approval processing. This service is defined in the Workflow Configuration region of Oracle WebCenter
Imaging. The Add Attachment to Expense Report service creates an entry in the FND_ATTACHMENTS table to the Universal
Content Management location where the image is stored. This service also initiates the approval process for expense reports
that require approval.

Expenses Work Area
When receipt images are attached to an expense report, you can view and annotate the receipt images in the Expenses work
area.
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How Setup Components That Affect Receipt Image
Processing Work Together
Setups in Oracle Expenses Cloud, Oracle WebCenter Imaging, and Oracle WebCenter Capture affect receipt image
processing.

Note:  Setup is applicable only for Expenses On-Premises implementations. For Expenses Cloud, setup is
predefined.

The following figure shows the Oracle WebCenter Capture components that affect receipt image processing.
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The following figure shows the Oracle WebCenter Imaging components that affect receipt image processing.
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Setting Up the Application to Wait for Receipts
If your company requires receipts to be submitted before managerial approval of expense reports, you can set up the
application to do so. Set Receipts Required Before Approval to Yes on the Manage Expenses System Options page.
Then, expense reports are not submitted for approval until receipts are received.

To enable barcode printing on the report's printable page, set the Display Bar Code to Yes on the Manage Expenses System
Options page.

Setting Up Oracle WebCenter Imaging for Integration with the Application
During the deployment of Oracle Applications Cloud, Oracle WebCenter Imaging is automatically installed at your company
with the configuration required for integrating with the application. You can access the configuration details for the application
by signing in Oracle WebCenter Imaging as a user with the FUN_FINANCIAL_APPLICATION_ADMINISTRATOR role.

The Oracle WebCenter Imaging configuration that is pertinent for the application includes the following:

• Application definition

• Input definition

• Search definition

The application definition captures application security, document security, field definition of the parameters required
for Oracle WebCenter Imaging to process the images, and the workflow configuration. The application definition for the
application is called Expense Reports Application. This application definition contains the packaged configuration for Oracle
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WebCenter Imaging to integrate with the application. The following table describes the application details predefined for the
Expense Reports Application.

Region Component Details

Application Security
 

Not applicable
 

Application security captures the roles, also
called security groups, that can access
the application definition and modify the
details. By default, the FUN_ FINANCIAL_
APPLICATION_ ADMINISTRATOR role
is given access to the Expense Reports
Application definition.
 

Document Security
 

Roles
  By default, the following two roles are given

access to view receipt images.

• EXM_AUDITOR job role. During
expense report auditing, auditors are
required to verify receipt images to
ensure the validity of the expenses.

• PER_EMPLOYEE_ABSTRACT
abstract role. This role is given
document access to enable all
employees to access receipt images
from their expense reports in the
application. When the receipt image is
called from the application, Universal
Content Management checks whether
the role accessing the document has
the necessary privileges in Oracle
WebCenter Imaging. The document
is displayed in the application only if
the user has sufficient privileges. At
a minimum, an employee must have
view, write, and delete access.

Document Security
 

Document Access
 

In addition to view, write, and delete, Oracle
WebCenter Imaging allows users to annotate
the image. To annotate, users must have
one of the following for document access:
Annotate Standard or Annotate Restricted.
Users with Annotate Restricted access can
create annotations that can be hidden from
users without Annotate Restricted access.
 

Workflow Configuration
 

Not applicable
 

Workflow configuration stores the details of
the service initiated by Oracle WebCenter
Imaging that attaches the receipt images to
expense reports using the expense report
identifier. This service also initiates the
expense report approval flow if the expense
report must be approved after the receipt of
images.
 

The input definition captures the folder location where Oracle WebCenter Imaging scans for receipt images and the format of
the metadata file accompanying the receipt image. The input definition for the application, called Expense Reports Input, is
created during deployment and contains the details described in the following table.
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Region Description

File Parameters
 

The File Parameters region stores the metadata file extension, delimiter used in the metadata
file, and the sample file. Sample values are provided for the input mask and delimiter. In Oracle
WebCenter Imaging, this step is called Review Sample File.
 
You can change the mask and the delimiter to suit your business needs. If you change the data in
this step, you must change the mask and the delimiter in Oracle WebCenter Imaging.
 

Field Mapping
  The Field Mapping section maps the fields that are defined in the Field Definition section by the

Application Summary page to the metadata file contents. The mapped fields include the Full File
Path and the Expense Report ID.

Input Security
 

The Input Security region defines who can modify the input definition. By default, the FUN_
FINANCIAL_ APPLICATIONS_ ADMINISTRATOR role is given access to modify the input definition.
 

The search definition stores the roles that are given access to search for documents by logging directly into Oracle
WebCenter Imaging.

Note:  No manual configuration is required for Oracle WebCenter Imaging. Oracle WebCenter Imaging's input
folder points to a storage host, which is configured during Oracle WebCenter Imaging deployment.

Setting Up Oracle WebCenter Capture for Integration with the Application
Your company must manually install Oracle WebCenter Capture on a Windows computer. Oracle WebCenter Capture
provides the packaged configuration for uploading receipt images to a folder for processing. Manual changes to the
packaged configuration are required, however, to tailor Oracle WebCenter Capture to meet your company's specific needs.

To facilitate receipt image processing, you must set up an Oracle WebCenter Capture file cabinet. The packaged file cabinet
for the application is called Expense Reports. The configuration for the commit server, which it uses to create and save the
metadata file, is called Expense Reports Commit Text. During the Oracle WebCenter Capture file cabinet setup, you define
the following:

• Mapping of relevant information in Oracle WebCenter Capture to Oracle WebCenter Imaging

• Location of the folder where processed receipt images and corresponding metadata files are stored

The following table contains the information you must capture during Oracle WebCenter Capture setup.

File Cabinet Setup Field Predefined Value Additional Information

File Cabinet Index Fields
 

Expense Report ID
 

The field in the metadata file that
stores the value of the parsed
barcode.
 

Delimiter
 

The delimiter character that
separates the data in the
metadata file. The delimiter is "|".
 

Oracle WebCenter Imaging
Dest1
 

Oracle WebCenter Imaging
Dest1 to Oracle WebCenter
Imaging Dest4 store the absolute
path to the location of the folder
where image files and metadata
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File Cabinet Setup Field Predefined Value Additional Information

files are stored for processing
by Oracle WebCenter Imaging.
These four fields are defined to
accommodate folder locations
that exceed the length limit. The
location of the folder is derived
as Oracle WebCenter Imaging
Dest1|| Oracle WebCenter
Imaging Dest2 || Oracle
WebCenter Imaging Dest3 ||
Oracle WebCenter Imaging
Dest4.
 
Deploying company must
change the value to reflect the
destination folder in its system.
 

Oracle WebCenter Imaging
Dest2
 

Deploying company must
change the value to reflect the
destination folder in its system.
 

Oracle WebCenter Imaging
Dest3
 

Deploying company must
change the value to reflect the
destination folder in its system.
 

Oracle WebCenter Imaging
Dest4
 

Deploying company must
change the value to reflect the
destination folder in its system.
 

Commit Profile/ Commit Driver
Configuration/ General/ Text File
Folder
 

Do Not Create Commit Text File
 

Unchecked
 

Export Folder
 

Example: C:\Oracle WebCenter
Capture Projects\Expenses
\Export
 

The folder where metadata files
are stored by Oracle WebCenter
Capture after processing.
 
Deploying company must
change the value to reflect the
export folder in its system.
 

File Extension
 

exmdat
 

Commit Profile/ Commit
Driver Configuration/ General/
Document Folder
 

Export Folder
 

Example: C:\Oracle WebCenter
Capture Projects\Expenses
\Export
 

The folder where images are
stored by Oracle WebCenter
Capture after processing.
 
Deploying company must
change the value to reflect the
export folder in its system.
 

Create a Folder per Committed
Batch
 

Unchecked
 

Formatting
 

Field Delimiter
 

None
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File Cabinet Setup Field Predefined Value Additional Information

Fields to Include
 

Oracle WebCenter Imaging
Dest1
 
Oracle WebCenter Imaging
Dest2
 
Oracle WebCenter Imaging
Dest3
 
Oracle WebCenter Imaging
Dest4
 
File Name Relative Path
 
Delimiter
 
Expense Report ID
 

The details written into the
metadata file and the format.
This includes the full file path of
the processed image file and
the expense report identifier
separated by the delimiter.
 
For example, the resulting entry
in the image file looks like: / slot/
ems7795/ appmgr/ provisioning/
mwhome/ instance/ domains/
machine/ visioncorporation/
com/ CommonDomain/ Oracle
WebCenter Imaging/ InputAgent/
Input/ 100000012512081TIF|
100000012512081
 

Document File Naming
 

Name Document Based on
Index Values
 

Checked
 

Selected Fields
 

Expense Report ID
 

These two fields rename the
receipt image file.
 

Batch ID
 

Batch ID of the process. The
image file when received by
Oracle WebCenter Capture is
renamed to Expense Report ID
- Batch ID to ensure uniqueness
of receipt image file name.
 

Document Output Format
 

TIFF - Multiple Page
 

The import server setup defines the details required for the different providers, such as the email provider and the folder
provider that deliver receipt images. The email provider does not support SSL connections.

Email provider and folder provider sample configurations are included with Oracle WebCenter Capture. If you plan to receive
images through fax or FTP, you must configure the settings for the fax provider or the FTP provider respectively.

The following table contains the information you must capture during the import server setup.

Import Server Setup Field Predefined Value Additional Information

email Provider
 

Batch Job Settings/Job for email
Provider/ General
 

File Cabinet
 

Expense Reports
 

Name of the file cabinet setup.
 

Batch Prefix
 

EXM-EM
 

Log File Path
 

Enter the local directory path for
the log file.
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Import Server Setup Field Predefined Value Additional Information

Example: C:\Program Files
\Oracle\Document Capture
\Logs.
 

Processing
 

If Invalid Page Found or Time
Out Occurs
 

Abort batch
 

Import Output
 

Retain Native Image Format
 

Yes
 

Example: expense_
receipts@vision. com.
 

email Provider Settings
 

email Accounts
 

Example: expense_ receipts at
Vision.com.
 
Deploying company must
change the value to reflect the
email accounts in its system.
 

email Provider Settings/ email
Filters/ Attachment Processing
 

Include Attachments Matching
the Following Mask(s)
 

*.TIF
 
*.DOC
 
*.PDF
 

email Provider Settings/ email
Filters/Post Processing
 

Upon Successful Import
 

Delete Messages
 

Upon Failed Import
 

Don't Delete Message
 

Folder Provider
 

Batch Job Settings/Job for
Folder Provider/ General
 

File Cabinet
 

Expense Reports
 

Name of the file cabinet setup.
 

Batch Prefix
 

EXM-FD
 

Log File Path
 

Enter the local directory path for
the log file.
 
Example: C:\Program Files
\Oracle\Document Capture
\Logs.
 

Processing
 

If Invalid Page Found or Time
Out Occurs
 

Abort batch
 

Import Output
 

Retain Native Image Format
 

Yes
 

Folder Provider Settings
 

Import Folder
 

Enter the local directory path for
the import folder.
 



Oracle Financials Cloud
Implementing Expenses

Chapter 7
Image Processing

201

Import Server Setup Field Predefined Value Additional Information

This is the location where the
folder provider receives receipt
images.
 

File Mask
 

Expenses*
 

Create a New Batch
 

For Each File
 

After Import/ Add Prefix to Image
File Name
 

Checked
 

Prefix
 

Processed
 

Server/ Scheduler
 

Schedule Event
 

Folder/List File Provider -
Expense Reports
 

Deploying company must
change the value to reflect the
scheduled event in its system.
 

Frequency
 

Every 30 seconds
 

Deploying company must
change the value to reflect the
frequency in its system.
 

The recognition server setup defines the details required for the recognition server component of Oracle WebCenter Capture
to derive relevant details from receipt image files.

The following table contains the information you must capture during the recognition server setup.

Recognition Server Setup Field Predefined Value Additional Information

Batch Job Settings/ General
 

Batch Job Name
 

Expense Reports
 

File Cabinet
 

Expense Reports
 

Name of the file cabinet setup.
 

Batch Prefix
 

EXM
 

Log File Path
 

Enter the local directory path for
the log file.
 

Use Commit Server
 

Checked
 

If Pages Remain After
Processing, Notify by email
 

Enter the email ID to be notified if
an error occurs while processing
a batch.
 

Batch Job Settings/ Processing
 

Each Batch Consists of
 

One Document Only
 

Pages to Read Barcodes
 

1
 

Document Separation Bar Code Expense Report ID
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Recognition Server Setup Field Predefined Value Additional Information

     

Clear All Index Values
 

Checked
 

Keep Document Separator
 

Checked
 

Bar Code Recognition
 

Auto Detect
 

Code 128
 

Deploying company must
change the value to reflect the
auto detect in its system if the
barcode is generated using
another code.
 

Number of Bar Code to Detect
 

Limit to 1
 

Bar Code
 

Bar Code Definition
 

Expense Report ID
 

Fields/ Delimiter
 

Auto Populate with
 

Default of "/"
 

Fields
 

Expense Report ID
 

Required
 

Auto Populate With
 

Bar Code
 

Description
 

Expense Report ID
 

Fields/Oracle WebCenter
Imaging Dest1
 

Auto Populate with
 

Oracle WebCenter Imaging
Dest1
 
Oracle WebCenter Imaging
Dest2
 
Oracle WebCenter Imaging
Dest3
 
Oracle WebCenter Imaging
Dest4
 

This is the folder where Oracle
WebCenter Capture posts
images and metadata files
for processing by Oracle
WebCenter Imaging. Due to
length limitation, four fields are
available to enter the partial
absolute path information that,
when concatenated, gives the
complete absolute path.
 
If the file path is long, enter
partial paths in all four fields.
If you don't need four fields to
enter the complete path, you
can leave the remaining fields
in Oracle WebCenter Imaging
Dest<n>blank.
 
Deploying company must
change the value to reflect the
destination folder in its system.
 

Server/ Scheduler
 

Schedule Event
 

Expense Reports
 

Deploying company must select
the applicable file cabinet.
 

Frequency
 

Every 30 seconds
 

Deploying company must
change the value to reflect the
frequency in its system.
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The commit server setup defines the details to transfer the receipt image files and the metadata files to a location accessible
to Oracle WebCenter Imaging for processing.

The following table contains the information you must capture during the commit server setup.

Commit Server Setup Field Predefined Value Additional Information

Batch Job Settings/ General
 

File Cabinet
 

Expense Reports
 

Batch Criteria
 

Process Specific Batches with
Prefix
 

EXM
 

Batch Status
 

All
 

Processing Order
 

Sort Before Commit
 
Order by Batch Name Ascending
 

Server/ Scheduler
 

Schedule Event
 

Expense Reports
 

Deploying company must select
the applicable file cabinet.
 

Frequency
 

Every 30 seconds
 

Deploying company must
change the value to reflect the
frequency in its system.
 

Server
 

Activate
 

Related Topics

• Why do I have to configure the barcode font mapping
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8  Expense Reimbursements

How Third-Party Expense Reimbursements Are Processed
Expense reports can be reimbursed through Oracle Fusion Payables or any legacy or third-party application. If you
want to issue expense reimbursements through a legacy or third-party application, you can use the third-party expense
reimbursement process.

Settings That Affect Third-Party Expense Reimbursements
On the Manage Expenses System Options page, you can use the Pay Expense Reports Through option to choose one of
the following for expense reimbursement:

• Payables

• Third-party application

A third-party application may be a legacy application within your company or an outside supplier.

How Third-Party Expense Reimbursements Are Processed
The following diagram illustrates the export of expense report data from Oracle Fusion Expenses to a legacy or third-
party application, the issuance of reimbursement payments by the legacy or third-party application, and the import of
reimbursement payment data back to Expenses.

The following figure illustrates the export of expense report data from Oracle Fusion Expenses to a legacy or third-
party application, the issuance of reimbursement payments by the legacy or third-party application, and the import of
reimbursement payment data back to Expenses.
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The following table describes the flow of expense report data when you use a legacy or third-party expense report
reimbursement application.

Sequence Action Result

1.
 

In Expenses, employees create expense
reports, which are approved, and audited.
 

Expense reports are eligible for
reimbursement.
 

2.
  In Expenses, you can schedule the following

processes to automatically export the
expense report data from Expenses to your
legacy or third-party application in .xml
format:

• Process Expense Reimbursements
and Cash Advances

• Create Card Issuer Invoices

The exported expense report data files
contain all the information necessary to issue
payments and record accounting entries in
your legacy or third-party application. The
Expenses processes automatically export
expense report data from Expenses to the
following locations:

• Universal Content ManagerNavigator
> Tools > File Import and Export
link.

• Search Results section on the
Scheduled Processes page:
Navigator > Tools > Scheduled
Processes.

UCM facilitates easy tracking and download
of expense report data files.

3.
  From the fin/expenses/export directory,

you can download the expense report data
files in .xml format and transfer them to your
legacy or third-party application.

Your legacy or third-party application
processes the expense report data files.
 

4.
  Your legacy or third-party application issues

expense report reimbursement payments to:

• Employees
• Credit card issuers

Employees and credit card issuers receive
payments.
 

5
  To transfer reimbursement payment

data from your legacy or third-party
application, you upload your expense report
reimbursement data to the fin/expenses/
import directory.

Expense report reimbursement information
transfers from the legacy or third-party
application back to Expenses in a
specific .xml format with a .txt or .xml
extension.
 
The specific .xml format depends on the
expense report payment option selected
by your company for corporate card
transactions and whether the data file is for
cash advances.
 

6
 

From Expenses, you schedule the Update
Expense Report Status process.
 

The Update Expense Report Status process
automatically:

• Updates the expense reports in
Expenses as paid
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Sequence Action Result

• Provides legacy or third-party
reimbursement references in the paid
expense reports

Expense Report Data Flow Using a Third-Party Application
If you use a legacy or third-party application to process expense report reimbursements, you can export expense report XML
data files from Oracle Fusion Expenses and use them to process data in your legacy or third-party application. After your
legacy or third-party application processes reimbursement payments, you can import the reimbursement payment XML data
files back to Expenses.

Expense Report XML Data Exported to Universal Content Manager
To create expense report XML data files for export to a legacy or third-party application, schedule the following automatic
processes in Expenses using Navigator > Tools > Scheduled Processes:

• Process Expense Reimbursements and Cash Advances

• Create Card Issuer Invoices

The resulting XML expense report data files are available from the Search Results section on the Scheduled Processes page
or you can download them from Universal Content Manager (UCM) at fin/expenses/export directory using Navigator >
Tools > File Import and Export link.
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The following figure shows an example of an expense report XML data file format that is automatically created when an
expense report containing cash expense items is processed by the Process Expense Reimbursements and Cash Advances
process.

Note:  Expense report data files that contain corporate card expenses for Company Pay or Both Pay payment
options have a different XML format structure than the preceding example. Similarly, expense report data files for
cash advances also contain a different XML format structure.
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Expense Report Reimbursement XML Data Imported Into Universal
Content Manager
To transfer expense report reimbursement data from a legacy or third-party application back to Expenses, the data must
appear in XML format. Upload the correctly formatted XML reimbursement payment data files to UCM at fin/expenses/
import directory.

Tip:  For optimal file handling, the best practice is to use the following naming convention for reimbursement
payment data files: MM-DD-YYYY HH-MM ExmPaymentExtract.

Caution:  The XML files you upload to UCM must be in precisely the same structure as shown in the following
figure.
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9  Mobile Devices

Disable the Scan Option on Mobile Expenses
You can disable the Scan option on the Expenses mobile application by configuring a profile option.

You must have one of the following roles to disable the Scan option:

• Application Implementation Consultant

• Financial Administrator

• Expense Manager

Defining the Profile Option
To disable the Scan option, define the profile option, EXM_MOBILE_DISABLE_SCAN, and set the profile option value to Yes.

To define the profile option, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Profile Options

2. On the Manage Profile Options page, click the Create (+) icon.
3. On the Create Profile Option page in the Profile Option Code field, enter EXM_MOBILE_DISABLE_SCAN.
4. In the Profile Display Name field, enter a profile display name.
5. From the Application choice list, select Expenses.
6. From the Module choice list, select Expenses.
7. From the Start Date field, enter a start date.
8. Click Save and Close.
9. On the Manage Profile Options page in the Profile Options Levels section, select Site as the Level value.

10. Select both the Enabled and the Updatable check boxes.
11. Click Save and Close.

Defining the Profile Option Value
To define the profile option value, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page in the Search: Profile Option section, enter
EXM_MOBILE_DISABLE_SCAN in the Profile Option Code field.

3. Click Search.
4. In the Search Results: Profile Options section, select the profile option you created.
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5. In the Profile Values section, click the Create (+) icon.
6. From the Profile Level choice list, select Site.
7. From the Profile Value choice list, select Y.
8. Click Save and Close.
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Glossary

barcode

A printable barcode that uniquely identifies each employee's expense report.

both pay

The deploying company pays the corporate card issuer for business expenses and the employee pays the corporate card
issuer for personal expenses.

card feed file

A file containing corporate card transactions that originated from the card issuer's server.

company pay

The deploying company pays the corporate card issuer for all transactions.

corporate card issuer

A bank that issues corporate cards.

corporate card program

An agreement between the corporate card issuer and the deploying company that governs the issuance of corporate cards
to the deploying company's employees and the payments to the card issuer.

eFolio

Summary corporate card transactions. Also known as Level 2 transactions.

error amount

When setting up corporate card usage policies to enforce the use of corporate cards, an amount that exceeds the cash limit
and for which an error displays during expense entry in the expense report, which prevents submission of the report.

error tolerance

When setting up corporate card usage policies to enforce the use of corporate cards, a range that is from the cash limit up to
the error tolerance amount. Over that amount, the expense report is not submitted.

error tolerance percentage

When setting up corporate card usage policies to enforce the use of corporate cards, a percentage that, when added to the
cash limit, defines the error amount. If you spend more than the error amount, the expense report is not submitted.

expense template

An administrator-defined list of related expense types. When you enter expenses on your expense report, you must select a
specific expense template.
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expense type

A potential expense that you can incur that has been defined by the administrator during setup.

FTP

Acronym for File Transfer Protocol. A system for transferring computer files, generally by the Internet.

individual pay

The employee pays the corporate card issuer for all corporate card transactions.

Level 2

Summary corporate card transactions. Also known as eFolio.

Level 3

Detailed corporate card transactions.

merchant category code

A four-digit code that identifies the industry in which the deploying company operates.

MIS industry code

A code provided by the card issuer that identifies the type of transaction.

payment method

Indicates the method of payment, such as check, cash, or credit.

payment request

A grouping of documents payable for which payment is requested. A payment request specifies the template to use in Oracle
Fusion Payables, selects invoices for a pay run, and groups the invoices into payments based on setup rules.

SIC code

A Standard Industrial Classification code, which represents a United States government system for classifying industries by a
four-digit code.

transaction codes

Codes that the card issuer assigns to corporate card transactions in the corporate card feed file.

warning amount

When setting up corporate card usage policies to enforce the use of corporate cards, an amount that exceeds the cash limit
and for which a warning displays during expense entry in the expense report.
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warning tolerance

When setting up corporate card usage policies to enforce the use of corporate cards, a range that is from the cash limit up to
the warning tolerance amount. Over that amount, a warning displays.

warning tolerance percentage

When setting up corporate card usage policies to enforce the use of corporate cards, a percentage that, when added to the
cash limit, defines the warning amount. If you spend more than the warning amount, a warning displays.
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